telestream @

AVID INTEGRATION GUIDE
2025.2

Vantage 8.3

Vantage 8.1

+ Update Pack 5
Vantage 8.2

+ Update Pack 3
Live Capture 3.7

Live Play 2.0

December 2025 2509031439



|

Copyrights | Trademark Notices | Licenses

Copyright © 2025 Telestream 2, LLC and its Affiliates. All rights reserved. No part of this
publication may be reproduced, transmitted, transcribed, altered, or translated into any
languages without written permission of Telestream 2, LLC. Information and
specifications in this document are subject to change without notice and do not
represent a commitment on the part of Telestream. Specifications subject to change
without notice.

Telestream, CaptionMaker, Cerify, DIVA, Episode, Flip4Mac, FlipFactory, Flip Player,
GraphicsFactory, Kumulate, Lightspeed, MetaFlip, Post Producer, ScreenFlow, Switch,
Tempo, TrafficManager, Vantage, VOD Producer, and Wirecast are registered trademarks
and Aurora, ContentAgent, Cricket, e-Captioning, Inspector, iQ, iVMS, iVMS ASM,
Pipeline, Sentry, Surveyor, Vantage Cloud, CaptureVU, FlexVU, PRISM, Sentry, Stay
Genlock, Aurora, and Vidchecker are trademarks of Telestream, LLC and its Affiliates. All
other trademarks are the property of their respective owners.

Telestream products are covered by U.S. and foreign patents, issued and pending.
Information in this publication supersedes that in all previously published material.
Specifications and price change privileges reserved.

Adobe. Adobe® HTTP Dynamic Streaming Copyright © 2014 Adobe Systems. All rights
reserved.

Apple. QuickTime, MacOS X, and Safari are trademarks of Apple, Inc. Bonjour, the
Bonjour logo, and the Bonjour symbol are trademarks of Apple, Inc.

Avid. Portions of this product Copyright 2012 Avid Technology, Inc.
CoreOS. Developers of ETCD.

Dolby. Dolby and the double-D symbol are registered trademarks of Dolby
Laboratories Licensing Corporation.

Fraunhofer IIS and Thomson Multimedia. MPEG Layer-3 audio coding technology
licensed from Fraunhofer IIS and Thomson Multimedia.

intoPIX and Fraunhofer. Notice under 35 U.S.C. §287(a): This product or service
includes JPEG XS compliant features that are covered by patents in the United States
and in other jurisdictions owned by intoPIX SA (“intoPIX") and/or Fraunhofer-
Gesellschaft zur Foerderung der angewandten Forschung E.V. (“Fraunhofer”) and listed
at HYPERLINK http://www.jpegxspool.com. Additional patents may be pending in
United States and elsewhere.

Google. VP6 and VP8 Copyright Google Inc. 2014 All rights reserved.

Built with Llama. Llama 3.1 and Llama 3.2 are licensed under the Llama Community
License, Copyright © Meta Platforms, Inc. All Rights Reserved. See https://
www.llama.com/llama3_1/license/ and https://www.llama.com/llama3_2/license/.

MainConcept. MainConcept is a registered trademark of MainConcept LLC and
MainConcept AG. Copyright 2004 MainConcept Multimedia Technologies.

Manzanita. Manzanita is a registered trademark of Manzanita Systems, Inc.

Ty
telestream Avid Integration Guide



MCW. HEVC Decoding software licensed from MCW.
Medialnfo. Copyright © 2002-2013 MediaArea.net SARL. All rights reserved.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS
IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS;
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Microsoft. Microsoft, Windows Server 2019, Windows Server 2022, Windows Server
2025, Windows 11, Media Player, Media Encoder, .Net, Internet Explorer, SQL Server
2019, SQL Server 2022, and Windows Media Technologies are trademarks of Microsoft
Corporation.

NLOG, MIT, Apache, Google. NLog open source code used in this product under MIT
License and Apache License is copyright © 2014-2016 by Google, Inc., © 2016 by Stabzs,
© 2015 by Hiro, Sjoerd Tieleman, © 2016 by Denis Pushkarev, © 2015 by Dash Industry
Forum. All rights reserved.

SharpSSH2. SharpSSH2 Copyright (c) 2008, Ryan Faircloth. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are
permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer:

Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution.

Neither the name of Diversified Sales and Service, Inc. nor the names of its contributors
may be used to endorse or promote products derived from this software without
specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS
IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS;
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

TN
Avid Integration Guide telestream



Swagger. Licensed from SmartBear.

Telerik. RadControls for ASPNET AJAX copyright Telerik All rights reserved.

VoiceAge. This product is manufactured by Telestream under license from VoiceAge Corporation.
X264 LLC. The product is manufactured by Telestream under license from x264 LLC.
Xceed. The Software is Copyright ©1994-2012 Xceed Software Inc.,, all rights reserved.
ZLIB. Copyright (C) 1995-2013 Jean-loup Gailly and Mark Adler.

®@<0c| _ & tinnafilm

SOLUTIONS Bonjous

PEDolby AFD

READY

Other brands, product names, and company names are trademarks of their respective
holders, and are used for identification purpose only.

MPEG Disclaimers

MPEGLA MPEG2 Patent

ANY USE OF THIS PRODUCT IN ANY MANNER OTHER THAN PERSONAL USE THAT
COMPLIES WITH THE MPEG-2 STANDARD FOR ENCODING VIDEO INFORMATION FOR
PACKAGED MEDIA IS EXPRESSLY PROHIBITED WITHOUT A LICENSE UNDER APPLICABLE
PATENTS IN THE MPEG-2 PATENT PORTFOLIO, WHICH LICENSE IS AVAILABLE FROM
MPEG LA, LLC, 4600 S. Ulster Street, Suite 400, Denver, Colorado 80237 U.S.A.

MPEGLA MPEG4 VISUAL

THIS PRODUCT IS LICENSED UNDER THE MPEG-4 VISUAL PATENT PORTFOLIO LICENSE
FORTHE PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER FOR (i) ENCODING
VIDEO IN COMPLIANCE WITH THE MPEG-4 VISUAL STANDARD (“MPEG-4 VIDEO") AND/
OR (ii) DECODING MPEG-4 VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A
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MPEG4 SYSTEMS

THIS PRODUCT IS LICENSED UNDER THE MPEG-4 SYSTEMS PATENT PORTFOLIO LICENSE
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AN ADDITIONAL LICENSE AND PAYMENT OF ROYALTIES ARE NECESSARY FOR
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STORAGE AND/OR USE. SUCH ADDITIONAL LICENSE MAY BE OBTAINED FROM MPEG LA,
LLC. SEE HTTP://WWW.MPEGLA.COM FOR ADDITIONAL DETAILS.

Limited Warranty and Disclaimers

Telestream 2, LLC (the Company) warrants to the original registered end user that the
product will perform as stated below for a period of one (1) year from the date of
shipment from factory:

Hardware and Media—The Product hardware components, if any, including equipment
supplied but not manufactured by the Company but NOT including any third party
equipment that has been substituted by the Distributor for such equipment (the
“Hardware"), will be free from defects in materials and workmanship under normal
operating conditions and use.

Warranty Remedies

Your sole remedies under this limited warranty are as follows:

Hardware and Media—The Company will either repair or replace (at its option) any
defective Hardware component or part, or Software Media, with new or like new
Hardware components or Software Media. Components may not be necessarily the
same, but will be of equivalent operation and quality.

Software Updates

Except as may be provided in a separate agreement between Telestream and You, if
any, Telestream is under no obligation to maintain or support the Software and
Telestream has no obligation to furnish you with any further assistance, technical
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support, documentation, software, update, upgrades, or information of any nature or
kind.

Restrictions and Conditions of Limited Warranty

This Limited Warranty will be void and of no force and effect if (i) Product Hardware or
Software Media, or any part thereof, is damaged due to abuse, misuse, alteration,
neglect, or shipping, or as a result of service or modification by a party other than the
Company, or (ii) Software is modified without the written consent of the Company.

Limitations of Warranties

THE EXPRESS WARRANTIES SET FORTH IN THIS AGREEMENT ARE IN LIEU OF ALL OTHER
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, ANY
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. No oral
or written information or advice given by the Company, its distributors, dealers or
agents, shall increase the scope of this Limited Warranty or create any new warranties.

Geographical Limitation of Warranty—This limited warranty is valid only within the
country in which the Product is purchased/licensed.

Limitations on Remedies—YOUR EXCLUSIVE REMEDIES, AND THE ENTIRE LIABILITY OF
TELESTREAM, LLC WITH RESPECT TO THE PRODUCT, SHALL BE AS STATED IN THIS
LIMITED WARRANTY. Your sole and exclusive remedy for any and all breaches of any
Limited Warranty by the Company shall be the recovery of reasonable damages which,
in the aggregate, shall not exceed the total amount of the combined license fee and
purchase price paid by you for the Product.

Damages

TELESTREAM, LLC SHALL NOT BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY
LOST PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES
ARISING OUT OF YOUR USE OR INABILITY TO USE THE PRODUCT, OR THE BREACH OF
ANY EXPRESS OR IMPLIED WARRANTY, EVEN IF THE COMPANY HAS BEEN ADVISED OF
THE POSSIBILITY OF THOSE DAMAGES, OR ANY REMEDY PROVIDED FAILS OF ITS
ESSENTIAL PURPOSE.

Further information regarding this limited warranty may be obtained by writing:
Telestream, LLC

848 Gold Flat Road

Nevada City, CA 95959 USA

You can call Telestream during U. S. business hours via telephone at (530) 470-1300.

Server Regulatory Compliance

Electromagnetic Emissions: FCC Part 15 Subpart B, ICES-003, EN 55032, EN/BS 55024,
EN/BS EN 55035, EN 61000-3-2, BS EN 61000-3-2, EN 61000-3-3, BS EN 61000-3-3, VCCI-
CISPR 32, AS/NZS CISPR 32

Electromagnetic Immunity: EN 55035
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Safety: IEC 62368-1, EN 62368-1, CSA C22.2 No. 62368-1-14, UL 62368-1
Additional Country Certifications: NOM, IRAM S-Mark

California Best Management Practices Regulations for Perchlorate Materials:

This Perchlorate warning applies only to products containing CR (Manganese Dioxide)
Lithium coin cells. Perchlorate Material-special handling may apply. See
www.dtsc.ca.gov/hazardouswaste/perchlorate.

Contact Telestream Customer Service for additional Regulatory Compliance certificates.

Obtaining Support | Information | Assistance

Here's how to contact Telestream for support, information, or assistance:

Resource

Contact Information

Telestream Technical
Support Portal

Web Site: telestream.net > Support

Vantage Technical
Support Portal

Web Site: telestream.net/telestream-support/vantage/
support.htm

Support Email: support@telestream.net

Terms and times of support services vary, per the terms of
your current service contract with Telestream.

Vantage Information,
Assistance, FAQs, Forums,
& Upgrades

Web Site: telestream.net/telestream-support/vantage/
support.htm

General Contact
Information

Web Site: telestream.net/company/contact-
telestream.htm

Telestream, LLC

Web Site: telestream.net
Sales and Marketing Email: info@telestream.net

International Distributor
Support

Web Site: telestream.net

See the Telestream site for your regional authorized
Telestream distributor.

Telestream Technical
Writers

Email: techwriter@telestream.net

If you have comments or suggestions about improving
this document, or other Telestream documents—or if
you've discovered an error or omission, please email us.
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Introduction

This guide helps you, as a Telestream Vantage or Live Capture operator/manager,
understand, implement, and utilize Vantage and Live Capture to perform media
transcoding and other digital media workflows in conjunction with Avid’s editorial and
asset management products.

This chapter is an overview of how Vantage and Avid products interact for highly-
effective media processing. Here, you'll gain an overview of how you export media
from Avid into Vantage workflows for transcoding and other processing. You'll also
learn how to import transcoded media from Vantage workflows back into Avid for
editing. The remainder of the guide focuses on implementation and application details.

Topics
m Overview
m Avid Product Integration in Vantage
m Supported Avid Products and Implementations
m Vantage Version Requirements
m Vantage | Live Capture Licensing Requirements
m Required Avid Components
m Network Adapters for Avid Shared Storage
m International Character Support
m Vantage to Avid—Ingesting Encoded Media into Avid Systems
m Avid to Vantage—Exporting Media to Vantage
m Accessing MediaCentral | Production Management Systems

m Best Practices and Tips

Note: This guide is written for video professionals who are familiar with using
Vantage. To implement applications in Vantage, you should know how to create
workflows and submit jobs. If you aren’t familiar with Vantage, we suggest that you
review the Vantage User’s Guide and Vantage Domain Management Guide as needed.
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Introduction
Overview

Overview

Avid’s editing and asset management products are used broadly throughout
broadcast, sports, and entertainment to edit and produce high value media. As such,
they are operated by highly-skilled creative staff, often located in premium facilities.

The comprehensive integration of Vantage with Avid's products enables significant
gains in productivity for almost every type of Avid user, from small production houses
to large broadcasters producing national news programs. These productivity gains are
made possible by making file- based and live media export and import processes faster,
more automated, and less reliant on operator action.

)

5
>
MediaCentral | Production
—>
> «
MP4 files with ORAtom media
—_ —>
\]
A
Media Cpmposer
Newsgutter
—
-
-
MediaCentral | Production
—>
-———
———
———
» ———
MediaCentral | Production L

You can integrate Vantage directly into Avid media processes from standalone Avid
Media Composer edit systems to MediaCentral | Production Management asset
management systems. Both single and multiple resolution assets can easily be created
to meet your requirements.

Note: In this guide, references to Avid Media Composer generally apply to Avid
editors including Media Composer, Newscutter, and Symphony.

Certain Vantage actions (Notify, Media Creation, Retrieve, and Asset Monitor) have
control labels which may use the term Interplay in previous Avid versions. Avid’s
official product name is now MediaCentral | Production Management, or more briefly
Production, both of which are used throughout this guide.

Throughout the guide, the terms Interplay and MediaCentral Production Management
may be used broadly and interchangeably.
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Introduction
Avid Product Integration in Vantage

Also, in the context of this guide, the phrase frame chase editing is sometimes used to
refer to Avid’s Edit While Ingest (EWI) feature.

Avid Product Integration in Vantage

Telestream provides Avid product integration with Vantage for workflows utilizing
these actions, all implemented in the Vantage Avid Service:

» The Asset Monitor action—see Exporting Master Clips | Subclips | Sequences and
Asset Monitor Action.

» The Retrieve action—see Ingesting Master Clips Directly into a Workflow and Config-
uring a Retrieve Action.

» The Media Creation action—see Generating and Ingesting Avid-Compatible MXF OP-
Atom Media and Media Creation Action.

o The AAF action—see Edit While Ingest Workflow for Avid Media Composer and AAF
Action.

For supported components see the Telestream web site or contact Telestream support
(see Obtaining Support | Information | Assistance).

T
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Supported Avid Products and Implementations

Supported Avid Products and Implementations

You can integrate Vantage for media file processing with these Avid products:

« Avid MediaCentral products: MediaCentral | Production Management—Vantage
seamlessly integrates directly with PAM for both import and export.

» Avid NEXIS—Avid's shared storage environment, a proprietary NAS device. The
term NEXIS is used in this guide but ISIS is also supported. The terms NEXIS as used
in this guide should not be confused with older Avid and Unity products.

You can also integrate Telestream'’s Live Capture with these Avid system
implementations for near-real time streaming video processing:

 Stand-alone Avid editing systems with local storage
 Avid editing systems with network attached shared storage (for example, NEXIS)

« Avid editing systems with MediaCentral | Production Management.

Vantage and Live Capture are tested for Avid compatibility with new versions.

Note: Avid MediaCentral components installed with Avid editors must use the
MediaCentral | Production Management version qualified with the editing system.
These include Media Indexer, Interplay Access, and Interplay Framework.

For details, see Avid Editing Application Compatibility with MediaCentral | Production
Management Releases in the Avid Knowledge Base.

Vantage Version Requirements

Using Avid integration features with Vantage requires these versions of Vantage
software and components, listed in order of installation where necessary. Log in and
download the Avid 2025.2 zip file from the support portal on the Telestream site:
telestream.net > Support to obtain the Avid patch installers.

Note that the Vantage Avid service requires access to TCP Port 8888.

Vantage 8.1

. Vantage 8.1

. Vantage 8.1 UP5

. ComponentPac Avid.2025.2

. Vantage 8.1 UP5 Avid Domain Patch

. Vantage 8.1 UP5 Avid Service Patch

. Flip64 2025.2

. Post Producer ComponentPac 2023.1.0.188 or higher—for Send to Vantage

N OO L1 ph W N =
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Vantage 8.2

. Vantage 8.2

. Vantage 8.2 UP3

. ComponentPac: Avid.2025.2

. Vantage 8.2 UP3 Avid Domain Patch

. Vantage 8.2 UP3 Avid Service Patch

. Vantage 8.2 UP3 Avid Notify Patch

. Flip64 2025.2

. Post Producer ComponentPac 2023.1.0.188 or higher—for Send to Vantage

00 N O L1 A W N =

Vantage 8.3
1. Vantage 8.3
2. ComponentPac: Avid.2025.2
3. Flip64 2025.2

Live Play Version Requirements

1. Live Play 2.0 (required for Send To Playback)
2. Avid Transfer Engine 2024.10
3. Telestream playback Service 2.0.2024

Live Capture Version Requirements

Live Capture 3.7 or later
1. Vantage 8.1
. Vantage 8.1 UP5
. ComponentPac Avid.2025.2
. Vantage 8.1 UP5 Avid Domain Patch
. Vantage 8.1 UP5 Avid Service Patch
. Flip64 2025.2
7. Post Producer ComponentPac 2023.1.0.188 or higher—for Send to Vantage

N 1 A W N

Contact your Telestream support team for details.

Vantage | Live Capture Licensing Requirements

Features for Avid interaction are enabled with specific Telestream licenses.

The Send to Vantage feature utilizes Compose and Conform actions, which are enabled

by the Post Producer license.
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Please contact your Telestream account manager or Telestream Customer Service (see
Obtaining Support | Information | Assistance) for information about purchasing Vantage
licenses.

VST
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Required Avid Components

These Avid components may be required for workflows communicating with
MediaCentral | Production Management. Installation and configuration of Avid
components is beyond the scope of this guide. They must be installed/configured by
you (the customer) or an Avid representative:

» Avid Interplay Web Services—must be installed and configured. Current version
is 2024.10.

» Avid NEXIS Client Manager—must be installed and configured on all Live Capture
or Vantage domain servers that use Live Capture or Vantage actions to write to Avid
shared storage and communicate with MediaCentral | Production Management.

* AAF File Location or AAF Temp File Location—see Media Creation Action Configu-
ration for details.

e MXF File Location—For use with Media Creation action workflows, these files
must be on an indexed Nexis Workspace.

e The workspace/directory must be indexed by the Avid Media Central Production
Index Service.

Required Avid Information

Prior to designing and implementing Avid workflows in Vantage to access Interplay
(MediaCentral | Production) systems, you (the customer or Avid representative) must
have this information about each system:

* NEXIS username and password
o NEXIS workspace/directory

» Web Services host

» Web Services port

e Production Workgroup

e Production Username

e Production Password

Note: Always connect to MediaCentral | Production Management and Web Services
using a fully-qualified DNS name, which is registered with Forward and Reverse look
up tables in DNS.

Use these specifications to define Avid connections in the Vantage Domain Console for
use in Media Creation and Asset Monitor workflows, or define them statically or
dynamically via variables, directly in your workflows. See Accessing MediaCentral |
Production Management Systems.
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Network Adapters for Avid Shared Storage

You should equip Vantage domain servers being used with Avid shared storage with an
Avid-approved network adapter. For a list of supported network adapters, see the Avid
Knowledge Base article resources.avid.com/SupportFiles/attach/AvidNEXIS/
AvVidNEXIS_Network_Switch_Guide.pdf.

International Character Support

Vantage fully supports multi-byte characters. However, some third party components
or interfaces used within Vantage do not.

These actions may impose practical limits when used in Vantage workflows:

» AAF | Asset Monitor | Media Creation | Retrieve actions—some Avid components may
have restricted multi-byte character support, which may affect these actions. See
associated Avid documentation for the latest information.

« Notify | Deploy actions—some Avid MediaCentral | Production Management com-
ponents have restricted multi-byte character support, which affects how Notify and
Deploy actions can interact with them.

MediaCentral | Production Management v2018.x and newer supports Unicode
characters from the basic plane for asset and folder names as well as for content such as
metadata or markers. This statement applies to Avid MediaCentral portfolio of products
and does not include creative applications such as Avid Media Composer.

Unicode support is limited for file system objects and across platforms. Due to the
complexity of consistently supporting Unicode file system objects across different
platforms, Avid recommends avoiding non-English file system file and folder names. If
your implementation cannot avoid this scenario, please make sure you fully test your
solution in a complete MediaCentral production environment for all relevant use cases.

See these Avid publications for more details:
* Media Composer Documentation

e MediaCentral | Production Management v2023.x Documentation
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Vantage to Avid—Ingesting Encoded Media into
Avid Systems

Media and its associated metadata arrives for processing in many ways and—in often
unpredictable—formats. The challenge is keeping up with content arriving from news
agency/wire feeds, bureau and stringer file deliveries, tapeless cameras, archive
retrievals, and user-generated media and crowd sourcing, enabled by the ubiquitous
cell phone.

Media files\ N

@ / Vantage \

Metadata Standalone Systems

Most source media requires transcoding for conversion to house standards. Media may
also require aspect ratio, frame rate conversion, or other essence modifications.

Vantage offers unparalleled transcoding/re-wrapping functionality and quality for
automated ingest of heterogeneous media files into Avid. Vantage offers a
comprehensive set of codecs and components that you can combine and configure in
workflows to solve your media transcoding challenges, making Vantage an excellent
choice for automated transcoding of source media into Avid platforms.
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Vantage Actions and Encoders for Avid Media Processing

You can implement these Vantage actions and encoders in Vantage workflows to
implement your Avid-based media processing requirements:

Media Creation Action

You can ingest files generated by the Media Creation action to create single and multi-
resolution assets for use in a MediaCentral | Production Management or Avid Media
Composer environment:

» Media Composer Mode: For creating Avid-compatible AAF and MXF OP-Atom files
including metadata written to storage for ingest into a Media Composer editor.

* Interplay Mode: For creating Avid-compatible AAF and MXF OP-Atom files and
metadata that is written to Nexis storage and automatically be checked-into Media-
Central | Production Management.

Note: The Media Creation action is designed as a same-as-source-converter,
assembling media as quickly as possible for processing (typically production
transcoding and related tasks) by downstream actions or other workflows. It does not
perform decoding/encoding operations. For details, see Generating and Ingesting Avid-
Compatible MXF OP-Atom Media and Media Creation Action.

Media Creation actions are executed by the Vantage Avid Service.

When ingesting media directly into a MediaCentral | Production Management system,
assets can include integrated User Properties, Asset Locators, Asset Restrictions, and
Headframe creation.

Open Workflow mode is supported in both Interplay and Media Composer modes for
ingest into Media Composer supporting Edit While Ingest editing; metadata insertion is
supported while files are being processed in Vantage, enabling near-real-time editing.

MXF Encoder

The MXF encoder is implemented in the Flip64 action. The MXF encoder creates media
that can be imported in to an Avid editorial environment.

Files created by the MXF encoder in a Generic OP1a, IMX (D10), or Sony XDCAM HD
MXF containers can be added to an Avid bin using Avid's MXF AMA plug-in.

Ancillary data in source files can be preserved as an MXF (SMPTE 436M) data track.
Avid’s AMA MXF plug-in reads SMPTE 436M and places it in the clip’s data track.
MOB ID Generator and Interplay Notifier

In Media Creation workflows, use the Notify action to perform these functions:
* Generatea MOB ID

VST
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« Create a master clip for ingest into MediaCentral | Production Management (legacy
function)

« Add metadata to a MediaCentral | Production Management clip

« Specify or create a MediaCentral | Production Management Folder for ingest. Speci-
fies the name of an existing MediaCentral | Production Management Access folder
to target or create a MediaCentral | Production Management virtual folder(s) that
does not exist in the configured MediaCentral | Production Management Folder
path.

 Extract clip metadata from the master asset for use in Vantage workflows
 Seta head frame in a MediaCentral | Production Management clip

» Copy an existing asset from one Interplay Folder to another, optionally with the
same Master MOB ID

» Move a clip into MediaCentral | Production Management

+ Delete a clip from MediaCentral | Production Management
» Checkin a non-Avid asset such as a still image graphic file

» Rename a clip to modify asset name

e Checkin an AAF file

« Indicate that Open Locators is still actively performing work
» Create afolder

» Add metadata to a folder.
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Avid to Vantage—Exporting Media to Vantage

Once an editis complete, the finalized sequence is ready to be sent to a playout system,
to syndication, or for online publication as quickly as possible.

Note: For implementation and configuration details, see Performing Avid Media
Production Operations, Media Creation Action and Configuring a Retrieve Action.

Vantage workflows automate transcoding and delivery to your distribution platforms.
For example, you can use Vantage workflows to automatically export MediaCentral |
Production Management sequences and master clips into Vantage to create media in
distribution platform formats for broadcast, cable/VOD, IPTV, online/mobile, and multi-

screen viewing.

Production

Standalone Avid system
. S

Vantage

&

- | ===

Web & Mobile Broadcast Asset Mgmt /
Servers Server Archive
IPTV Playout areen

You can process Avid editorial output in Vantage workflows in a variety of ways. By
exporting media directly to Vantage, you can easily automate the creation of all

required file types.

Topics

m Automatically Exporting Sequences and Master Clips from MediaCentral | Produc-

tion Management

m Exporting Master Clips by MOB ID
m Avid Media Composer Integration

m Transcoding Sequences Directly from Media Composer

m Processing Simplified AAF Files Exported from Media Composer

m PMR Processing | Matte/Key Effects on AAF Files
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Automatically Exporting Sequences and Master Clips from
MediaCentral | Production Management

Workflows using the Asset Monitor action monitor a virtual folder in MediaCentral |
Production Management systems for both master clips and sequences to perform
same-as-source-conversion, assembling the media as quickly as possible for processing
by downstream Vantage actions in the workflow; typically production transcoding and
related tasks.

The Asset Monitor action creates a proprietary MP4 reference file that references MXF
OP-Atom files located on Avid shared storage for that asset and may also include
additional transcoded media, as well as media samples for mixed format sequences.
The MP4 reference file also includes ancillary data extracted from the MediaCentral |
Production Management assets data track. Additionally, a metadata XML file
containing the MediaCentral | Production Management asset’s user metadata and
MediaCentral | Production Management System data is generated. The MP4 reference
file and associated XML file can then be processed by downstream Vantage actions for
transcoding and metadata extraction. Creation of an AAF from an Avid asset is also
supported.

Note: Forimplementation and application details, see Exporting Master Clips | Subclips
| Sequences. For configuration details, see Asset Monitor Action.

Exporting Master Clips by MOB ID

Workflows using the Retrieve action initiate a job each time an Interplay MOB ID is
submitted to this workflow. It retrieves the master clip identified by the MOB ID from
the target Interplay system, and generates a Telestream MP4 reference file as the
primary output. The Retrieve action will not successfully process an asset if it is in an
Offline or partially Online state, because Vantage can not create an MPEG-4 Reference
with missing Avid OP Atom media.

Note: The Retrieve action is designed as a same-as-source-converter, assembling
media as quickly as possible for processing (typically production transcoding and
related tasks) by downstream actions or other workflows. It does not perform
decoding/encoding operations. For details, see Ingesting Master Clips Directly into a
Workflow and Configuring a Retrieve Action.

Retrieve actions are executed by the Vantage Avid Service.

Typical workflow functionality involves transcoding the MP4 file downstream in Flip64
or other transcoding action to produce the desired output format. Metadata and AAF
are optional output files that are delivered as attachments.

The target workflow must start with a Receive origin action to enable it to receive the
MOB ID - via a Forward action in another workflow, a manual job submission from
Workflow Designer, or from an API-based external system.

T
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Avid Media Composer Integration

Avid operators can use Media Composer’s Send to Playback command to re-wrap Avid
OP-Atom files into MXF or TIFO and export them to Live Play and register them in a
playlist for playback. Operators can also use the Send To Playback command to export
sequences directly to a Vantage watch folder for ingest by the associated workflow for
processing.

To learn about installing, configuring and using Send to Playback in Media Composer,
see Exporting Sequences to Live Play | Vantage via Send to Playback.

Transcoding Sequences Directly from Media Composer

The Send To Vantage feature is an optional suite of Vantage programs for Avid Media
Composer that enables Avid editors to send sequences directly from Media Composer
to an active Vantage workflow for processing.

The Conform action in Send to Vantage workflows renders media descriptor
compositions (as defined in the Composition XML file which it is passed) with transition
and image effects and graphic overlays and conformed audio, applying option filters as
appropriate, encoding the output video in the specified format.

To learn about installing, configuring and using Send to Vantage in Media Composer,
see Starting Sequence Processing Jobs from Media Composer.

Processing Simplified AAF Files Exported from Media
Composer

You can export AAF files for flattened and mixed down sequences from Avid Media
Composer for processing by Vantage workflows designed with Post Producer (Edit)
Compose and Conform actions. The features of these actions were designed in
collaboration with Avid to meet the requirements of processing simplified AAF files.

The Compose action configured with a Simple AAF composer parses the AAF files and
the Conform action transcodes the video, processing audio and data track (D-Track)
MXF OP-Atom media referenced in the file ingested from storage.

Note: See the Post Producer Developer’s Guide on the Telestream web site for general
information on using Post Producer in Vantage, and for detailed information about
exporting Simple AAF files.

PMR Processing | Matte/Key Effects on AAF Files

The AAF action ingests an AAF file and performs various operations on the media in the
MXEF folder referenced in the AAF, as configured by you. Avid Media Composer utilizes

Persistent Media Record (PMR) files for information about the online status of file Media
Object information (MOB). Each PMR file provides an index in a form that an editor can
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quickly load all the file MOBs and their associated media files in the media directory in
which the PMR file resides.

You can also perform a Matte/Key effect on ingested files to use in Avid Media
Composer, where you apply a Matte/Key effect on selected media using the clips.

In order to perform Open Workflow, Frame Chase (Edit While Capture) processing of
Media Creation outputs, you must bind the AAF Path variable (created in an upstream
Media Creation action) to the Input Source File Name field.

Note: See Edit While Ingest Workflow for Avid Media Composer and AAF Action for
details.

Accessing MediaCentral | Production Management
Systems

Asset Monitor, Retrieve, and Media Creation actions are configured to interact with a
specific MediaCentral | Production Management system. Identification may be
manual—statically specifying a system which does not change on a job-by-job basis.

System identification can also be dynamic, where you use variables to identify the
system at run time for each job that executes. This is preferable when you may be
accessing one of many Avid systems in a single workflow, based on run-time metrics.
Dynamic, variable-driven workflows often simplify workflow design and utilization.

Topics
m Specifying an Avid Interplay System Statically
m Specifying an Avid System Dynamically

Specifying an Avid Interplay System Statically

Before you can configure an action with a static system, you should identify the Avid
Interplay | MediaCentral Production Management systems you plan to use, and add
them as connections in the Vantage Management Console. Optionally, Media Creation,
Asset Monitor, and Retrieve actions enable you to identify the Interplay system directly
in the action.

When you use Avid connections to access different systems from a single workflow, the
workflow must use Decide actions to examine an Avid server variable and branch to the
appropriate branch, based on its value.

For each Interplay system connection you require, follow these steps:

T
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1. Open the Vantage Management Console (VMCQ), select Settings & Options and
display the Avid tab, where you can create and configure Avid connections:

Settings & Options =

General Email Authorization Mapped Drives DIVA Signiant Telestream Cloud Storage Management Dashboard Links

| Workgroup

Name: Avid Production 2022.7
Web Services Host: Production06
Web Services Port: 20,196 £ 1-65535
Praduction Woarkgroup:  pRODUCTION20227
Production Username:  gyid

Production Password: gees

2. Click the Add... button in the toolbar (or right-click in the table and select Add new
setting), and configure these fields:

a. Name—enter a practical name for the Interplay server (for example, Interplay-
Vantage Server).

b. Interplay Web Services Host—enter the domain name of the Interplay server.

c. Interplay Web Services Port—select or enter a port number (default 80).

d. Interplay Workgroup—enter the work group name.

e. Interplay Username—enter the user name expected by the Interplay server.

f. Interplay Password—enter the Interplay user’s password.

For details on configuring and managing Avid connections, click the ? icon and
read the Configuring Interplay Settings topic in the Domain Management Guide.

3. Click Test to confirm that Vantage can access the target server. If you have
problems, determine the issue and retry.

Workflow Designer adds these connections dynamically to the Interplay Configuration
menu in the Media Creation action.

With your Avid connections created, return to Workflow Designer and continue with
your Avid workflow implementation by selecting the Interplay system you are targeting
in this action—selecting it from the Interplay Configuration menu, as shown below.

Specifying an Avid System Dynamically

To configure an action to interact with an Avid system dynamically—where the system
may change on a job-by-job basis—follow these steps:
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1. In the inspector’s Interplay Configuration menu, select Interplay:

Interplay Configuration: Interplay ¥

Media Composer
Output media file nicks W
Interplay2024
« Media Creation Sett Interplay2024_a

2. Open the Interplay Definition panel:

Interplay Configuration: Interplay ¥

i

Output media file nickname: Edit Filename Pattern...

~ Media Creation Settings
“  Interplay Definition

Interplay Web Services Host:

Interplay Web Services Port: 80 $ 165535 -

Interplay Workgroup:
Interplay Username:

Interplay Password:

3. You can configure these controls with static values—so that it functions exactly the
same as if you'd created an Avid connection and selected it—or, you can
dynamically configure the control by clicking the green browse button, and
selecting a variable that represents this control:

a. Interplay Web Services Host—the domain name of the server.

b. Interplay Web Services Port—the server’s port number (default 80).

c. Interplay Workgroup—the work group name.

d. Interplay Username—an authorized user name for accessing the server.

e. Interplay Password—the user’s password.

For more details on configuring Avid connections, click the M icon and read the
help page.

4. Now, upstream of this action—in the origin action (Watch, Receive, etc.) or other
action preceding this one—identify the variables bound to this action and set their
values as appropriate for the target server for this job.

Note: For comprehensive information about variables, see Utilizing Variables in an
Action, in the Workflow Designer User’s Guide.

Best Practices and Tips

These practices and tips are not specific to Avid integration with Vantage but may assist
in your creation of end-to-end workflows.

/_'\
Avid Integration Guide telestream

33



34 | Introduction
Best Practices and Tips

Graphic File Checkin Requirements

After performing a Graphic File Checkin in the Notify action, the file must be imported
into Avid Media Composer, with the Do not resize smaller images control checked.

Avid Log Files

Log files for calls made to Avid web services are available in Vantage. To configure how
log files are written, perform these steps:

» Navigate to C:\Program Files (x86)\Telestream\Vantage\Compo-
nents\Avid XXXX.X.X.XX (where Avid XXXX.X.X.XX is Avid ComponentPac version).

» Open AvidChecklin.exe.config in a text editor and set these rule, then save:

<rules>
<!-- Log levels are (Most restrictive to most Verbose): Off, Fatal, Error, Warn, Info, Debug, Trace -->
<logger name="*" minlevel="0ff" writeTo="logconsole" />
<logger name="*" minlevel="Error" writeTo="logfile" /> Default
A

</rules>

<rules>»
<!-- Log levels are (Most restrictive to most Verbose): Off, Fatal, Error, Warn, Info, Debug, Trace --»
<logger name="*" minlevel="0ff" writeTo="logconsole" />
<logger name="*" minlevel="Warn" writeTo="logfile" /> Set for Logging

</ruless —

 Log files are written to C:\Windows\System32\config\systemprofile\AppData\Roam-
ing\Telestream\Logs for user or support purposes.

Set Update Interval Setting in Media Composer

When using Open workflow mode and importing files into Avid Media Composer, the
Update Interval setting must be set and the Media Composer application restarted.

If the setting is not made the files show Media Offline in the player window and must
be manually updated from Avid Production Management.
Using Media Composer

In Media Composer under File > Settings > User > Capture > MXF Media Files:
o Check the During capture, clip is updated in Production Management checkbox.

» Set Update Interval to 1 Minute (minimum update interval allowed).
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» Restart Media Composer:

Edit MXF Media Files
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Exporting Master Clips |
Subclips | Sequences

This chapter describes how the Asset Monitor action is implemented in Vantage, and
how you can use it to export master clips, sequences, and subclips from MediaCentral |
Production Management into Vantage workflows. Automatically exporting master
clips, sequences, and subclips as they are added or modified is accomplished by
workflows implemented with the Asset Monitor action.

Asset Monitor workflows are designed to quickly and efficiently generate a proprietary
Telestream MP4 reference file (with video, audio and ANC data) plus an external
metadata file for highly efficient processing by transcoding actions or other workflows.

Topics
m Overview
m Using Telestream MP4 reference Files
m Creating a Prototype Asset Monitor Workflow

m Configuring an Asset Monitor Action

S
telestream



38‘

Exporting Master Clips | Subclips | Sequences

Overview

Overview

The Asset Monitor action is executed by the Vantage Avid Service. It is unique in that
(unlike most Vantage actions) it performs two tasks:

» Monitors a user-specified virtual folder on the target MediaCentral | Production
Management database for new master clips, sequences, and subclips to export

» Creates a Telestream MP4 reference file that can be consumed by downstream Van-
tage actions in a workflow or other separate workflows.

The Asset Monitor action is designed as a same-as-source-converter, assembling media
as quickly as possible for processing (typically production transcoding and related
tasks) by downstream actions or other workflows.

This action is an origin action and can only be used as the first action in a workflow;
however, it may be the only action in a workflow. Asset Monitor actions run when the
workflow is activated and during the active time frame, if specified. The Asset Monitor
action initiates a job each time a new media asset is discovered and generates the
specified output; then it passes control to the next action (if any) in the workflow or
potentially, other workflows.

The Asset Monitor action does not require additional Telestream components installed
in the Vantage domain. The Asset Monitor can be used instead of using Avid Media
Composer exports or Send to Playback | Send to Vantage features from Media
Composer.

Feature Summary

Here is a summary of the features of the Asset Monitor action:

» Queries for master clips, sequences, and sub clips; exports into Vantage and pro-
duces a Telestream-proprietary MP4 reference file for use in downstream actions.

« If a sequence’s timeline contains gaps, the Asset Monitor action replaces the gaps
with black frames and silent audio.

» Supports mixed essences

» Supports inclusion of a data track in output files

e Supports up to 16 channels of rendered audio

» Supports audio channel labeling (master clips ONLY)

 Can be used as a replacement for traditional file exports from MediaCentral | Pro-
duction Management (such as QuickTime Reference or MXF OP1a).

Note: For best results, use an isolated Production Management folder for monitoring
or use a sub-folder under your bin folder. All assets including the bin must be checked
into MediaCentral | Production Management.
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Limitations

Here is a summary of the limitations of the Asset Monitor action:
* Is not a Media Composer effects render engine
» Does not use Avid background services
» Does not support overlapping timelines
» Does not support audio-only assets
» Does not support AMA-linked media
» Has the same media render requirements as traditional file export methods

» Requires a fully flattened/rendered timeline. Supports audio and video effects
when rendered within the sequence timeline

» Growing assets are ignored until they are complete
» Does not support multi-layer video sequences

* No sub-folder support—the Asset Monitor action does not recursively search sub-
folders to a configured Interplay folder.

Avid Version Requirements

Vantage and Live Capture are continually tested for Avid compatibility as new versions
become available. For details, see Required Avid Components.

Avid Media Composer Sequence Requirements

In order to export and properly process Avid media, the Avid sequence asset
specifications must adhere to certain requirements. The Asset Monitor action processes
three kinds of MediaCentral | Production Management assets—master clips,
sequences, and subclips. Sequences may include:

» Timeline Gaps—during processing, gaps are filled with black frames/silent audio.

» Mixed formats (codecs/resolutions)—segments that differ from the format of the
first segment are transcoded to the first segment's format and the samples are
stored in the output MP4 reference files.

» Transition effects—transition effects must be rendered before exporting and sub-
mitting the asset to an Asset Monitor workflow.

» Segment effects—tracks that contain segment effects must be rendered before
exporting the asset and submitting it to an Asset Monitor workflow.

» Multiple video layers—only one video layer is supported. Video layers must be flat-
tened prior to exporting the asset and submitting it to an Asset Monitor workflow.

Note: Segment effect rendering is effective for most commonly used compositions
but may not work as expected for highly complex sequences.

T
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Processing Asset Types

Master Clip and Sequence Assets. When processing a multi-resolution asset from
MediaCentral | Production Management, the largest media size is processed by default.
This is not always the highest quality.

Note: When exporting growing media in the MediaCentral | Production Management
folder being monitored, the Asset Monitor processes the asset when the asset is
complete.

AAF File Generation

The AAF action can generate AAF files for use in other applications. For example, Edit
While Ingest operations and file compositing for matte/key effects in Avid Media
Composer.

Telestream MP4 Reference File Generation

The Asset Monitor action creates a Telestream MP4 reference file that references MXF
OP-Atom files located on Avid shared storage for the asset and may also include
additional transcoded media, and, for mixed format sequences, media samples. The
MP4 reference file also includes ancillary data extracted from the MediaCentral |
Production Management assets data track. Additionally, a metadata XML file
containing the Production asset’s user metadata and Production System data is
generated. The MP4 reference file and XML file are passed to downstream actions in the
workflow or to other workflows for transcoding and metadata extraction.

The Asset Monitor action treats the media format of the first segment of a sequence as
the sequence’s media format. The subsequent segments that differ in the format are
transcoded to the sequence's format. The transcoded samples are stored in the MP4
output media.

Decoding Support

The Asset Monitor action can decode a wide array of Avid formats including sequences
containing mixed video resolutions such as HD with SD or clips set to different codec
types (such as XDCAM with DNxHD).

Note: ProRes video can be linked, but not imported.

Supported formats include:

AVC-Intra AVC-Ultra Long GOP
DNxHD DNxHR
DV DVCPro
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DVCProHD IMX
JPEG 2000 (J2K) XDCAM
XAVC

Metadata Preservation

Most MediaCentral | Production Management systems have been developed with a
specific and often complex Production schema for metadata storage and manipulation
within a Production Workgroup, and contain asset-based metadata including custom
user properties.

The metadata associated with an asset stored in the Production database is preserved
by the Asset Monitor action within a metadata XML file. All ANC data contained in the
asset’s data track is also preserved in the MP4 reference file through Telestream
extensions to the MP4 container (see Using Telestream MP4 reference Files for
information on processing and playing of these files). When the file is passed
downstream, the associated XML file is also transferred, making the metadata available
for extraction and processing as required.

Note: User-defined metadata that includes control characters is rejected by the Asset
Monitor. If control characters exist in your asset’s user-defined metadata, they must
either be removed or you must check Ignore User Defined Metadata when configuring
the Asset Monitor. The error message “AvidSvc Monitor: GetUserAttributes Errors for
interplay://[avid wg]/: There is an error in XML document ([x], [y]); hexadecimal value 0x07,
is an invalid character. Line [x], position [y]” is generated in this situation.

Typical Applications

The Asset Monitor action collects the system and user attributes for each asset and
stores them in the generated output file. The values for the custom user attributes
defined for that Production workgroup are also collected. The attributes that do not
have any value set are not inserted into the output file.

Here are two examples of how the Asset Monitor processes Avid assets:

« Ifthe asset’s media sequence consists entirely of clips using a single codec type of
the same quality level (such as AVC Intra 1080i @ 29.97) then the action performs
same-as-source-conversion. The resulting output is a reference file pointing
directly to the asset’s MXF OP-Atom files residing on Avid’s shared storage. In this
case, other Vantage actions will use the native Avid media files directly during fur-
ther media processing.

« Commonly, however, Avid sequences contain mixed media timelines. For example,
different resolutions or different codecs. In a mixed-mode asset, the Asset Monitor
action selectively converts media segments to match the format and codec type
used in the first segment of the sequence. Thus, the MP4 reference file contains
media segments created from the non-conforming segments (those in a format
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other than the one detected in the first clip) and direct references to the native Avid
media files for the conforming segments (in the format of the first clip).

If a sequence’s timeline contains gaps, the Asset Monitor action replaces the gaps with
black frames and silent audio.
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Using Telestream MP4 reference Files

Telestream-proprietary MP4 reference files generated by the Asset Monitor action are
intended for process by Vantage encoding actions. They are not intended for playing.
These files must have fully authenticated access to the media files located in the Avid
shared storage.

Creating a Prototype Asset Monitor Workflow

The Asset Monitor action is an origin action—that is, it must be the first action in a
workflow and may be the only action in a workflow. The Asset Monitor action is a dual-
purpose action: It detects new or updated Avid media in MediaCentral | Production
Management to export for processing, and initiates a job when detected. It generates a
Telestream MP4 reference file and an XML file containing external metadata associated
with the sequence or master clip.

These files are available to downstream actions or other downstream workflows for
processing as appropriate (typically, production transcoding).

Here is a simple example:

Asset Monitor

In this workflow, three actions are implemented:

Asset Monitor—monitors a virtual folder in the target Production system for new
sequences or master clips and initiates a job in Vantage to export the media. The source
media is transcoded into an MP4 reference file and the associated metadata is inserted
into an XML file.

Flip64—configured with an XDCAM encoder, the action creates a high-resolution file.

Deploy—configured to deliver the broadcast format high-resolution file to an external
system, as configured by the workflow designer.
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Configuring an Asset Monitor Action

Before this action can be configured, you must configure your Vantage domain to
connect and interact with the MediaCentral | Production Management systems you are
using. If you haven't already created at least one Avid MediaCentral | Production
Management connection, perform that task now. See Accessing MediaCentral |
Production Management Systems for details.

To configure an Asset Monitor action, follow these steps (Click M in the action inspector
to view a detailed help topic):

1. Specify the Production system you plan to monitor, and configure the monitoring
options as required.

2. Add Asset Monitor output format(s) and configure them for processing.
3. When you are done configuring this action, click Save.

Asset Monitor Settings

The Asset Monitor action monitors the specified folder and initiates a job each time a
new or modified asset is discovered in Avid MediaCentral | Production Management
since the last scan, and generates the specified format reference output, passing
control to the next action (if any) in the workflow.

Asset Monitor actions are executed by the Vantage Avid Service.

The Asset Monitor action is an origin action, and can only be used as the first actionin a
workflow; however, it may be the only action in a workflow. Asset Monitor actions run
when the workflow is activated and during the active time frame, if specified.

The Asset Monitor action is designed as a same-as-source-converter, assembling media
as quickly as possible for processing (typically transcoding and related tasks) by
downstream actions or other workflows.

It generates an Interplay Metadata and/or Telestream proprietary MP4 media file from
the new/modified input asset.

Note: When some or all media is offline, and only AAF Container and Interplay
Metadata are configured to produce output files for an asset (master clips or
sequences), the job will process and complete. However, if MPEG-4 Reference is
selected, the job will fail because Vantage can not create an MPEG-4 reference file with
missing Avid OP Atom media.

A wide variety of Avid formats are supported for decoding. Consult the Ingesting
Master Clips | Subclips | Sequences chapter in the Avid Integration Guide for a complete
list.

Before this action can be activated and used in a workflow, you must configure your
Vantage domain for the MediaCentral | Production system(s) you are using. See Adding
a MediaCentral | Production Management System to Vantage, below, for details.
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Topics
m Avid Media Composer Sequence Requirements
m Processing Asset Types
m MP4 File Generation
m Adding MediaCentral | Production Management Connections to Vantage
m Configuration Overview
m Configuration Details
m Output Components
m Adding and Configuring Outputs

Note: Controls with a green Browse button may be bound to a variable to
dynamically assign their setting or value. The variable must have a value when this
action executes. You can assign the value to the variable in a previous action in the
workflow or use the variable's default value. Click Browse to select the variable or
create a new one.

Avid Media Composer Sequence Requirements

In order for the Asset Monitor action to ingest and process Avid media, it must adhere
to the following requirements:

The Asset Monitor action processes two kinds of assets - master clips and sequences.
Sequences may have:

- Gaps in the timeline. During processing, gaps will be filled with black frames/silent
audio.

- Mixed formats (codecs/resolutions). Segments that differ from the format of the first
segment will be transcoded to the first segment's format and the samples will be stored
in the output MP4.

- Transition effects. Transition effects must be rendered before submitting the asset to
the Asset Monitor action.

- Segment effects. Tracks that contain segment effects must be rendered before
submitting the asset.

Note: Segment effect rendering is effective for most commonly used compositions
but may not work as expected for highly complex sequences.

Processing Asset Types

You can process Master Clip and Sequence assets as well as Master Clip assets.
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Note: If the Asset Monitor is active and processing output as it is being written (frame
chase editing | edit while ingest), occasionally the proxy file will be written first. As a
result, this will be the file processed by the Asset Monitor. When ingesting growing
media in the Avid folder being monitored, the Asset Monitor processes the asset only
when it is complete. Files must be completed and closed prior to the Asset Monitor
activation so that both the proxy and high-res are present.

MP4 File Generation

The Asset Monitor action creates a Telestream proprietary MP4 media file for further
Vantage processing, which references MXF OP-Atom files located on Avid shared
storage for the asset and may also include additional transcoded media. The file also
includes VANC data extracted from the asset's data track. In addition, a metadata XML
file containing the asset's metadata is generated. The MP4 reference file and XML file
are passed to downstream actions in the workflow or to other workflows for
transcoding and metadata extraction.

Any system processing these MP4 files must have fully-authenticated access to the
media files located in the Avid shared storage (ISIS/NEXIS).

MP4 files generated by the Asset Monitor action contain Telestream-proprietary
extensions. Therefore, the following requirements apply:

- Vantage transcoding actions processing these files must use the Auto decoder for
Flip64.

- For playback, Switch 4.0 or later is required and processes closed captions including
other metadata in these files.

Adding MediaCentral | Production Management
Connections to Vantage
Before this action can be activated and used in a workflow, you must add and configure

an Avid system in your Vantage domain to communicate with each MediaCentral |
Production Management system you are monitoring.

Note: The systems displayed in the Asset Monitor action's Configuration menu are
those that have been added to the Vantage Management Console.

To add an Avid system to Vantage and configure and test its connection, follow these
steps:

1. Start the Vantage Management Console.
2. In Settings & Options, display the Avid tab.

This panel is where you create, configure, delete, import and export Avid system
connections.
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3. Create and configure a connection to the target system, providing the following
information:

- Name

- Web Services Host

- Web Services Port

- Production Workgroup
- Production Username
- Production Password.

For more details on configuring and managing connections, click the ? icon to dis-
play the topic in the Vantage Domain Management Guide.

4. Click Test to confirm that Vantage can access the target MediaCentral | Production
Management server. If you have problems, determine the issue and retry.

Configuration Overview

To configure an Asset Monitor action for your workflow, first specify the system you
plan to monitor, and configure the monitoring options as required.

Note: The Avid configurations listed are created by you in the Vantage Management
Console.

Next, add your output(s) and configure them for processing.

When you are done configuring this action, click Save.

Configuration Details

Interplay Configuration. Specifies the target Avid system for this workflow. When the
workflow is activated, this list is dynamically generated from the Avid systems
identified in the Vantage domain. See Adding a MediaCentral | Production Management
System to Vantage (above) for details.
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Asset Monitor Settings

Interplay Configuration:  interplay03

Asset Name Pattern:

User Attribute Monitor:

lgnore Modifications Before:

Interplay Folder Scan Interval:

Web Service Request Timeout:
Web Service Wait Per Reques

Generate Variable

Master MOB ID:

Source MOB ID:

Browse...

User Attributes
v’ Reprocess As n Modifications =

v Persist Assets

v Process Incomplete Assets

v Ignore Asset Online Status  ~

v Process Partially Online Multi-Resolution Master Clip

lanuary 1 1
60 v 5-120 secs
60 5-120 secs

0 S 0-120 millisecs

Tape (Source Package) Name:

I Container: AAF Container

File Extension: aaf

Interplay Folder. Specifies the full folder path for the output asset. For example:

Incoming Media/Folder 1/Folder 2.Thefolder can be specifiedin the

following ways: entering the folder path; clicking Browse and selecting an existing
folder path; binding to a folder path variable.

Note: Folder names are not case sensitive.

Master Clips. When checked, specifies that new master clips will be ingested for
processing; otherwise they will be ignored. See Processing Asset Types below for more
details.

Sequence Assets. When checked, specifies that new sequence assets will be ingested
for processing; otherwise they will be ignored. See Processing Asset Types below for
more details.
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Ignore Custom User Attributes. Asset Monitor gathers all the asset metadata into an
Interplay Metadata output file, that includes system metadata, user metadata and
contents of custom metadata fields defined for the MediaCentral | Production
Workgroup, by default. When this option is checked, the custom metadata fields will be
ignored. This option is used to address server issues involving control characters in the
custom metadata.

Reprocess Assets on Modifications. When checked, assets that have been processed
will be processed again when the asset is modified.

Persist Assets. When unchecked, processes all assets in a specified folder (conforming
to other criteria, such as the last modified time of the asset being later than the date
specified in Ignore Modifications Before) after each system/service restart.

When checked, saves the assets and their last-modified time stamps in persistent
storage so they are not reprocessed after a system or service restart.

Track Deleted Assets. When checked, tracks assets that were deleted from a folder
then added again later. Vantage will not reprocess the asset when the asset re-appears
or if the Avid Web service is restarted.

Process Incomplete Assets. When checked, processing an incomplete asset results in
a failure for that asset. When unchecked (default), the asset will continue to be
processed in subsequent scans.

Ignore Asset Online Status. When checked, ignores the online/offline status of an
asset and processes the asset.

Process Partially Online Multi-Resolution Master Clip. When checked, processes the
largest media size online resolution of a multi-resolution master clip track. When
unchecked, the asset is always treated as having an offline track.

Asset Name Pattern. String supplied to Avid for filtering the responses using a regular
expression on the asset display name.

User Attribute Monitor. Monitors for changes to user attribute metadata from Avid
Production Access. When a change is detected, a new job is triggered.

Note: Changing the attribute value to null (blank) or changes made while the service
is not actively monitoring will not trigger a new job. When Track Deleted Asset is
checked, moving the asset, modifying metadata, then moving the asset back to its
original folder will trigger a new job.

Ignore Assets Created Before. Specifies a date in the past, beyond which no newly
created assets should be ingested.

Ignore Modifications Before. Specifies a date in the past, beyond which no modified
assets should be ingested.

Interplay Folder Scan Interval. Specifies the number of seconds (5-120) that should
occur between scans.
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Web Service Request Timeout. Specifies the maximum number of seconds (5-120) to
wait for a response from the specified system before timing out.

Web Service Wait Per Request. Specifies the wait time for Web Service requests in
milliseconds (0-120). Non-zero values disables HTTP persistence.

Generate Variables

Master MOB ID. When checked, specifies the text variable that contains the value of
the master MOB ID for the ingested asset.

Source MOB ID. When checked, specify the text variable that contains the value of the
Source MOB ID of the ingested asset, for use in downstream actions. The source MOB ID
can be used to associate a high-res asset that is already in Production Management to
link it to a Vantage/Flip64 proxy with the same MOB ID. The Source ID and Tape name
are needed for Dynamic Relinking.

Tape (Source Package) Name. When checked, specify the text variable that contains
the value of the tape name of the ingested asset, for use in downstream actions. The
Source ID and Tape name are required for Dynamic Relinking.

Output Components

An Output component generates a file in the format specified, utilizing the ingested
input file from the specified system.

- QOutputs

B AAF Container Output Location... Edit Filename...

Output Toolbar Buttons

Up/Down Arrows. Moves the selected output up and down the set, for organization/
readability purposes. Alternatively, use drag-and-drop: select a component and drag it
to its new location in the set.

Plus Sign. Adds another output to this action. Click to select the type of output you
want to add.
Deleting an Output

Delete. To delete an output, click the X icon immediately right of the nickname menu.

Adding and Configuring Outputs

Configure these controls:

Add Outputs. Add (using the Add button - Plus sign button - in the Output component
toolbar) your outputs by format. Add one output for each file you plan to generate.
Output formats include:
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AAF - Create an AAF file of an Avid asset.

Interplay Metadata - A CML file containing the metadata associated with the asset. This
file is intended to make metadata, along with the media files, available to Avid
workflows. Asset restriction information for master clip assets is preserved in Interplay
Metadata outputs.

Note: If you require the metadata file to have an XML extension instead of the default
CML extension, select the output component to display the Container details panel in
the details panel at the bottom. Click on the Browse button on the File Extension
control and create a text variable, supplying the string 'xml’ as the default value. This
causes the file to use an XML extension instead of the default CML extension.

MPEG-4 Reference - A Telestream variant of an MPEG4 Reference file, intended for use in
defining OP-Atom files for transcoding into the intended media file in a downstream
action or workflow. Telestream MPEG-4 Reference files can be played in Switch.

Select the Output Location. Click Output Location and select from these choices:

- Available Vantage Store: Write the file to any available store, selected dynamically at
run-time. Use this option typically when you only have one store, or when you are
going to access and use the file by nickname in a downstream action - a transport or
staging action, for example.

When you display the Vantage Folder Address Book, click the ? icon for more assistance.
For more information on Vantage folder addresses, see the Vantage User Guide or the
Vantage Domain Management Guide.

- Vantage Store/Folder: Write the file to a specific Vantage store or folder. Select from the
list, or click the Browse button to display the Vantage Folder Address Book where you
can create, edit, and manage your Vantage folder addresses.

When you display the Vantage Folder Address Book, click the ? icon for more assistance.
For more information on Vantage folder addresses, see the Vantage User Guide or the
Vantage Domain Management Guide.

- Path: Write the file to a specific Windows file system server and directory. Manually
enter a Windows share (UNC path) or drive letter (not recommended on Vantage arrays)
or click Browse to navigate and select the location. Or, click the green Browse button
and select a variable which supplies the fully-qualified path.

Edit Filename Pattern. Displays the Filename Pattern Editor so that you can construct
the exact filename pattern you require. Default: Base Name.

Click the insertion point in the text field and use the gear menu to select one or more
tokens or multiple tokens of the same type to insert along with optional, static text
fragments for the filename you are creating. You must specify a file extension. Drag
tokens to re-arrange them; to delete a token, select and press Delete or right-click and
select Delete.

Tokens:

Ty
Avid Integration Guide telestream



52 | Exporting Master Clips | Subclips | Sequences
Configuring an Asset Monitor Action

- Base Name: Adds the Base Name (the portion of the filename excluding the period
and the extension) of the input source file output filename to the output filename.

- Variable: Adds the value of the specified variable to the output filename. The Variable
token is replaced by the value it holds when the action executes. The variable should be
set prior to execution of this action. For example, if a Variable token named /SC/ is given
the value 12H4 JA 678, wherever the ISCl variable token exists in the filename pattern
it is replaced with 12H4JA678.

- Date: Adds the date to the filename. Right-click the down-arrow to select the date
format.

- Time: Select to add the time to the filename. Right-click the down-arrow to select the
time format.

Select the Media Nickname. Click the menu to select the nickname (or enter it
manually) for this new file.

Specify the Container File Extension. Select the output panel and specify the file
extension for the selected wrapper, at the base of the right panel.
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Ingesting Master Clips
Directly into a Workflow

This chapter describes how the Retrieve action is implemented in Vantage, and how
you can use it to start a job with a master clip’s MOB ID, using it to provide Vantage
access to its assets for transcoding or other processing.

Workflows can use the Retrieve action to quickly and efficiently generate a proprietary
Telestream MP4 reference file (with video, audio and ANC data) plus an optional
external metadata file and AAF file for processing by downstream actions or other
workflows.

These workflow jobs are triggered via an API-based system or manually, via a
Workorder or Receive action.

Topics

S
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Overview

Overview

m Overview
m Using Telestream MP4 reference Files
m Creating a Prototype Retrieve Action Workflow

m Configuring a Retrieve Action

Workflows using a Retrieve action initiate a job each time an Interplay master clip’s
MOB ID is submitted to it and generating an MP4 reference file, plus optional metadata
and AAF files. The Retrieve action makes the master clip’s assets identified by the MOB
ID from the target Interplay system accessible to the Vantage workflow. The Retrieve
action can't process an asset if it is in an offline or partially online state, because
Vantage can not create an MPEG-4 Reference with missing Avid OP Atom media.

Note: The Retrieve action is designed as a same-as-source-converter, assembling
media as quickly as possible for processing (typically production transcoding and
related tasks) by downstream actions or other workflows. It does not perform
decoding/encoding operations. For details, see Ingesting Master Clips Directly into a
Workflow and Configuring a Retrieve Action.

Retrieve actions are executed by the Vantage Avid Service.

Typical workflow functionality involves transcoding the MP4 file downstream in Flip64
or other transcoding action to produce the desired output format. Metadata and AAF
are optional output files that are delivered as attachments.

Feature Summary

Here is a summary of the features of the Retrieve action:

» Accepts a MOB ID via APl or manual submission, makes the associated master file’s
assets accessible to downstream Vantage actions, and produces a Telestream-pro-
prietary MP4 reference file for use in downstream actions

» Generates optional metadata file

» Produces optional AAF file.
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Limitations

Here is a summary of the limitations of the Retrieve action:
» Only processes master files—can not process sequences or subclips

» Master file assets, metadata, and media must all be accessible—not partially or
completely offline

e Can not execute in Open workflows

Avid Version Requirements

Vantage and Live Capture are continually tested for Avid compatibility as new versions
become available. For details, see Required Avid Components.

Processing Asset Types

Master Clip. When processing a multi-resolution asset from MediaCentral | Production
Management, the largest media size is processed by default. This is not always the
highest quality.

AAF File Generation

The Retrieve action can optionally generate AAF files for use in other applications. For
example, Edit While Ingest operations and file compositing for matte/key effects in
Avid Media Composer.

Telestream MP4 Reference File Generation

The Retrieve action creates a Telestream MP4 reference file that references MXF OP-
Atom files located on Avid shared storage for the asset and may also include additional
transcoded media and media samples. The MP4 reference file also includes ancillary
data extracted from the MediaCentral | Production Management assets data track.
Additionally, a metadata XML file containing the Production asset’s user metadata and
Production System data is generated. The MP4 reference file and XML file are passed to
downstream actions in the workflow or to other workflows for transcoding and
metadata extraction.

Metadata Preservation

Most MediaCentral | Production Management systems have been developed with a
specific and often complex Production schema for metadata storage and manipulation
within a Production Workgroup, and contain asset-based metadata including custom
user properties.

The metadata associated with an asset stored in the Production database is preserved
by the Retrieve action within a metadata XML file. All ANC data contained in the asset’s
data track is also preserved in the MP4 reference file through Telestream extensions to
the MP4 container (see Using Telestream MP4 reference Files for information on
processing and playing of these files). When the file is passed downstream, the
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associated XML file is also transferred, making the metadata available for extraction
and processing as required.

Using Telestream MP4 reference Files

Telestream-proprietary MP4 reference files generated by the Retrieve action may be
processed by downstream Vantage encoding actions such as Flip64, and others. These
files must have fully authenticated access to the media files located in the Avid shared
storage.

Creating a Prototype Retrieve Action Workflow

Here is a prototype Retrieve action workflow depicting a typical use-case:

Receive o | Retrieve

In this workflow, three actions are implemented:

Receive—The Receive action initiates a job when media is passed to it from a Forward
action in another workflow, when a job is submitted via the Vantage SDK interface, or
when a MOB ID is manually submitted to the workflow in Workflow Designer. This
Receive action should be configured with a text variable to receive the MOB ID.

Note: For testing purposes, you can configure the Receive action to receive a media
file (which is unused) in addition to the variable you've specified for the MOB ID, and in
the Retrieve action, paste the MOB ID into the MOB ID control. Or, paste MOB ID
directly into the variable as the default value.

Retrieve—configured to ingest the MOB ID via the specified variable from the Receive
action and generate an MP4 file, with optional metadata and AAF file output.

Flip64—configured with an XDCAM encoder, the action creates a high-resolution file.

Configuring a Retrieve Action

The Retrieve action receives an AVID Interplay asset’s master MOB ID. It retrieves the
assets identified by the MOB ID from the target Interplay system, and generates a
Telestream MP4 reference file as the primary output. The Retrieve action can not
process an asset if it is in an Offline or partially Online state, because Vantage can not
create an MP4 Reference with missing Avid OP Atom media.
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Retrieve actions are executed by the Vantage Avid Service.

Workflows using a Retrieve action may start with a Receive origin action configured
with a variable to enable it to receive the MOB ID - from an API-based external system, a
Forward action in another workflow, a Workflow origin action, or a manual job
submission in Workflow Designer.

The Retrieve action is designed as a same-as-source-converter, assembling media as
quickly as possible for processing (typically production transcoding and related tasks)
by downstream actions or other workflows. The Retrieve action can not process assets
that are sequences or subclips.

Typical workflow functionality involves transcoding the MP4 file downstream in Flip64
or other transcoding action to produce the desired output format. Metadata and AAF
are optional output files that are delivered as attachments.

Before this action can be used in a workflow, you may configure your Vantage domain
for the MediaCentral | Production system(s) you are using. See Adding a MediaCentral |
Production Management System to Vantage, below, for details. Alternatively, you can
define the target Interplay directly in the action.

Topics
m MP4 File Generation
m Adding MediaCentral | Production Management Connections to Vantage

m Configuration Details

Note: Controls with a green Browse button may be bound to a variable to
dynamically assign their setting or value. The variable must have a value when this
action executes. You can assign the value to the variable in a previous action in the
workflow or use the variable's default value. Click Browse to select the variable or
Create a new one.

MP4 File Generation

The Retrieve action creates a Telestream proprietary MP4 file that references MXF OP-
Atom files located on Avid shared storage for the asset and may also include additional
transcoded media. The file also includes VANC data extracted from the Interplay asset's
data track. In addition, a metadata XML file containing the Interplay asset's metadata
may be generated. The MP4 reference file (and XML metadata file and AAF file if
present) may be passed to downstream actions in the workflow or to other workflows
for transcoding and metadata extraction.

Any system processing these MP4 files must have fully-authenticated access to the
media files located in the Avid shared storage (ISIS/NEXIS).

MP4 files generated by the Retrieve action contain Telestream-proprietary extensions
and are primarily for utilization within the Telestream ecosystem. Therefore, the
following requirements apply:
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- Vantage Flip64 actions processing these files must use the Auto decoder.

- For playback, Switch 4.0 or later is required and processes closed captions including
other metadata in these files.

Adding MediaCentral | Production Management
Connections to Vantage

To identify the target Interplay system, you can define it directly in the Retrieve action
or you may add and configure an Interplay connection in your Vantage domain to
communicate with each MediaCentral | Production Management system you are
interacting with.

Note: The systems displayed in the Retrieve action Interplay Configuration menu are
those that have been added to Vantage via the Vantage Management Console.

To add an Interplay connection to Vantage and configure and test it, follow these steps:
1. Start the Vantage Management Console.
2. In Settings & Options, display the Interplay tab.

Vantage displays the Interplay configuration panel where you create, configure,
delete, import and export MediaCentral | Production Management system connec-
tions.

3. Create and configure a connection to the target system, providing the following
information:

- Connection Name

- Interplay Web Services Host
- Interplay Web Services Port
- Interplay Workgroup

- Interplay Username

- Interplay Password

For more details on configuring and managing connections, click the ? icon to dis-
play the topic in the Vantage Domain Management Guide.

4. Click Test to confirm that Vantage can access the target MediaCentral | Production
Management server. If you have problems, determine the issue and retry.

Interplay Configuration: Interplay v

Output media file nickname: {7} v Edit Filename Pattern...

-~ General

Mob Id:
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Configuration Details

Interplay Configuration

Interplay Configuration. Specifies Interplay | <<Specific user-specified Interplay
systems>>. The specific Interplay systems menu items are dynamically generated from
the MediaCentral | Production systems identified in the Vantage Management Console.
See Adding MediaCentral | Production Management Systems to Vantage (above) for
details.

Note: When you select a pre-defined Interplay system, the Interplay Definition panel
(directly below the General panel) is hidden. If you select Interplay, the Interplay
Definition panel displays and must be configured to identify the target system.

Configuring Output Media File Settings

Output Media File Nickname. Specifies the nickname associated with the MP4 output
file for use in downstream actions.

Edit Filename Pattern. Opens the Filename Pattern Editor. Enter the complete
filename or a portion of the filename, and use the menu on the right side to select one
or more tokens to insert to create the exact filename pattern you require. You can drag
and drop a token to change its order relative to other tokens, thus changing its location
in the filename. Use the following tokens:

- Base Name. The name of the file, without the extension.
- Variable. You select the variable to use.

The Variable token is replaced by the value it holds when the action executes. The
variable should be set prior to execution of this action. For example, if a variable token
ISClis given the value 12H4JA678, wherever the ISCl variable token appears in the
filename pattern it is replaced with that value.

- Date. The current date at the time the filename is constructed. Change the date
format using the menu.

- Time. The current time at the time the filename is constructed. Change the time
format using the menu.

General Settings

Mob ID. Specifies the Mob ID associated with the Avid asset registered in the specified
Interplay system.
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Interplay Definition

¥ General
4 Interplay Definition

Interplay Web Services Host:

-~

Interplay Web Services Port: 80 v 1-65535 -

Interplay Workgroup:

Note: This set of controls is only displayed when you select Interplay from the
Interplay Configuration menu, to provide the target system directly in the action. If
you select an Interplay system that you have defined in the Vantage Management
Console, this panel is not displayed.

Interplay Web Services Host. The DNS/IP address of the Interplay Web Services server.

Interplay Web Services Port. The port being utilized by the Interplay Web Services
server.

Interplay Workgroup. Name of workgroup (case-sensitive) associated with this
Interplay system.

Interplay Username. Authorized user name.

Interplay Password. Authorized password.

Output Interplay Metadata

Configure these controls to generate a separate metadata XML file containing CML, as
an attachment file for use downstream or separately. In Vantage, you can use the
Extract action to access the AVID assets metadata in these files.

The metadata CML file contains the MXF file paths, Avid User properties - Name/Value
string pairs, Avid Interplay Frame Locators, Avid Asset Restrictions (Copyright
information, TV rating, etc.).

Aetadata Enable W

Metadata File: | specify the output:

File nickname:

® File name:

Overwrite Existing Metadata File -

Output Interplay Metadata. Specify Enable to generate an optional metadata file in
XML format and supply a nickname or fully-qualified filename.

File Nickname. Select File nickname to identify the file by nickname.
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File Name. Manually enter or browse and select the fully-qualified path to the XML
metadata file. The destination must be writable by the Vantage Avid Service.

Overwrite Existing Metadata File. When checked, write the new file out to the
destination, overwriting the existing file (if it is writable) without warning. If unchecked
and the file exists, the job fails at the start of the job when user configuration is
validated.

Output AAF

Configure these controls to generate a separate AAF file, as an attachment file for use
downstream or separately.

-~ Qutput AAF  Enable W

AAF File: | Specify the output:

File nickname:

@ File name:

Overwrite Existing AAF File =

Output AAF. Specify Enable to generate an optional AAF file and supply a nickname or
fully-qualified filename.

File Nickname. Select File nickname to identify the file by nickname.
File Name. Manually enter or browse and select the fully-qualified path to the AAF file.

Overwrite Existing AAF File. Check to silently overwrite the existing output file
without warning. If unchecked and the file exists, the job fails at the start of the job
when user configuration is validated.

Override Output Path

Configure these controls to override the default output path for the MP4 Reference file,
for use downstream or separately.

=« Override Output Path  Enable ¥

Output Asset Path:

Create Unique Folder =

Ovenwrite Existing Output File -

Override Output Path. Specify Enable to override the default MP4 location (Vantage
store) and supply a fully-qualified filename. When disabled, the location is the default
Vantage store.

Output Asset Path. Manually enter or browse and select the fully-qualified path to the
MP4 reference file. The destination must be writable by the Vantage Avid Service.
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Create Unique Folder. Specify Enable to generate a folder in the path, and write the
file to the new folder. The subfolder is named with a randomly generated GUID.

Overwrite Existing Output File. Check to silently overwrite the existing output file
without warning. If unchecked and the file exists, the job fails at the start of the job
when user configuration is validated.
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Generating and Ingesting
Avid-Compatible MXF OP-
Atom Media

You can re-wrap primary/proxy media into an Avid-Compatible MXF OP-Atom
container for use in an Interplay environment or Media Composer by creating
workflows implemented with the Media Creation action. The Media Creation action
doesn’t transcode media; it simply re-wraps it. Therefore, you may have to transcode
your media before processing it in the Media Creation action to use video that is
compatible with MXF OP1a.

This chapter describes how the Media Creation action is implemented in Vantage and
how you can use it in workflows to re-wrap media for import into Interplay
(MediaCentral | Production Management) environment or Media Composer
environment.

For a complete description of the Media Creation action’s configuration details, see
Media Creation Action Configuration.

Note: The listed license options do not support Edit While Ingest mode used with the
AAF action. These require V-AVID or LS-LIVE-AVID-OPT license options.

Topics
m Overview
m Creating Media Creation Workflows
m Media Creation Action Configuration
m Avid Multi-Res Configuration using Flip64

Overview

Media Creation actions are executed by the Vantage Avid Service.

The Media Creation action has two operational modes for generating MXF OP-Atom
media files—one for ingest into an Interplay (MediaCentral | Production Management)
environment and one for a direct ingest to Media Composer environment:
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» Media Composer Mode. For creating Avid-compatible MXF OP-Atom media files
and the associated AAF file, including User Property metadata for use within a
Media Composer editor directly. On a Vantage system, this mode is enabled with a
Transcode Pro license. On a Live Capture system, this mode is enabled with the
default Live Capture license.

« Interplay Mode. For creating Avid-compatible MXF OP-Atom media files and meta-
data that can be written to Avid shared storage and automatically checked into Pro-
duction. On a Vantage system, this mode is enabled with a Transcode Pro Connect
license containing the Advanced Avid Option. On a Live Capture system, this mode
is enabled with the Live Capture Avid Option.

When ingesting media into Avid shared storage and checking the asset into a
Production system, the asset can include integrated User Properties, Asset Restrictions,
Locators, and a Head Frame file. Additional operations can be added by using a Notify
Action.

If the workflow is set into an Open Workflow mode, Frame Chase (Edit While Ingest) can
be enabled allowing a media file to be edited as it is being written into Production.

Note: In Interplay mode, for master files, you can enable the Custom Metadata
Management to allow an Asset Name to be updated in Interplay (MediaCentral |
Production Management) from an Open, Edit While Ingest Flip64, Lightspeed Live
Capture or Tape workflow. When you enable Custom Metadata Management, Vantage
can update User Metadata and create a head frame in the asset while the file is open
and growing, without requiring the use of the Notify action to generate the MOB ID in
primary videos. For proxy generation, you are still required to use the Notify action to
generate the MOB ID.

This action is open workflow-capable if the Open Workflows license is installed; right-
click the action and select Workflow Mode > Open. Open Workflows must also be
enabled for the current workflow and in the Vantage Management Console > Settings.
For Open Workflow configuration details, consult the Vantage Domain Management
Guide available on the Telestream website.

Note: The Media Creation action does not perform media transcoding. Files are re-
wrapped into Avid compatible MXF OP-Atom files. Therefore, the video must already
be in the required format.

If the video in the file you want to add/update does not contain video in the
appropriate format, it should first be processed through a Flip64 or Capture action to
produce MXF OP1a or TIFO media containing video in the proper format. For Flip64 or
Capture configuration details, consult the appropriate guides available on the
Telestream web site.

You can also perform live or tape capture operations using the Capture or Tape action
workflows on video you want to ingest. Configure the Capture/Tape action to produce
MXF OP1a or TIFO media containing video in the proper format. For Flip64 | Capture |
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Tape action configuration details, consult the appropriate guides available on the
Telestream web site.

Note: For Live Capture | Tape workflows using the Media Creation action, always
enable Set One Track per Channel.

Media Creation Action Codec Support

The Media Creation action supports pass-through of media in these forms:
» AVClIntra 50
« AVClIntra 100
» AVC Long GOP G12/G25/G50
e AVCUItra
e DNxHD 444 /HQX/HQ/SQ/LB
» DNxHR 444 /HQX/HQ/SQ/LB
e DV based 25/50/100
e DVCPro HD
e H.264 800Kbps / 1.5Mbps / 2 Mbps Proxies
e IMX30/40/50
e XAVC Long GOP 25/30/50
» XAVClIntra 50/ 100
e XAVClIntra Class 300 CBG/ VBR
» XAVCIntra Class 480 CBG / VBR
» XDCAMHD 18/35
o XDCAMHD 50
 XDCAMEX 35

Note: J2K support is limited; not all J2K progressive formats are expected to process
correctly. J2K interlaced files are not supported in AMT.

AVC Intra 2K/4K 444 formats are not currently supported for Avid Flip64 workflows.
Flip64 supports creation of Open MXF XDCAM HD for use in the Media Creation action
as well as TIFO files for open, Edit While Ingest workflows.
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Creating Media Creation Workflows

You can create a variety of workflows using the Media Creation action for ingest into
Interplay (MediaCentral | Production Management) systems. These include but are not
limited to single resolution and multi-resolution workflows, metadata processing, and
the generation of Avid classic proxies as required.

Note: In Interplay mode, for master files, you can enable the Custom Metadata
Management to allow an Asset Name to be updated in Interplay (MediaCentral |
Production Management) from an Open, Edit While Ingest Flip64, Lightspeed Live
Capture or Tape workflow. When you enable Custom Metadata Management, Vantage
can update User Metadata and create a head frame in the asset while the file is open
and growing, without requiring the use of the Notify action to generate the MOB ID in
primary videos. For proxy generation, you are still required to use the Notify action to
generate the MOB ID.

Single Resolution Mezzanine Workflow

» Watch Action (Set to Open mode)—origin action, configured to monitor for
sources.

 Flip64 Action (Set to Open mode)—transcode to the appropriate media format
with Avid specific settings. TIFO and MXF OP1A are supported.

» Media Creation Action (Set to Open mode)—write Avid OP-Atom and AAF to Avid
Storage and check asset into Production. Select TIFO or MXF OP1A as input
depending on type specified in Flip64 action.

Check In

b
|
I

Find file and start job Transcode to AVID

Note: When creating Open MXF XDCAM HD files with Flip64 for use in the Media
Creation action, configure partition settings in Flip64 as specified below.

~ General

Partition Strategy:

V' Partition Duration:

Partition Strategy—Select ‘Place essence container in the body partition, the Index
Tables are placed in the partition following essence partitions + RIP"

Partition Duration—Enable and set to 5 seconds.
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Simple Live Capture to Production Workflow

» Capture action (Set to Open mode)—origin action, create MOB IDs, Capture into
Avid format. TIFO and MXF OP1A are supported. Always enable Set Force One Track
Per Channel when using the Capture action or Tape action in a Media Creation
workflow.

» Media Creation Action (Set to Open mode)—write Avid OP-Atom and AAF to Avid
Storage and check asset into Production. Select TIFO or MXF OP1A as input
depending on type specified in Capture action.

Note: For workflows which use Capture to generate proxies, Master MOB and Source
MOB ID variable generation is specified in the Capture action configuration so a Notify
action is not required.

Note: MPEG-1 Layer 2 audio is supported in Media Creation for Avid Proxy format
created by Capture.

Media Creation Action Configuration

Configuring a Media Creation action involves three distinct steps:

 Select the format of your input file for proper decoding. See Media Creation Action
Configuration.

» Configure the high-level controls for the Media Creation action to perform as speci-
fied, regardless of whether you are delivering media to Media Composer or an
Interplay system. See Configuration Overview.

» Configure Media Composer controls or Interplay controls, based on your target sys-
tem. See Configuration Details.

Input Formats

Select. Specifies Auto | AIFF | MXF OP1a | TIFO | Wave. See Media Creation Action Codec
Support for supported formats.

 Select Auto Input to ingest media which is in a video/audio format supported by
your Media Composer or a Interplay (MediaCentral | Production Management)
environment for re-wrapping into Avid-compatible MXF OP-Atom files.

 Select AIFF Input to ingest media from an AIFF input file for re-wrapping into Avid-
compatible MXF OP-Atom files.
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» Select MXF OP1a Input when you are processing Open MXF OP1a files created by
Lightspeed Live Capture. For other supported file formats, select Auto or TIFO.

 Select TIFO Input when you are capturing video in open workflow mode in TIFO for-
mat and want to re-wrap it into Avid-compatible MXF OP-Atom files. TIFO input is
Open Workflow capable.

 Select Wave Input when you are ingesting media from a WAVE input file for re-wrap-
ping into Avid-compatible MXF OP-Atom files. Each Wave input supports one-
channel-per audio track(s). This input component should only be utilized when you
are processing WAVE files. Submitting non WAVE files to this input will result in job
failures. For other supported file formats select Auto, MXF OP1a or TIFO.

Media Creation Settings
Media Creation actions are executed by the Vantage Avid Service.

Vantage Avid Service log files (avid.trace) are written to the C:\Program Files
(x86)\Telestream\Vantage\Avid directory on the server where the Vantage Avid Service
that executed the action is hosted. Update the config file to write log files per your
requirements.

The Media Creation action enables you to create single and multi-resolution assets for
use in a Media Composer or a MediaCentral | Production Management system. The
Media Creation action operates in two modes: Media Composer mode and Production
mode. Your first configuration task is to choose the mode from the Interplay
Configuration menu at the top of the configuration details panel.

Note: You can select Interplay and configure the target system directly in the action.
Or, you can identify one or more Media Central | Production Management systems in
the Vantage Management Console - Workflow Designer automatically displays these
systems by name in the same menu. This enables you to choose the target
MediaCentral | Production Management system from the menu, avoiding repeated
manual configuration.

- Media Composer Mode: Select Media Composer to create Avid-compatible MXF OP-
Atom files including metadata for ingest into a Media Composer editor. Media
Composer is not required to be part of a MediaCentral | Production Management
infrastructure.

- Interplay Mode: Select Interplay Mode | Pre-defined MediaCentral | Production
Management System (see Adding MediaCentral | Production Management Systems to
Vantage, below) to create Avid MXF OP-Atom files and metadata written to ISIS/NEXIS
storage and automatically checked into a MediaCentral | Production Management
system. Specific systems may be identified in the Vantage Management Console and
selected from the menu.

When delivering media directly to a MediaCentral | Production Management system,
assets include integrated User Property and Headframe creation. Locator metadata can
also be created; use a Notify action for delivery along with the Avid Production Web
Service check-in into an Avid MediaCentral | Production Management workspace.
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You can also create files for ingest into Media Composer in Open mode for Frame Chase
editing; metadata insertion is supported while live video is being captured and the file
is being processed in Vantage, enabling real-time editing.

Note: The Media Creation action does not perform transcoding. Files are re-wrapped
into Avid-compatible MXF OP Atom AAF files. Therefore, the video must already be
processed if required, with a supported codec. The Media Creation action supports a
number of popular file formats. Consult the Generating and Ingesting Avid-
Compatible MXF OP-Atom Media chapter in the Avid Integration Guide for the list.

If the video in the file you want to add/update is not in a supported format, it should
first be processed through a Flip64 action to produce MXF OP1a media containing
video in the proper format.

This action is Open workflow capable. It requires an Open Workflows license; right-click
the action and select Workflow Mode > Open. Open Workflows must also be enabled
for the workflow and at the domain level, in Vantage Management Console > Settings.

Note: Controls with a green Browse button may be bound to a variable to
dynamically assign their setting or value. The variable must have a value when this
action executes. You can assign the value to the variable in a previous action in the
workflow or use the variable's default value. Click Browse to select the variable or
Create a new one.

Accessing a MediaCentral | Production Management System

Prior to designing and implementing Avid workflows in Vantage to access
MediaCentral | Production systems, you (the customer or Avid representative) must
identify each system, including credentials.

Use these specifications to define Avid connections in the Vantage Domain Console for
use in Media Creation, Retrieve, and Asset Monitor workflows, or define them statically
or dynamically via variables, directly in your workflows.

Retrieve, Asset Monitor, and Media Creation actions are configured to interact with a
specific MediaCentral | Production Management system. System configuration may be
manual—statically specifying a system which does not change on a job-by-job basis.

System identification can also be dynamic, where you can use variables to identify the
system dynamically for each job you execute. This is preferable when you may be
accessing one of many Avid systems in a single workflow, based on run-time metrics.
Dynamic, variable-driven workflows often simplify workflow design and utilization.

Note: Always connect to MediaCentral | Production Management and Avid
Production Web Services using a fully-qualified DNS name, which is registered with
Forward and Reverse look up tables in DNS.
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Note: Specific Avid systems that display in the Interplay Configuration menu are
connections that have been configured in Vantage via the Management Console. For
full details, see the Avid Integration Guide > Accessing MediaCentral | Production
Management Systems.

To add a MediaCentral | Production connection to Vantage, follow these steps:

1. In the Vantage Management Console, in Settings & Options, display the Avid tab.
The configuration panel enables you to create, configure, delete, import and export
MediaCentral | Production Management system connections.

2. Create and configure a connection to the target system, providing the following
information:

- Name (displays as a menu item in the action's Interplay Configuration menu)
- Web Services Host (enter the IP address | DNS name)

- Interplay Web Services Port

- Production Workgroup

- Production Username

- Production Password

For more details on configuring and managing connections, click the ? icon to dis-
play the topic in the Vantage Domain Management Guide.

3. Click Test to confirm that Vantage can access the target MediaCentral | Production
Management server. If you have problems, determine the issue and retry.

Action Configuration Details

Input (Left Panel)
Select. Specifies Auto | AIFF | MXF OP1a | TIFO | Wave.

- Auto: Ingest media which is in a video/audio format supported by your Media
Composer/MediaCentral | Production system for re-wrapping into Avid-compatible
MXF OP-Atom files.

- AIFF: Ingest media from an AIFF input file for re-wrapping into Avid-compatible MXF
OP-Atom files.

- MXF OP1a:To process Open MXF OP1a files. For other supported file formats, select
Auto or TIFO.

Note: The MXF OP1a decoder supports open workflows only for files being created
by Lightspeed Live Capture and Flip64.

- TIFO: To capture video in open workflow mode in TIFO format for re-wrapping into
Avid-compatible MXF OP-Atom files. TIFO input is Open Workflow capable.
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- Wave: To ingest media from a WAVE input file for re-wrapping into Avid-compatible
MXF OP-Atom files. Each Wave input supports one-channel-per audio track(s). This
input component should only be utilized when you are processing WAVE files.
Submitting non WAVE files to this input will result in job failures. For other supported
file formats select Auto, MXF OP1a or TIFO.

Interplay Configuration Mode

Production Configuration. Specifies Media Composer | Interplay | <<Avid System
connections identified in the Management Console>>. There may be zero or more
connections in the menu, depending on the connections you've created. The
connections below the Media Composer | Interplay menu items are dynamically
generated from the MediaCentral | Production systems identified in the Vantage
Management Console. See Adding MediaCentral | Production Management Systems to
Vantage (above) for details.

- Media Composer. Select to write AAF files to a specific location, and configure the
Media Creation action to facilitate Media Composer ingest and use of the files.

- Interplay: A workflow-specified MediaCentral | Production Management system.

- <<Avid System connections identified in the Management Console>>. There may be
zero or more connections in the menu, depending on the connections you've created.
The list is dynamically generated from the MediaCentral | Production connections
identified in the Vantage domain. See Adding a MediaCentral | Production Management
System to Vantage (above) for details.

Configuring Output Media File Settings

Output Media File Nickname. Specifies the nickname for the output file for use in
downstream actions.

Edit Filename Pattern. Opens the Filename Pattern Editor. Enter the complete
filename or a portion of the filename, and use the menu on the right side to select one
or more tokens to insert to create the exact filename pattern you require. You can drag
and drop a token to change its order relative to other tokens, thus changing its location
in the filename.

You can use the following tokens:
- Base Name. The name of the file, without the extension.
- Variable. You select the variable to use.

The Variable token is replaced by the value it holds when the action executes. The
variable should be set prior to execution of this action. For example, if a variable token
ISClis given the value 1214372678, wherever the ISCl variable token is located in the
filename pattern, it is replaced with that value.

- Date. The current date at the time the filename is constructed. Change the date
format via the menu.
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- Time. The current time at the time the filename is constructed. Change the time
format via the menu.

Media Composer Configuration

Use these panels to configure the Media Creation action for use with a Media
Composer system:

Physical File Settings
A e e
AAF File Location:
MXF File Location:
Delete AAF Subdirectory and Temporary Files

Create Unique Folder for AAF  —

4 Physical Directory Control | Limit Files per Directory ¥

Max Number of Files in MXF Directory: 5000 % files -

~ Copy AAF File | Enable ¥

AAF Copy Directory:

Overwrite Existing AAF File -

AAF File Location. Specifies the UNC path to Avid storage where the AAF file will be
written. The typical pattern is \\<servername>\<workgroup folder>\<filename>. For
example: \\avidnexispro\Interplay2021\AAF\AAF Filel.aaf.

MXF File Location. UNC path to Avid storage where the MXF OP-Atom media files will
be written. The typical pattern is \\servername\workgroup folder\Avid
MediaFiles\MXF\file. For example: \\avidnexispro\Interplay2021\Avid
MediaFiles\MXF\MXF Filel.mxf.

Note: Initial MXF path name must include the \Avid MediaFiles\MXF\ string.

Delete AAF Sub-directory and Temporary Files. When checked, deletes the AAF files
and temporary files after the media has been checked into Interplay. These files are not
deleted if the job fails.

Create Unique Folder for AAF. When checked, creates a unique directory folder for the
output AAF file.

Physical Directory Control. Specifies Limit Files per Directory | Do Not Limit Files per
Directory.

/_'\
telestream Avid Integration Guide



Generating and Ingesting Avid-Compatible MXF OP-Atom Media | 73
Media Creation Action Configuration

- Limit Files per Directory: When Limit Files per Directory is selected, update the Max
Number of MXF Files in MXF Directory field to specify the maximum number of files.
When the maximum is reached, the action creates a new directory with a numerical
suffix (<dirname>.1, etc.) to store the next set of files. Range: 100 - 10,000. Default:
5,000.

- Do Not Limit Files per Directory: When Do Not Limit Files per Directory is selected, there
is no maximum.

Copy AAF File. Specifies Enable | Disable:
- Enable: Specifies the AAF Copy Directory and option to Overwrite Existing AAF File.

AAF Copy Directory. Browse to select or manually enter the fully-qualified folder
path.

Overwrite Existing AAF File. Check to overwrite an existing file of the same name
in the target copy directory; uncheck to fail the action.

- Disable: Do not copy the AAF file. Local AAF file is temporary and disposed of per
Vantage settings.

Note: If Overwrite Existing File is unchecked and a file with the same name exists in
the destination directory, the job fails.

Asset Attributes

~  Asset Attributes

Master MOB ID:
Source MOB ID:

Disable Data Track in the Output -

~ Material Name Override W

Material Name:

-~ Timecode Overnde Timecode ¥

Override Timecode: 00 : 00 : 00 : 00 c 2997 W fps -

4 Input Type Tape W

Tape Name:

Master MOB ID. Specifies the master MOB ID for this asset.
Source MOB ID. Specifies the source MOB ID for this asset.

Disable Data Track in the Output. When checked, disables creation of a data track in
the output.
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Set Source Clip Start Time Offset. When checked, sets the timecode in the SMTE 377
timeline.

Material Name. Specify Use Media Name | Override. This name displays as the asset's
display name unless a non-empty tape name is configured.

- Use Media Name. Input media name is used to configure the asset name.

- Override. Overrides default asset name with the user specified value. When selected,
complete this control:

Material Name. Specifies the name to use for the asset.

Note: To change the AAF folder name and filename use the Filename Pattern Editor
to change the naming scheme.

Timecode

If the transcoded source uses drop frame timecode then the Media Creation action
generates drop frame output. Conversely, if the transcoded source is non-drop frame
then the generated output is also non-drop frame.

Timecode. Specifies timecode to use: Use Source Timecode | Override Timecode.
- Use Source Timecode. Uses the source timecode detected in the media.

- Override Timecode. Timecode detected in source file is used with no changes to the
timecode in the output. When selected, provide:

Override Timecode. Specify the timecode, frame rate, and drop frame or non-drop
frame notation to use.

Input Type

Both Tape Name and Source Package Name values change the first 9 characters of the
MXF output filenames and add metadata to Access and Media Composer in the tape
name field (no character limit). If values are entered, this overrides the name set in the
Filename Pattern Editor.

Dynamic Relinking: Avid uses the input descriptor information to check whether one of
the two media are proxies or can be dynamically relinked. In the case of Dynamic
Relinking using 2 Media Creation actions (1 high-res, the other proxy) the input
descriptors (Tape Name/Source Package Name values) must be the same. This is best
achieved by using a variable.

Naming Tapes: Tape names must be alphanumeric characters (A - Z, 0 - 9) and include
uppercase and lowercase characters. Select a case convention and maintain it
throughout a project.

Guidelines for MultiRez Tape Management: When working in a MultiRez workflow, it is
important to name tapes properly. In particular, you should keep the following in mind:
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Whenever you create a new tape, Media Composer generates a new source ID, even if
the name you type for the new tape exactly matches that of an existing tape. You
cannot dynamically relink media that does not share a source ID.

Do not use the same name for two different tapes or different names for the same tape.
This might cause incorrect media association. Do not use the default tape name New
Tape.

Input Type. Specifies input type: Tape | Import. Default: Import.

Tape: Select when media is tape-based, and specify the optional tape name of the
asset.

Note: Avid does not support ingesting media define as Tape for 4K media - the asset
displays as offline. Additionally, media with a non-zero timecode greater than 26
seconds also displays as offline.

Tape Name. When Input Type is Tape, optionally specify the asset tape name.

Import: When media is digital (disk-based), specifies the asset source package
name.

Note: While Avid strongly recommends using Import mode for file-based digital
media workflows, this method does not permit the Tape name field to be used for
relinking. Tape mode should be used for traditional dynamic relinking using the Tape
field.

Tape name data replaces the Asset Name set in the Vantage Filename Pattern Editor
when not empty. To configure the Asset Name you must configure a User Property
with the property name Display Name along with the desired value. Consult the Avid
Integration Guide for more details.

Source Package Name. When Input Type is Import, specifies the optional source
package name of the asset.

Asset Tag Properties

~ Asset Tag Properties

~ Tagged Values Enable w

~ [V Import Tagged Values

Tagged Values: | gpecify the input source:

File nickname:

@ File name:

~ [V Set Tagged Values

Add New ltem
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Tagged Values. Specifies Disable | Enable. When enabled, allows specification by
filename or file nickname of an XML file containing tagged values for an asset.

Import Tagged Values. When checked, allows specification by filename or file
nickname of an XML file containing tagged values for an asset.
File Nickname. Select File nickname to identify the file by nickname.
File Name. Manually enter or browse and select the fully-qualified path to the
XML file.

Set Tagged Values. When checked, allows specification of tagged value pairs that
are displayed in the Media Composer bin. Click Add New Item and configure pairs.
Each tagged value pair item contains metadata fields for the name and associated
value for the tagged pair.

. .
Processor Configuration
-« Processor Configuration
Hang Detection Interval: 160,000 < milliseconds -

Flush Period: 0 $ milliseconds ~

Progress Report Interval: 100,000 ¢ milliseconds =

« |0 Performance Tuning = Custom

Video Essence File System 10 Page Size: 512Bytes -

Audio Essence File System IO Page Size: 12 2 512Bytes -

Data Essence File System 10 Page Size: 131,072 512Bytes -
Video Essence File System IO Page Count: 4
Audio Essence File System 10 Page Count:

Data Essence File System 10 Page Count: ¢

Hang Detection Interval. (Default: 160,000) Specifies the time interval in MS to detect
a hung process.

Flush Period. (Default: 6,000) Specifies the flush period time interval in MS.

Progress Report Interval. (Default: 50,000) Specifies the progress report time interval
in MS.

10 Performance Tuning

Specifies Default | Custom. For Custom settings, configure these controls:

Video | Audio | Data Essence File System 10 Page Size. Larger size leads to better
performance. 512KB to 64MB in 512K increments. Note that If you are using NEXIS
Cloud and notice pixelation or missing frames in the first few seconds of a video,
you should set the Video Essence File System 10 Page Size below 65,536.

Video | Audio | Data Essence File System 10 Page Count. Smaller page count
leads to better performance. 1 - 4 pages.
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AAF Updates

« AAF Updates

AAF Update Interval: 0 v milliseconds -

Expected Maximum Duration: 21600 % seconds@60fps -

V| AAF Path: [ v Path variable to generate

AAF Update Interval. An AAF file, updated progressively, is made available for
importing into Media Composer for editing, at the beginning of media capture.
Specifies optional local AAF update interval time in milliseconds. Default is 0 (disabled).

Expected Maximum Duration. Expected duration in seconds, rationalized for 60 fps.

AAF Path and Mob ID Variables

AAF Path. When checked, specifies the path variable and is assigned the fully-qualified
path of the AAF file for use by downstream actions. Typically this is used in Open
workflows to provide an intermediate AAF path while media files are still growing. The
variable is set from the AAF action from the Input > Source > File name field.

Master MOB ID. When checked, specifies the text variable and is assigned the master
MOB ID of the asset for use by downstream actions.

Interplay Mode Configuration

Use the following panels to configure the Media Creation action for use with an
Interplay system that you want to specify directly in this action or for use with a specific
Interplay system:

Note: The Interplay Definition panel is only displayed when you select Interplay and
must identify the target system directly in the action. If you select an Interplay system
that you have defined in the Vantage Management Console, these controls are not
displayed.

Interplay Definition
4 Interplay Definition
Interplay Web Services Host:

~

Interplay Web Services Port 80 v 1-65335 -

Interplay Workgroup:

Interplay Usemname:

Interplay Password:

Interplay Web Services Host. The DNS/IP address of the Interplay Web Services server.
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Interplay Web Services Port. The port being utilized by the Interplay Web Services
server.

Interplay Workgroup. Name of workgroup (case-sensitive) associated with this
Interplay system.

Interplay Username. Authorized user name.

Interplay Password. Authorized password.

Interplay Settings

« Media Creation Settings

“ Interplay Settings

Interplay Folder: /Incoming Media/ Browse...

Create Interplay Folder Path -

Interplay Folder. Specifies the MediaCentral | Production Management virtual folder
path to be used for the output asset. For example, /Incoming Media/Media
Creation/New Folder or /Incoming Media/.You may entera known path;
browse to an existing folder path; or bind to a folder path variable.

Create Interplay Folder Path. When checked, creates the Production virtual folder(s)
that do not exist in the configured Interplay Folder path. When not enabled, the job
fails if the Interplay folder path does not exist.

These top-level system directories in Production can't be modified Catalogs
- Incoming Media

- Orphan Clips

- Projects

- Send To Playback

- Unchecked-In Avid Assets

Note: These special characters are not allowed in folder names 7 : /\" < > |

Frame Chase Editing. Specifies Enable | Disable. When enabled, creates a special type
of Production asset, that can be edited while media ingest is in progress. The growing
asset is available in the Production system, as soon as the initial check-in occurs. When
the media capture ends, a final update is made to the Production system. This update
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changes the clip's type from an in-progress clip to a conventional master clip and
updates the metadata. Configure these controls:

“~ Frame Chase Editing Enable ¥

Interplay Frame Chase Interval: 20,000 ¢ milliseconds

Expected Maximum Duration: 21,600 $ seconds@60fps -

V' Custom Metadata Management -

4 Second Interplay Folder  Enable W

Second Interplay Folder: /Incoming Media/

Create the Second Interplay Folder Path

Interplay Frame Chase Interval. Specifies the frame chase interval (integer - num-
ber of milliseconds). Growing assets are checked into Production at the end of
every specified frame chase interval.

Expected Maximum Duration. Specifies the expected maximum duration in sec-
onds @60fps that is displayed in Interplay Access and Media Composer while a file
is being processed. Once the file is complete and updated, the duration shows the
actual duration of the file. This applies to both open and closed workflow configu-
rations.

Custom Metadata Management. Enable to allow an Asset Name to be updated in
MediaCentral | Production Management in an Open, Edit-During-Capture (Frame
Chase) Flip64, Lightspeed Live Capture or Tape workflow. Enables Vantage to
update the asset user metadata and the head frame without requiring the use of
the Notify action to generate the MOB ID. For proxy generation in a Flip64 work-
flow, you must use a Notify action to generate MOB IDs. In a Capture/Tape work-
flow, you may use the Capture/Tape action to generate the MOB IDs directly.

Note: For improved Head Frame display performance in Interplay Access, enable
Custom Metadata Management.

Second Interplay Folder. Specifies Enable | Disable. When enabled, creates an
identical, duplicate media asset to a secondary folder on the same system.

Second Interplay Folder. Specifies the MediaCentral | Production Management
virtual folder path to be used for the secondary output asset. For example, /
Incoming Media/Media Creation/New Folder or /Incoming Media/.You
may enter a known path; browse to an existing folder path; or bind to a folder path
variable.

Create the Second Interplay Folder Path. Optionally, create the virtual folder
manually in Interplay Access. Or check the control to create the Production virtual
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folder(s) that do not exist in the configured Interplay Folder path. When not
enabled, the job fails if the Interplay folder path does not exist.

These top-level system directories in Production can't be modified Catalogs
- Incoming Media

- Orphan Clips

- Projects

- Send To Playback

- Unchecked-In Avid Assets

Note: These special characters are not allowed in folder names 7 : /\" < > |

Asset Head Frame. Specifies Enable | Disable. When enabled, allows specification of a
Head Frame source as generated by a Media Creation or Flip64 action. Creation of an
open Head Frame is supported.

4 Asset Head Frame Enable W
4 Asset Head Frame Source Create ¥

= Asset Head Frame Configuration | Specify Frame Number W

Frame Number: 0 ] o

Asset Head Frame Source. Specifies Create | Set. Allows specification of a Head
Frame source using Frame Number or Timecode (Create) or via an Asset Head
Frame file (Set). Configure these controls:

- Create. Specifies Head frame using frame number or timecode (default).

Asset Head Frame Configuration. Specifies Specify Frame Number | Specify
Timecode. Complete these controls as appropriate:
Frame Number. Creates and uses the first I-frame from the specified
frame number in the input video track.
Specify Timecode. Creates and uses the first I-frame from the specified
timecode in the input video track.
- Set. Specifies Head Frame using filename or nickname of the file generated:
File Nickname. Specifies the file by nickname. The file must have been ingested
by an upstream action and assigned a nickname. Use this option when the file
changes for each job.
File Name. Manually enter or browse and select the fully-qualified path to the
file. The Vantage service that executes this action must have access to the file
location. Use this option when you want to assign a static file, which is used for
every job. If you assign a variable, the variable must be assigned the fully-quali-
fied path and file name in an upstream action and the file can change for each
job.
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Interplay Asset Metadata. Specifies Disable | Enable. When enabled, allows metadata
to be added via a file using a (Interplay) Production metadata file or manually using
Add Asset Restrictions, Add Asset Locators, or Add User Properties controls.

“  Interplay Asset Metadata Enable ¥

~ V| Import Metadata

Metadata: Spedify the input source:
File nickname:

@ File name:

~ [V Add Asset Restrictions
Add New ltem

* [V] Add Asset Locators

« [V Add User Properties

Add New ltem

Note: The XML for Avid User Property Metadata and Locators uses a simple structure.
It consists of two Element types: <Entry> for adding Avid User Property data and
<Locator> for adding Avid Locator data. Each Element has several attributes, used to
supply data for the Entry or Locator element you are defining. Multiple Entry and
Locator elements are permitted. See MediaCentral | Production Management Metadata
XML.

Import Metadata File. Allows specification of an Production Asset Metadata file by
file path or nickname. Various parameters such as User Properties and Locators can
be added via an XML file.

Add Asset Restrictions. When checked, allows manual addition of Asset Restric-
tions. A restriction is a span of an asset that indicates a clip, or a portion of a clip,
whose use is limited in some way, such as through intellectual property rights man-
agement or content compliance. There are 2 options for setting the Restriction:

- In Frame Number / Out Frame Number

- InTimecode / Out Timecode
The Frame Number options are enabled by default and values entered in Timecode
fields are ignored. Disable the Frame Number options to use the In Timecode and
Out Timecode values.
If Frame Numbers are used, the In Frame Number and Out Frame Number are off-
sets from the beginning of the clip. A Frame Number is considered invalid if it is
negative or if it extends past the duration of the clip.

Note: Jobs complete successfully, and assets are created, even if a restriction was
unable to be added to the database. This can occur, for example, if an Asset Restriction
uses a non-existent frame number or timecode value. However, such failures with
Production transactions in setting the asset metadata will not result in job failures.
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Note: Unlike other Interplay Access metadata features, the following special
characters are allowed 7:/\" <> |.

Add Asset Locators. When enabled, allows the addition of frame locators and
associated attributes for assets. These include Comment, Color, Timecode, Frame
Number, and Track.

Add User Properties. When enabled, allows the addition of Avid User Properties. If
the name of the User Property does not exist, it is created and populated with the
associated value.

Note: When viewed in Interplay Access, copied clips may intermittently include a
random number sequence appended to the display name (EX.Dup_12345678).
Specifying ‘Display Name’for Name in Add User Properties metadata field prevents
this from occurring.

Physical File Settings
“«  Physical File Settings
AAF File Location:
MXF File Location:
Delete AAF Subdirectory and Temporary Files -

Create Unique Folder for AAF  —

4 Physical Directory Control | Limit Files per Directory ¥

Max Number of Files in MXF Directory: 5000 % files -

~ Copy AAF File | Enable ¥

AAF Copy Directory:

Overwrite Existing AAF File -

AAF File Location. Specifies the UNC path to Avid storage where the AAF file will be
written. The typical pattern is \\<servername>\<workgroup folder>\<filename>. For
example: \\avidnexispro\Interplay2021\AAF\AAF Filel.aaf.

MXF File Location. UNC path to Avid storage where the MXF OP-Atom media files will
be written. The typical pattern is \\servername\workgroup folder\Avid
MediaFiles\MXF\file. For example: \\avidnexispro\Interplay2021\Avid
MediaFiles\MXF\MXF Filel.mxf.

Note: Initial MXF path name must include the \Avid MediaFiles\MXF\ string.

Delete AAF Sub-directory and Temporary Files. When checked, deletes the AAF files
and temporary files after the media has been checked into Interplay. These files are not
deleted if the job fails.
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Create Unique Folder for AAF. When checked, creates a unique directory folder for the
output AAF file.

Physical Directory Control. Specifies Limit Files per Directory | Do Not Limit Files per
Directory.

- Limit Files per Directory: When Limit Files per Directory is selected, specify the Max
Number of MXF Files in MXF Directory. When the maximum is reached, a new
directory is created with a numerical suffix (<dirname>.1, etc.) to store the next set of
files. Range: 100 - 10,000. Default: 5,000.

- Do Not Limit Files per Directory: When Do Not Limit Files per Directory is selected, there
iS N0 maximum.

Copy AAF File. Specifies Enable | Disable.

- Enable: Specifies the AAF Copy Directory and option to Overwrite Existing AAF
File.

- Disable: Do not copy the AAF file. Local AAF file is temporary and disposed of per
Vantage settings.

Note: If Overwrite Existing File is unchecked and a file with the same name exists in
the destination directory, the job fails.

Asset Attributes

~  Asset Attributes
Master MOB ID:
Source MOB ID:
Disable Data Track in the Output -

~ Material Name Override W

Material Name:

-~ Timecode Overnde Timecode ¥

Override Timecode: 00 : 00 : 00 : 00 3 2997 W fps -

4 Input Type Tape W

Tape Name:

AAF Path: |

Master MOB ID. Specifies the master MOB ID for this asset.
Source MOB ID. Specifies the source MOB ID for this asset.

Disable Data Track in the Output. When checked, disables creation of a data track in
the output.

/_'\
Avid Integration Guide telestream



84 | Generating and Ingesting Avid-Compatible MXF OP-Atom Media
Media Creation Action Configuration

Set Source Clip Start Time Offset. When checked, sets the timecode in the SMTE 377
timeline.

Material Name

Specify Use Media Name | Override. This name displays as the asset's display name
unless a non-empty tape name is configured:

- Use Media Name. Input media name is used to configure the asset name.

- Override. Overrides default asset name with the user specified value. When selected,
complete this control:

Material Name. Specifies the name to use for the asset.

Note: To change the AAF folder name and filename use the Filename Pattern Editor
to change the naming scheme.

Timecode

If the transcoded source uses drop frame timecode then output is drop frame. If
transcoded source is non-drop frame then output is non-drop frame.

Specifies timecode to use: Use Source Timecode | Override Timecode:
- Use Source Timecode. Uses the source timecode detected in the media.

- Override Timecode. Timecode detected in source file is used with no changes to the
timecode in the output. When selected, specify...

Override Timecode. Specify the timecode, frame rate, and drop frame or non-
drop frame notation to use.

Override Physical Source Timecode

When the Media Creation action generates a new asset from a part of the media file
that was used to make another asset and these two assets need to be relinked, then the
new asset should have the same physical start timecode as the one made with the
complete media file.

Specifies: Enable | Disable. When enabled, specify...

Override Timecode. Specify the timecode, frame rate, and drop frame or non-drop
frame notation to use.

Input Type

Specifies: Tape | Import. Complete these controls as appropriate:
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Note: Avid does not support ingesting media via Tape mode for 4K media - the asset
displays as offline. Additionally, non-zero timecode greater than 26 seconds also
displays as offline.

- Tape Name. When Input Type is Tape, specifies the tape name of the asset.

- Import. When Input Type is Import, specifies the source package name of the asset.

Note: While Avid strongly recommends using Import for file based digital media
workflows, this method does not allow for the Tape name field to be used for relinking.
Tape mode may be used for traditional dynamic relinking using the Tape field.

Tape name data replaces the Asset Name set in the Vantage Filename Pattern Editor
when not empty. To configure the Asset Name you must configure a User Property
with the property name 'Display Name' along with the desired value. Consult the Avid
Integration Guide for more details on this configuration.

Processor Configuration
-« Processor Configuration
Hang Detection Interval: 160,000 € milliseconds -

Flush Penod: 0 C milliseconds ~

Progress Report Interval: 100,000 € milliseconds -

« |0 Performance Tuning Custom W

Video Essence File System 10 Page Size: 512Bytes -
Audio Essence File System 10 Page Size:
Data Essence File System 10 Page Size:
Video Essence File System IO Page Count: ¢
Audio Essence File System IO Page Count: 4

Data Essence File System 10 Page Count: ¢

Hang Detection Interval. (Default: 160,000) Specifies the time interval in MS to detect
a hung process.

Flush Period. (Default: 6,000) Specifies the flush period time interval in MS.

Progress Report Interval. (Default: 50,000) Specifies the progress report time interval
in MS.

10 Performance Tuning
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Specifies Default | Custom. For Custom settings, configure these controls:

Video | Audio | Data Essence File System 10 Page Size. Larger size leads to better
performance. 512KB to 64MB in 512K increments.

Video | Audio | Data Essence File System 10 Page Count. Smaller page count
leads to better performance. 1 - 4 pages.

AAF Path and Mob ID Variables

AAF Path. When checked, specifies the path variable and is assigned the fully-qualified
path of the AAF file for use by downstream actions. Typically this is used in Open
workflows to provide an intermediate AAF path while media files are still growing. The
variable is set from the AAF action from the Input > Source > File name field.

Master MOB ID. When checked, specifies the text variable and is assigned the master
MOB ID of the asset for use by downstream actions.
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Avid Multi-Res Configuration using Flip64

The Media Creation action supports TIFO x264 inputs with an Avid-compatible proxy
format (up to 16 channels of MPEG-1 Layer 2 audio) and a compatible high-res format
created by Flip64 (see Flip64 Settings for Avid Proxies).

Note: The Media Creation action supports TIFO files with MPEG-1 Layer 2 audio.

Media Creation 7

Monitor for Input MOE ID Variables Make Proxy and Hi-Res

Avid Multi-Res Workflow using Flip64
» Watch Action—origin action.

» Notify Action—generates Master MOB and Source MOB ID variables. These vari-
ables are bound in the Media Creation actions and allow the high-res and proxy
assets to be toggled using Dynamic Relinking in Media Composer.

Note: In Interplay mode, for master files, you can enable the Custom Metadata
Management to allow an Asset Name to be updated in Interplay (MediaCentral |
Production Management) from an Open, Edit While Ingest Flip64, Lightspeed Live
Capture or Tape workflow. When you enable Custom Metadata Management, Vantage
can update User Metadata and create a head frame in the asset while the file is open
and growing, without requiring the use of the Notify action to generate the MOB ID in
primary videos. For proxy generation, you are still required to use the Notify action to
generate the MOB ID.
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» Flip64 Action—creates TIFO outputs, one for proxy and one for high-res.

~ QOutputs
-~ K mFro Output Location... Edit Filename... i 1080i proxy

% Video ) Track 1 v B ANC v
Video 1 Audio 1 v P ANC1 v

-~ K mro Output Location..  Edit Filename.. ™ DNxHD high res

™ Video ) Track 1 v B ANC v
Video 1 Audio 1 v g ANC1 v

» Media Creation Actions—parallel actions (for proxy and high-res) for delivering
assets to Avid systems.

Configuring the Notify action to generate Media Creation variables
1. Select MOB ID Generator Notifier.

2. Configure to generate Master MOB ID and Source MOB ID variables.

Configuring the Flip64 action x264 proxy TIFO output
1. Create a Flip64 action configured with a TIFO output container.

2. For the Video track, select x264 from the Video Codec menu and configure.

Note: Enter the x264 configuration settings detailed in the Flip64 Settings for Avid
Proxies document available from Telestream.

3. For the Audio track, select PCM or MPEG-1 Layer 2 audio. For PCM set the
appropriate Number of Channels, Sample Rate of 48,000 Hz, and Format to 16 or 24
bits. For MPEG-1 Layer 2 audio, set Channel Configuration to Mono, Bit Rate to 48
kbps, and a Sample Rate of 48,000 Hz.

Configuring the Flip64 action high-res MXF OP1a | TIFO output
1. Create a Flip64 action configured with a MXF OP1a | TIFO output container.

2. Select a supported format from the container’s Video Codec menu. See Media
Creation Action Codec Support.

3. Configure PCM audio, setting the appropriate Number of Channels, a Sample Rate of
48,000 Hz, Format to 16 or 24-bits and the Number of channels per track set to 1.

Configuring the Media Creation proxy action
1. Create a Media Creation action configured with a TIFO input container.

2. Set the Avid Picture Essence Coding Type to the appropriate proxy setting (800
kbps, 1.5 Mbps, or 2 Mbps). See Specifying the Avid Picture Essence Coding Type for
required values.
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Configuring the Media Creation high-res action
1. Create a Media Creation action configured with a TIFO or MXF OP1a input container
to process your input file properly.

2. Set the Avid Picture Essence Coding Type to Auto. If ingesting AVCl 50/100 or XAVCI
50/100, select the appropriate value. See Specifying the Avid Picture Essence Coding
Type for required values.

3. Bind the Master MOB ID and Source MOB ID variables, generated previously in the
Notify action, in the Asset Attributes panel.

4, For both Media Creation actions, select Import (Source Package Name) for the
Input Type in the Asset Attributes panel. See Using the Import Input Type.

5. Enter a value for the Source Package name. See Guidelines for Multi-Res Input Type
Name Management.

Note: Import (Source Package Name) value specified must be the identical for both
Media Creation actions.

Guidelines for Multi-Res Input Type Name Management

When working in a multi-res workflow, it is important to use Import (Source Package
Name) properly. In particular, you should keep these issues in mind:

1. Whenever you create a new Import (Source Package Name), Media Composer
generates a new source ID, even if the name you type exactly matches that of an
existing Import (Source Package Name). You cannot dynamically relink media that
does not share a source ID.

2. Do not use the same name for two different assets or different names for the same
asset. This will result in incorrect media association.

3. When using the Tape Name input type, do not use the Avid reserved tape name of
New Tape.

4. Input Type names are case-sensitive—for example, inputname1 and InputName1
are considered distinct—so maintain a consistent naming convention throughout
a project.

Note: Historically, using a tape name was common because most material was
digitized from tape. For example in Avid Media Composer, creating a ‘New tape’
creates a new tape Source MOB ID. With most sources now being file based, the
correct descriptor type to select is Import with specified Source Package Name.
Depending on the descriptor type selected, Avid Media Toolkit follows slightly
different rules for naming files and Master MOB IDs. It is not necessary to create a tape
name to be able to set the ‘tape name’ property in the resulting media asset. For
configuration details see Using the Import Input Type.

T
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Dynamic Relinking

Avid uses the Input descriptor information to check whether one of the two media are
proxies can be dynamically relinked or not. In the case of Dynamic Relinking using two
Media Creation actions (one high-res, the other a proxy) the Input descriptors must be
the same. This is best achieved by using a variable.

Note: Tape name data replaces the Asset Name set in the Vantage Filename Pattern
Editor when not empty.

Using the Import Input Type

WARNING: Avid strongly recommends using Import mode for file-based digital media
workflows.

Using Import mode doesn’t allow for the Tape Name field to be used for relinking. The
Tape name value specified in the Media Creation action is replaced by the Asset Name
set in the Vantage Filename Pattern Editor (when not empty).

Using the Tape Input Type

WARNING: Ingesting media generated as Tape input type may not perform as expected.

Tape mode may be used for traditional dynamic relinking but the Tape name value
specified in the Media Creation action will replace the Asset Name set in the Vantage
Filename Pattern Editor (when not empty). In order to use Tape mode and properly
configure the Asset Name and Tape name in Media Composer and Interplay Access,
perform these tasks:

» Enable Interplay Asset Metadata and check Add User Properties. Click Add New
Item and set Name to the reserved value of Display Name. Provide a value (for
example, Name of the File) or bind it to a variable which provides a value.

» Under Input Type, select Import and provide a source package name (for example,
RedHerring) or bind a variable which provides a value. Avid recommends using
Import.
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Requirements for Creating Proxies

Configuring the Resizing Filter in Flip64
For 720p 50/59.94 2 Mbs proxies, configure the resizing filter in Flip64 as shown:

~ [V Resizing Filter =

> General

- Cropping and Padding = Automatic ¥

When changing Aspect Ratio: Stretch =

Treat SD input as 169  —
Treat HD input as 149 -

Output Aspect Ratio: Output display aspect ratio is 16:9 v = —
~ Resizing Algorithm  Lanczos W
Detail Sensitivity: Avoid Visual Artifacts (smooth) v -

* Vertical Blanking

Cropping and Padding—Automatic
Output Aspect Ratio—Output display aspect ratio is 16:9
Detail Sensitivity—Avoid Visual Artifacts (smooth).

Specifying the Avid Picture Essence Coding Type

Avid Proxy Formats

In the Media Creation action under TIFO input, specify required Avid Picture Essence

Coding Type for creation of Avid proxy formats. See Flip64 Settings for Avid Proxies and
menu below for required settings.

B Container: TIFO
¥ General
= Avid Picture Essence Coding Type
. Set Avid Picture Essence Coding Type Auto WV

»Wﬁ
Avid Proxy 800Kbps Interlaced

Avid Proxy 800Kbps Progressive
Avid Proxy 1.5Mbps

Avid Proxy 2Mbps

AVCI 50

AVCI 100

XAVCI 50

XAVCI 100
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AVCI and XAVC Formats

In the Media Creation action under TIFO input, specify required Avid Picture Essence
Coding Type for creation of AVCl and XAVC formats.

B Container: TIFO
* General

= Avid Picture Essence Coding Type

. Set Avid Picture Essence Coding Type Auto WV

Rute T
Avid Proxy 800Kbps Interlaced
Avid Proxy 800Kbps Progressive
Avid Proxy 1.5Mbps
Avid Proxy 2Mbps
AVCI 50
AVCI 100
XAVCI 50

XAVCI 100

Note: When the input media does not have SMPTE RP2027 descriptors necessary for

distinguishing AVCI from XAVCI formats, this configuration can be used to identify
them correctly.
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Exporting Sequences to
Live Play | Vantage via
Send to Playback

Telestream’s Send to Playback components integrate Telestream’s Live Play and
Vantage with Avid Transfer Engine and Media Composer.

Avid operators can use Media Composer’s Send to Playback command to re-wrap Avid
OP-Atom files into MXF or TIFO and export them to Live Play and register themin a
playlist for playback. Operators can also use the Send To Playback command to export
sequences directly to a Vantage watch folder for ingest by the associated workflow for
processing.

Topics
m Overview
m Installation, Configuration, and Verification
m Sending Media to a Vantage Workflow or Live Play
m Troubleshooting
m Telestream Intermediary Format (TIFO)
m Managing Send to Playback Logging
m Supported Avid Media Formats
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Overview

Telestream’s Playback Service enables operators using Avid Media Composer with Avid
Interplay Transfer Engine to use the Send to Playback command to send sequences
directly to Vantage and Live Play. When a Media Composer operator performs the Send
to Playback operation on a sequence, Avid Interplay Transfer Engine delivers the
sequence to the Telestream Playback Service, which encodes and delivers the media to
a target location and registers the clip in a Live Play playlist for playout, or delivers the
media to a target location for processing by a Vantage workflow.

4
A

Avid
Media Composer

5 NG DR,

SDI Playlists

Sequences

Avid
Transfer Engine

— —
Sequences MXEF | TIFO Files
— —[

Media Files

You can install the Telestream Playback Service in any supported Avid configuration
(see Installing the Telestream Playback Service) on as many Avid Interplay Transfer Engine
instances as required. You can also create multiple playback devices to identify Live
Play systems and Vantage workflows to suit your media processing requirements.

Product Requirements

A Telestream Send to Playback-enabled system requires these Telestream and Avid
products up and running:

» Vantage 8.0 or later

* Live Play version 2.0 or later

» Telestream Playback Service version 2.0 or later
» Avid Media Composer 23.12.0 or later

 Avid Transfer Engine Client 23.12.0 or later

 Avid Interplay Transfer Engine 2023.7 or later, installed on the same server as
Telestream Playback Service

 Avid Interplay Transfer Client 2023.7 or later—You must install the Avid Interplay
Transfer Engine client program on each edit system that plans on transferring Avid
assets to a playback device.
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The Telestream Playback Service may be hosted in these Avid configurations:

Standalone Avid Transfer Engine

In this configuration, the Avid Transfer Engine is installed on a standalone server.

J. Avid Editing Station |
= m Avid Media Composer
= —
- m Avid Transfer Client
Avid Nexis 5
Shared Storage

m Avid Media Production Transfer Engine

Avid Transfer Engine on Editing Station—Nexis Shared
Storage

In this configuration, the Avid Transfer Engine is installed on an Avid editing station.
Each editing workstation must host both the Avid Transfer Engine and Avid Transfer

Client.

J. Avid Editing Station
= -— m Avid Media Composer
L1 |
-——— m Avid Transfer Client

Avid Nexis m Media Production Transfer Engine
Shared Storage A

Avid Transfer Engine on Editing Station—Local Storage

In this configuration, Avid Transfer Engine is installed on an Avid editing station with
local storage.

Avid Client Workstation

Local Storage m Media Composer
B Avid Transfer Client

a__“ m Media Producton Transfer Engine
(]

T
Avid Integration Guide telestream



96 | Exporting Sequences to Live Play | Vantage via Send to Playback

Installation, Configuration, and Verification

Installation, Configuration, and Verification

Before you can submit media to Live Play or Vantage, perform these one-time
installation and configuration tasks. Before starting, ensure that your Avid edit system
(Avid Media Composer and Avid Interplay Transfer Engine) is operational. Next, you'll
install the Telestream Send to Playback programs, create a Vantage workflow and/or
create a Live Play playlist, depending on your workflow requirements, and then
configure the Telestream Playback Service, Transfer Engine, and Avid Media Composer
to integrate them.

Note: When you are installing software or modifying Avid programs or systems,
always confer and coordinate with your Avid systems administrator or manager to
make these changes, including restarting any services. Always refer to Avid
documentation if you have questions about the use of their products.

Installation and Configuration Tasks

1. Uninstalling an Older Telestream Playback Service—Uninstalling an older version in
preparation for upgrading the Send to Playback feature.

2. Installing the Telestream Playback Service—Installing the Telestream Playback
Service components on the Avid Interplay Transfer Engine server.

3. Creating a Workflow in Vantage—Optionally, creating a Vantage workflow that
monitors the storage location where Telestream Playback Service writes the
encoded file out each time a sequence is received.

4. Creating a Playlist in Live Play—Optionally, creating a playlist in Live Play that is
updated by Telestream Playback Service when it writes the encoded file out each
time a sequence is received.

5. Configuring the Telestream Playback Service—Creating a playback device entry in
the Telestream Playback Service.

6. Configuring Avid Interplay Transfer Engine with Playback Devices—Creating a
matching playback device entry in the Avid Interplay Transfer Engine to integrate
with the Telestream Playback Service.

7. Configuring Avid Media Composer to Integrate with Vantage | Live Play—Configuring
Media Composer to be able to send sequences to the Telestream Playback Service
via Avid Interplay Transfer Engine.

Testing Media Composer-Vantage | Media Composer-Live Play Integration

1. Sending Media to a Vantage Workflow or Live Play—Test sending a sequence from
Media Composer to a Vantage workflow for processing or sending a sequence from
Media Composer to Live Play and updating the playlist.
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Uninstalling an Older Telestream Playback Service

You should always install the Telestream Playback Service on a server that hosts the
Avid Interplay Transfer Engine. To determine if an older version of Telestream Playback
Service is installed, open the Add/Remove Programs | Programs and Features control
panel, locate the Telestream Playback Service and note the version.
To uninstall older versions of Telestream Playback Service, follow these steps:

1. Close all programs.

2. Run PlaybackServicelnstaller_TE_x.x_Vxx.x.msi, click Remove, then click Finish

OR

Display the Add/Remove Programs | Apps and Features control panel (depending
on your Windows system), locate the Telestream Playback Service, select it, and
click Yes | Uninstall to remove the program.

3. Restart the Transfer Engine host computer.

T
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Installing the Telestream Playback Service

You should install the Telestream Playback Service on each computer running the Avid
Interplay Transfer Engine, which is used to transfer media to Vantage | Live Play via the
Telestream Playback Service.

Note: If you install the Telestream Playback Service on a computer with a desktop
(non-server) Windows OS, in the Turn Windows Features On or Off window, enable
.Net.

The installer installs the following components:
 Telestream Playback Service

o Telestream Playback Service Manager, a utility with a desktop shortcut—Playback
Service_IF.

Note: If your system has an older version of the Telestream Playback Service installed,
remove it (see Uninstalling an Older Telestream Playback Service) before installing the
current version.

Obtain the Telestream Playback Service installer—follow these steps:

1. Go to the Telestream Web site Vantage Downloads page and log in with your
credentials.

2. Scroll down to view the tabbed panels—click on the Additional Components tab.
3. Click on the Telestream Playback Service’s Download Now link and download the
installer ZIP file.
Install the Telestream Playback Service—follow these steps:

1. Copy the installer to the computer where the Avid Interplay Transfer Engine is
installed.

2. Run the Telestream Playback Service installer—
Telestream_PlaybackService_2.0.<<9999.999>>.msi. (On Windows desktop
operating systems, you may have to run it as Administrator—if Windows displays
the error “Please open Playback Service Manager in admin mode’, your user does
not have permissions to run the program. Right-click and run the program as
Administrator.

3. If an Open File security warning displays, click Run to continue.
4, The installer displays the Welcome panel—click Next.
5. The Telestream Playback Service requires Microsoft .NET 3.5 or later.

If the installer detects that .NET isn’t installed, close the installer and install it now:
Open the Start menu and search for the Add Roles and Features Wizard. Open the
wizard and navigate to Features. Select .NET Framework Features and click Install
and then restart the installer.

6. If the installer detects that the proper version of Transfer Engine isn't installed,
install it now and restart the installer.
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7. License Agreement panel—Select | Agree (if you do), and click Next.

8. Select Installation Folder—Accept the default folder (C: \Program
Files\Telestream\Telestream PlaybackService 2.0\) orselectanother
folder, and click Next.

9. Confirm Installation—Click Next to start installation.
10. Installing Telestream Playback Service—Wait for installation to complete.
11. Installation Complete—Click Close to exit the installer.
12. Restart the computer.

T
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Creating a Workflow in Vantage

If you plan to send a sequence from Media Composer to process media in Vantage
workflows for direct-convert operations, transcoding, or other media processing, you
must first design, configure, and activate the workflow(s) in Vantage Workflow
Designer.

Note: If you are not familiar with Vantage Workflow Designer, please start the
program and open the Workflow Designer User Guide for assistance in creating and
configuring a workflow.

You should design and configure your workflows to process the media ingested from
Media Composer to suit your media processing requirements.

These workflows can optionally deliver the media that has been processed back to an
Avid client as a new master clip via Avid Interplay Transfer Engine, creating a round-trip
workflow.

Avid Media Composer identifies Vantage workflows as playback devices; for each one
that you require, you should create one or more Vantage workflows to monitor the
folder specified in the Playback device. The common directory is the only connection
between Media Composer and the Vantage workflow.

Here is a simple, prototype workflow:

The only requirement for a workflow is that it starts with a Watch action, so that the
workflow starts a job for each new file placed in the watch folder—the folder being
monitored by the Watch action. When you activate the workflow, for each new file
delivered—it starts a job to process that media file.

Configure the playback device entry in the Telestream Playback Service Manager
(Configuring the Telestream Playback Service) to match the Watch folder path specified in
the Watch action.

When you activate the workflow, for each new file delivered—it starts a job to process
the media. Workflows must be activated in Vantage during the time an operator plans
to use the Send to Playback command to deliver sequences to this workflow.
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Creating a Playlist in Live Play

If you plan to send a sequence from Media Composer to play out media in Live Play, you
must first create and configure a playlist.

To create a playlist in Live Play, open the Live Play web app. Create an Open Media Pool.
In the Playlists panel, click the Create New Playlist button at far right in the title bar. For
help with creating playlists, see the Creating and Managing Playlists topic in the Live
Play User Guide.

Note: If you aren’t familiar with Live Play, please start the program and open the Live
Play User Guide for assistance in creating and configuring a playlist.

Name the playlist, and configure the playlist as required for your playback
requirements. Note the name; this is used is the Playback Service Manager’s Playlist
Name in the Config Playlist dialog (see Configuring the Playlist Name and Logging
Details).
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Configuring the Telestream Playback Service

You use the Telestream Playback Service Manager to create Playback Service entries—
providing one entry for each playback device you plan to use in Avid Media Composer.
Each device entry identifies a specific Vantage watch folder or Live Play playlist.

A playback device, in the context of Avid, refers to a dedicated hardware device or
server, or an external system—such as Telestream Vantage and Telestream Live Play—
that receives a video sequence from Avid Media Composer for play back or other
processing, essentially acting as the output point for your edited content.

You should create one Playback Service entry for each Live Play system you've
implemented, and one device entry for your Vantage domain to enable Avid Transfer
Engine to transfer files to these systems. You'll typically set up at least one entry initially,
then add or modify entries as your workflow requirements increase or change.

For each Playback Service entry you add, you should create at least one corresponding
playback device entry in the Avid Transfer Engine Configuration Manager. The
Telestream Playback Service Manager publishes these device entries for use by the
Telestream Playback Service when transferring files to them.

Note: Each time you add, delete, or modify entries, you must restart the Telestream
Playback Service in order to obtain the current set of device entries. (See Starting the
Telestream Playback Service). Also, always restart the Avid Interplay Transfer Engine
after making changes to the Avid Interplay Transfer Manager configuration or the
Telestream Playback Service configuration.

To start the Playback Service Manager, choose one:
» Double-click the PlaybackService_IF shortcut on the desktop

On desktop operating systems, you may have to navigate to c: \ Program
Files\Telestream\Telestream PlaybackService (default) to start Play-
backService_IF.exe. The service can be run by the actual administrator or by
another user with admin rights.

The Playback Service Manager starts and displays this window:

Telestream, LLC PlaybackService Manager
Telestreamn Transfer Engine Playback Service
PORT# | File Storage Location VideolD | MamelD | MOB D |
< >
Restart TS_PlaybackService | EDIT | ADD ‘ DELETE ‘

I Enable Debug Logging |C\Windows\SystemS2\confiq\system
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Adding | Editing Playback Service Entries
Click ADD or select an entry from the list, and click EDIT to display this dialog:

Port
Cutput Format W -
& VideolD In MName | " MamelD In MName |  MOEBID In Mame |

File Destination

BROWWSE
™ PlaylList Config

LivePlay Location
PlaylList Name Cancel

Configure these settings:

Port. The port number of the Transfer Engine to be used for this destination path.
Suggested ports: 8001-65535. This port must not be used by other program on this
server, and the port number must match the port entered in the Playback Device entry
in the Avid Transfer Engine Configuration Manager (Adding | Editing Playback Service
Entries).

Note: While you're unlikely to select a port already in use and create a conflict, you
can open a command window (Start > Run, enter cmd and press OK) and run netstat
-a to obtain a list of ports in use on this computer.

Output Format. Specifies the file format (MXF | TIFO) that the Playback Service should
save the encoded sequence as.

Select one or more of these optional Name choices (at least one must be selected) to
use these values when composing the file name for all files sent to this destination:

VideolD in Name. Unique material identifier specified in TapelD or VideolD attributes
in the Interplay environment.

NamelD in Name. Display name of the associated sequence in the Interplay
environment.

MobID in Name.The internal system identifier used by Interplay to track the video
sequence.

File Destination. Click Browse to navigate and select a server and folder or manually
enter a fully-qualified UNC path where the files are to be stored for ingest by the target
Vantage workflow or Live Play playlist. The path may be a local path—although it is
unlikely that all systems (Avid and Vantage | Live Play) are running on the same
computer—or a network server path. It should be a share with full read/write
privileges, so that Vantage can access the media. The folder must be configured as an
Open Media Pool in Live Play.
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For a Vantage workflow destination, this path must be the same path configured in the
Watch action of your target workflow. For a Live Play destination, it may be any location;
the destination is automatically added to the playlist. The location may or may not be
identified as a media pool.

When you’re done, click OK to save the entry and close the dialog.

Configuring the Playlist Name and Logging Details

When you're creating/editing a device entry for Live Play, select the entry and configure
the Live Play server and target playlist:
Playlist Config. Check to identify the Live Play server and target playlist:

LivePlay Location. Specify the IP address | DNS name of the Live Play server; this
server must be configured to be an Open Media Pool in Live Play.

Playlist Name. Specify the name of the target playlist, as defined by the name of
the playlist you created in Live Play.

When you're done, click OK to update the information and close the dialog.

Click Exit to close the Telestream Playback Service Manager.

Back on the main window, to enable debug logging, configure these controls:

Enable Debug Logging. Check to enable logging, and browse or manually specify the
fully-qualified path to the logging folder.

Starting the Telestream Playback Service

After adding/updating playback device entries in the Playback Service Manager, you
must restart the Telestream Playback Service to pick up the current set of entries for use
by the Avid Interplay Transfer Engine.

To restart the Telestream Playback Service, choose one of these options:

¢ In the Telestream Playback Service Manager, click the Restart Playback Service but-
ton. Wait for the Playback Service Restarted Successfully notification, dismiss the
dialog and exit the program

OR

* In Windows, on a server-based OS, open the Windows Services (Control Panel >
Administrative Tools > Services) panel, locate the Telestream Playback Service and
click Restart. On a desktop (non-server) OS, right-click Windows Start > Computer
Management > Services and Applications > Services > Telestream Playback Service.

Note: If you attempt to exit the Telestream Playback Service Manager after making
changes to playback device entries, the program displays a restart dialog to remind
you. Click Yes to confirm that you want to restart the service.

When you're done, click Exit to quit the Playback Service Manager and proceed.
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Configuring Avid Interplay Transfer Engine with Playback
Devices
Avid Interplay Transfer Engine should be configured using the Interplay Transfer
Configuration program to integrate with the Telestream Playback Service and mirror
the device playback entries in the Telestream Playback Service you've created.
To configure Transfer Engine settings, start the Avid Transfer Engine Configuration
program from the desktop shortcut icon or at C:\Program Files\Avid\Avid Interplay
Transfer Engine\
TRANSFERMGRSERVERCONFIG\tmconfig.exe.
When it starts, it displays this window:
% Avid Interplay Transfer Engine Configuration EI = @
‘Workgroup Setiings ‘Workgroups Ingest
W Interplay enabled W ‘Workgroup transfers enabled M Ingesttransfers enabled
Interplay Engine hostname: W Incoming workgroup transfers enabled Max. simultaneous ingesttransfers: ,—4
‘Interplade Mazx. incoming transfers =8 Ingest devices:
User name: |avid Max. outgoing transfers: ,—4 TEServeri
Foerert | Directory for temparary compaosition files: ﬂ
v Acceplincur_mng workgroup transfers without F.'.Pr\:gmmDEﬂa-A\did'.TemD %
Interplay login = Delete temporary composifion Browse... Edit...
Mo-login workspaceforincoming fransfers: files after transfer
Mnrkspacﬂ ‘Workgroup names:
Dynamically Extensible Transfers (DET)
_sad. | ¥ DET enabled
Delete Max. DET push transfers: [
Edit. Max. DET pull transfers: ,710
Total Transfers (All Types)
Playback Max.s\mu\taneoustransfers,—32 Calculate
W Playback transfers enabled
System Seftings Playlist Informationr
¥ Enable auto-cleanup oftransfer queues ) ’— ™ UseNewsroom rundowns to schedule transfers
Auto-cleanup transfers older than 360 minutes :::;.b:;u:::lioe::splaybacktransfers. ‘
Run auto-cleanup every 12 minutes TIFIO{TEServer!: 17002/ Jax} S
Logging Storage
Delete
™ Serverlogging off 515 3x -
(¥ Standard logging on Buffer size: M
® DT 168IH Purge \Worker Log Files Older Than
[ Day
Configure FTP Servers OK Gancel
Playback panel
Configure this setting in the Total Transfers (All Types) panel (right center):
Max. Simultaneous Playback Transfers. Suggested value: 4. This is an arbitrary
number to limit server load—it should be adjusted as required—and typically matches
the same control in Playback (following).
Configure these settings in the Playback panel (center bottom):
Playback Transfers Enabled. Check this option to enable playback transfers.
Max. Simultaneous Playback Transfers. Suggested value: 4. This is an arbitrary
number to limit server load; it may be adjusted as required.
Configure other settings as required.
o~
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Adding Transfer Engine Playback Devices

For each destination you intend to use in your Avid-Telestream media processing
workflows, you must add a playback device for use by Avid Interplay Transfer Engine,
configured with the destination folder being monitored for ingest by each Vantage
workflow or Live Play playlist. Each playback device must have a unique name and use a
dedicated port number.

Note: Set up at least one playback device initially, then add or modify devices as your
workflow requirements change. For each playback device you have, you need to
create a corresponding playback device entry in the Telestream Playback Service
Manager. Always restart the Telestream Playback Service after making changes.

In the Playback panel (bottom center), click Add (or select a playback device and click
Edit) to display this dialog:

Playback Device *

Profile Name | Slildarlie=

Device Name ‘Il-remole-2-1

Service Host ‘gear-test-E

Service Port 3675

Taped |1

Add i

Catalog
I™ Enable Playhack Catalog Name
¥ Allow Ancilary Data Tracks
¥ write to Temporary File

[~ Create Clip ¥ML

Device String:  LivePlayTest{gear-test-2:067 9 -remote-2-1 ¢

Update these settings:

Profile Name. A descriptive phrase that identifies this playback device. For example,
the destination folder and workflow or playlist name. It cannot contain spaces. The
name displays in the Playback panel’s Playback devices list (<Profile Name>{<ingest
service computer:port/<device name>}.

Device Name. The descriptive name of the device, which should be indicative of the
workflow in which it is utilized. It cannot contain spaces. The Device Name displays in
Avid Media Composer under Transfer > Send To Playback.

Service Host. The name of the computer that hosts the Transfer Engine and Telestream
Playback Service.

Service Port. The port number Transfer Engine uses to transfer the sequence to
Telestream Playback Service for this destination. Suggested ports: 8001-65535. The
port number must match the port entered in the Playback Device entry in the
Telestream Playback Service Manager (Adding | Editing Playback Service Entries).
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Optionally, you can add a descriptive name at the end of the server:port identifier,
separated by a slash (/). For example: AMC7-2:17000/Jax_Test.

Tape ID. Each sequence that you send to Transfer Manager must have the Tape ID set
either here or in Media Composer. It must not contain spaces. The data that is placed in
this ID is irrelevant and is not used, but Transfer Manager will not transfer sequences
without it.

Catalog. Check these options as appropriate for your requirements

Click OK to save the playback device and close the dialog.

Note: When adding a device, be sure to add the corresponding playback device entry
in the Telestream Playback Service Manager (see Adding | Editing Playback Service
Entries).

Each time you make changes to your playback device list, be sure to re-start the Avid
Interplay Transfer Engine to obtain and publish the new list of Avid playback devices.
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Configuring Avid Media Composer to Integrate with
Vantage | Live Play

Note: Be sure to coordinate with your Avid systems administrator to make these
changes or restart any computers.

To set up Media Composer to use the Telestream Playback Service, follow these steps:
1. Start Media Composer and select File > Settings > Transfer:
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2. Double-click the Transfer setting to display the Transfer > Settings tab:

Transfer Settings - Current

3. In the Settings tab, settings may be configured per your requirements.
4. Display the TMClient.ini tab:

Transfer Settings - Current

5. Make sure that the settings are appropriate for your environment—in the Server
field, enter the name of the Avid Transfer Engine server.

6. Click OK when finished.

Note: For complete details on configuring Avid Media Composer, see their guides.
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Sending Media to a Vantage Workflow or Live Play

This topic describes the typical method of using Media Composer to send sequences to
the Telestream Playback Service for processing by a Vantage workflow or to Live Play
for playback:

1. Make sure that the Telestream Playback Service is running. To start the Telestream
Playback Service, choose one of these options:

 InTelestream Playback Service Manager, click Restart Telestream Playback Service
OR
» Open the Windows Services panel and restart the Telestream Playback Service.

2. Make sure that the Avid Interplay Transfer Engine is running.

3. In Media Composer, select Transfer > Connect | Reconnect to Server and open the
Bin directory.

4. Select a sequence from a bin directory.

Awid |

cols Windows Script Avid Link  Tran

ntitfed r ; ; E

IN-OUT Mark IN Mark OUT Trac

5:04:04 01:00:00:00 01:05:04:04
5:04:04 01:00:00:00 01:05:04:04

5:04:14 (C)

5. Select Transfer > Send To Playback > <<Playback Device>>.
Media Composer displays the Send To Playback window:

Send to Playback
Playback Device: STPTEST

Itermn Tape ID PWT Ov

Billy 001
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6. Provide the sequence with a tape ID (no spaces allowed) if required. The Avid
Interplay Transfer Engine won't transfer the sequence without it. Optionally, enable
PWT to play the media during transfer, as well as Overwrite.

The sequence is sent to the Avid Interplay Transfer Engine, which sends it to the
selected playback device. (If you attempt to send a sequence with the same tape ID as
one already in the Transfer Engine an error displays. To overwrite the tape ID name,
select the Overwrite option.)

The Avid Interplay Transfer Engine connects with the Telestream Playback Service to
encode the media as a TIFO | MXF file in the destination path specified by the playback
device you selected.

Note: If there are effects in the timeline that have not been rendered, Media
Composer renders the sequence automatically before the transfer starts.

The Vantage workflow ingests the file and transcodes it as specified.

Or, Live Play plays out the newly-added media in the cliplist.

T
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Troubleshooting

If you are having problems successfully transferring a sequence to a Vantage workflow,
follow these steps and tips:

Confirm that the target Transfer Engine is running.

Confirm that the Telestream Playback Service is running. Restart the Telestream
Playback Service via the Windows control panel.

Verify that the playback device entries in both systems are using the same (and
unique) port number.

Be sure to restart the Telestream Playback Service after adding or modifying a play-
back device entry in the Avid Interplay Transfer Engine Configuration program.

Be sure to enter a tape ID in your sequences.

Confirm that Media Composer is connected to the server
(Transfer > Connect to Server).

Confirm that the destination path in your playback devices is a share.
Confirm that the share has full rights for all Windows users.
Confirm that you are not referencing a local drive letter directory instead of a share.

In the TMClient.ini tab, make sure that the settings are appropriate for your network
environment.

In Vantage:
- Confirm that your Vantage workflow is active in Workflow Designer.
- Confirm that your workflow’s Watch action is monitoring the correct share.

Note: If you are still having problems, contact Telestream Customer Service for
assistance.

VT
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Consider restarting the Telestream Playback Service in case of issues during trans-
fer.

Check log files generated by Avid for transfer. Its available under C:\Program-
Data\Avid\Temp\TMServerLog and C:\ProgramData\Avid\Temp\Trans-
ferEngine\TmWorkerLogs.

When Enable Debug Logging is checked in the Playback service, the logs are gener-
ated in PlaybackService_<DATE>.log files, written to the location specified in the
Enable Debug Logging field.
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Telestream Intermediary Format (TIFO)

Telestream Intermediary Format (TIFO) is a proprietary, intermediate media wrapper
format designed by Telestream as a lightweight, uniform, interchangeable file format to
ensure interoperability among Telestream’s media processing products.

TIFO provides a low-overhead wrapper that is essence-agnostic, with metadata,
timecode, and closed caption support. TIFO improves the ability to move media files
between Telestream products with all media essence elements & metadata intact,
preserving the widest range of transcoding options.

TIFO files are a Telestream proprietary format and aren’t playable or readable by non-
Telestream applications. You should only use TIFO format if your workflow requires
transcoding by Telestream workflow automation applications. The maximum temporal
length of a TIFO file is 12 hours.

Workflow Considerations

TIFO or MXF Op1A format can be used for open workflows or open file playback.
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Managing Send to Playback Logging

Logging can be enabled and viewed for both Transfer Engine and for the Telestream
Playback Service.

Transfer Engine Logging

Avid Transfer Manager generates log files that may be of value during troubleshooting.

The log files are located at:
e C\ProgramData\Avid\Temp\TMServerLog
o C:\ProgramData\Avid\Temp\TransferEngine\TmWorkerLogs.

For more information about Avid logging, see appropriate Avid guides.

Telestream Playback Service Logging

When you check Enable Debug Logging in the Telestream Playback Service Manager,
the service also generates log files named PlaybackService_<DATE>.log, writing them at
the location specified in the Enable Debug Logging field.
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Supported Avid Media Formats

Send to Playback supports the following formats:

e DNxHD
« DVCPRO
e IMX

e AVCintra
* XAVC

+ XDCAM

Supported Avid Media Formats

These media formats can be processed by Vantage via the Telestream Playback Service.

Support for ancillary data tracks includes:

» 608/708 captions
» XDS

- Program Name

- V-Chip/Content Advisory Information

- Ratings

¢ Active Format Description

Media Formats

HD Formats
m 720P Media Formats

m 7080i Media Formats
m 1080p Media Formats

720P Media Formats

Format Rate (fps) Frame Size
DNxHD 60 MXF 23.976 1280x720
DNxHD 90 MXF 23.976 1280x720
DNxHD 90 X MXF 23.976 1280x720
AVCIntra 100 23.976 1280x720
AVCintra 50 23.976 960x720
DNxHD 60 MXF 25 1280x720
DNxHD 90 MXF 25 1280x720
DNxHD 90 X MXF 25 1280x720

Avid Integration Guide
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Format Rate (fps) Frame Size
DVCPRO HD MXF 25 1280x720
AVClintra 100 25 1280x720
DVCPRO HD MXF 25 960x720
AVClntra 50 25 960x720
DNxHD 75 MXF 29.97 1280x720
DNxHD 110 MXF 29.97 1280x720
DNxHD 110 X MXF 29.97 1280x720
DVCPRO HD MXF 29.97 1280x720
AVCIntra 100 29.97 1280x720
DNxHD 120 MXF 50 1280x720
DNxHD 185MXF 50 1280x720
DNxHD 185 X MXF 50 1280x720
DVCPRO HD MXF 50 1280x720
AVC-Intra 100 50 1280x720
DVCPRO HD MXF 50 960x720
AVClntra 50 50 960x720
DNxHD 145 MXF 59.94 1280x720
DNxHD 220 MXF 59.94 1280x720
DNxHD 220 X MXF 59.94 1280x720
DVCPRO HD MXF 59.94 1280x720
AVCIntra 100 59.94 1280x720
DVCPRO HD MXF 59.94 960x720
AVCntra 50 59.94 960x720

VT
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1080i Media Formats

Format Rate (fps) Frame Size
DNxHD 120 MXF 50 1920x1080
DNxHD 185MXF 50 1920x1080
DNxHD 185 X MXF 50 1920x1080
DVCPRO HD MXF 50 1920x1080
AVClintra 100 50 1920x1080
DNxHD TR 120 MXF 50 1440x1080
DVCPRO HD MXF 50 1440x1080
AVClIntra 50 50 1440x1080
DNxHD 145 MXF 59.94 1920x1080
DNxHD 220 MXF 59.94 1920x1080
DNxHD 220 X MXF 59.94 1920x1080
DVCPRO HD MXF 59.94 1920x1080
AVClintra 100 59.94 1920x1080
DVCPRO HD MXF 59.94 1280x1080
AVCIntra 50 59.94 1440x1080
DNxHD TR 145 MXF 59.94 1440x1080

1080p Media Formats

Format Rate (fps) Frame Size
DNxHD 36 MXF 23.976 1920x1080
DNxHD 115 MXF 23.976 1920x1080
DNxHD 175 MXF 23.976 1920x1080
DNxHD 175 X MXF 23.976 1920x1080
AVCIntra 100 23.976 1920x1080
AVClIntra 50 23.976 1440x1080
DNxHD 36 MXF 24 1920x1080
DNxHD 115 MXF 24 1920x1080
DNxHD 175 MXF 24 1920x1080
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1080p Media Formats

Format Rate (fps) Frame Size
DNxHD 175 X MXF 24 1920x1080
DNxHD 36 MXF 25 1920x1080
DNxHD 120 MXF 25 1920x1080
DNxHD 185 MXF 25 1920x1080
DNxHD 185 X MXF 25 1920x1080
AVClIntra 100 25 1920x1080
DNxHD 45 MXF 29.97 1920x1080
DNxHD 145 MXF 29.97 1920x1080
DNxHD 220 MXF 29.97 1920x1080
DNxHD 220 X MXF 29.97 1920x1080
AVCIntra 100 29.97 1920x1080
SD Formats

m 480i Formats
m 480p Formats
m 576i Formats

m 576p Formats

480i Formats

Format Rate (fps) Frame Size
DV25 411 MXF 30 720x480
DV50 MXF 30 720x480
MPEG 30 (IMX) MXF 30 720x480
MPEG 40 (IMX) MXF 30 720x480
MPEG 50 (IMX) MXF 30 720x480
480p Formats
Format Rate (fps) Frame Size
DV25P 411 MXF 23.976 720x480
DV50P MXF 23.976 720x480
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576i Formats

Format Rate (fps) Frame Size
DV25 420 MXF 25i 720x576
DV25 411 MXF 25i 720x576
DV50 MXF 25i 720x576
MPEG 30 (IMX) MXF 25i 720x576
MPEG 40 (IMX) MXF 25i 720x576
MPEG 50 (IMX) MXF 25i 720x576
576p Formats
Format Rate (fps) Frame Size
DV25P 420 MXF 25p 720x576
DV25P 411 MXF 25p 720x576
DV50P MXF 25p 720x576
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Starting Sequence
Processing Jobs from
Media Composer

The Send To Vantage feature is an optional suite of Vantage programs for Avid Media
Composer that enables Avid editors to send sequences directly from Media Composer
to an active Vantage workflow for processing.

Topics

T
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Overview
Overview
m Overview
m Installation, Configuration, and Verification
m Sending Sequences to a Vantage Workflow
m Template Files Information
m Troubleshooting
Send To Vantage in Media Composer interacts directly with Vantage to start a Vantage
workflow job and process the selected sequence. This diagram depicts the
components, data flow, and processes in both the Media Composer workstation and in
Vantage, where the job executes.
Media Composer Workstation
MXF 1 Media 3endTo
Interplay Composer antage
MIXF 2 Database
Clip Sequence RrRiecteet
MXF 3
Sequence Metadata
in AVID Format
AVID Nexis Nexis client
Storage
Vantage Node
Receive
SDK service
\
Converts Sequence data from
Avid format to Vantage Format Egﬁzz:’;:e
AAF to CML
project.aaf > nro|ecl.CMk‘
\
Nexis client Conform Network
Edit Service Storage
broject.cmu >
1- Reads Sequence data
2- Gets Clip segments from Nexis
3- Creates a Rendered Video
on desired storage
Send To Vantage is comprised of three programs which are all installed on a Media
Composer workstation:
/—'\
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» Send To Vantage Template Editor—Enables you to create templates, which are
used during job initiation to facilitate media and metadata transfer for processing.

» Send To Vantage Template Installer—Used to install templates that you have cre-
ated as output options in Media Composer.

» Vantage File Sender—The program that you use when they populate job details,
and submit and monitor jobs. This program is started automatically by Media Com-
poser when you choose Send To > Vantage.

You can install the Send To Vantage feature on as many Media Composer workstations
as required, to meet your media processing requirements.

Topics
m Prerequisites
m Media Composer/Vantage Workflow Limits
m Product and Version Requirements

Prerequisites

A Send To Vantage-enabled Media Composer workstation must meet these
prerequisites:

» The Send To Vantage programs must be installed on the workstation where Media
Composer is installed

» Media Composer and Vantage must have read/write access to a common, shared
storage location for access to media files and template files. When storage is Avid
Nexis, which is most common, both systems require Nexis clients installed.

Media Composer/Vantage Workflow Limits

The following limits apply when using Send To Vantage in Media Composer:

* You can only submit sequences—you can’t independently submit master clips,
sub-clips or grouped clips

* You can only submit media with simple transition cuts
* You can’t submit sequences with offline partially-offline clips
* You can’t submit sequences with third-party effects

» Workflows are limited to the same constraints as Post Producer Simple AAF work-
flows (See page 66 in the Post Producer Developer Guide, published on the
Telestream web site.

Product and Version Requirements

A Send To Vantage-enabled Media Composer and Vantage domain requires these
Telestream and Avid products up and running:

T
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Avid Media Composer...
» Avid Media Composer 7 or newer

» Avid Media Composer Client 7 or later, when Media Composer is on a dedicated
workstation.

» Send To Vantage V1.0 or newer

Vantage...
» Vantage 8.1 UP5 or later

» Post Producer ComponentPac—2023.1.0.188 or higher

Note: There are no licensing requirements for using the Send To Vantage feature.
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Installation, Configuration, and Verification

Before you can submit sequence processing jobs to Vantage, you should perform these
one-time installation and configuration tasks.

Before starting, you should ensure that Avid Media Composer is operational. Next,
you'll install the Send To Vantage programs on the Media Composer workstation, create
and configure at least one Vantage workflow, and create and install at least one
template, depending on your workflow requirements.

Note: When you are installing software or modifying Avid programs or systems,
always confer and coordinate with your Avid systems administrator or manager to
make these changes, including restarting any services. Always refer to Avid
documentation if you have questions about the use of Avid products.

Installation and Configuration Tasks

1. Uninstalling the Send To Vantage Programs—Uninstall an older version of Send To
Vantage programs if any, before installing a newer version.

2. Installing the Send To Vantage Programs—Install the Send To Vantage programs on
the Media Composer workstation.

3. Creating a Send To Vantage Workflow—Create a Vantage workflow that starts a new
job in Vantage each time a sequence is received and processes it.

4, Creating and Installing Send To Vantage Templates—Create and install templates in
Media Composer for each workflow you've created.
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Uninstalling the Send To Vantage Programs

Use this topic to uninstall the Send To Vantage programs on a Media Composer
workstation where the feature has been installed. You may be removing it permanently
from a Media Composer workstation or you may be removing it in preparation to install
a newer version.

Uninstall the Send To Vantage programs using the Windows Add or Remove Programs
in System Settings. The program can only be uninstalled by the user ID that installed it.

Installing the Send To Vantage Programs

Use this topic to install the Send To Vantage programs on each Media Composer
workstation. The installer installs the following programs:

» Send To Vantage Template Editor
» Send To Vantage Template Installer

» Vantage File Sender

Obtain the Send To Vantage installer

To obtain the Send To Vantage programs installer, contact your Telestream
representative (see Obtaining Support | Information | Assistance).

Install the Send To Vantage programs

1. Run the installer—SendToToolsWindowslnstaller.exe. The installer displays the
Welcome panel:

Bl Vantage Send To Tools Setup x

Welcome

telestrean

Welcome = .

|1 |

Next > Qunt
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3. Accept the default location or browse to the location where you want to install the
program and click Next. The Select Components panel displays:

S Vimtage Send To Teoh Setup

Select Componenis

*

Select Components —

PFiease select e components you want (o nsia telestreamn

Select - Rlequeed fof cre

£ Send To Terngiste Edtor
4 Send To Termplate installer
= Vantage File Sender

< Back Mext > Cancel

4, Select all components and click Next. The Start Menu Shortcuts panel displays:

[ inrnage Send Te Tosks Setup

St Menu shomouts

x

Start Menu shomcuts ¥
S P e R S L cexe s Celestrean

Startup
System Tools
Wirdaws Pl 5his

< Back Hend = Cancel L

5. Accept the default Windows Start menu shortcuts or change them if required.
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6. Click Next—the Ready to Install panel displays:

Ready to Inatall —

telestream

Ready to install

< Back iresi Cancel |

7. Click Install to begin installation.

If the error “.. You are not installing on a Media Composer..." displays, cancel the
installation and verify that the target workstation has Media Composer installed.

8. When installation is complete, click Finish to close the installer.

Creating a Send To Vantage Workflow

In order to send a sequence from Media Composer to process in a Vantage workflow,
you must first design, configure, and activate the workflow in Vantage Workflow
Designer.

Note: If you are not familiar with Vantage Workflow Designer, refer to the Workflow
Designer User Guide (directly in the program) for assistance in creating and
configuring a workflow. Detailed configuration help is also available for each action—
in the action’s inspector window, click on the M icon in the upper-right corner.

A workflow that you send media to using Send To Vantage feature must have a Receive
> Compose > Conform set of actions in it. The Compose action converts simple AAF
media descriptor files into Post Producer Composition Markup Language (CML), for
processing by Vantage using the Conform action.

The Conform action renders media descriptor compositions (as defined in the
Composition XML file which it is passed) with transition and image effects and graphic
overlays and conformed audio, applying option filters as appropriate, encoding the
output video in the specified format.

Workflows can optionally deliver the media that has been processed back to an Avid
client as a new master clip via Avid Interplay Transfer Engine, creating a round-trip
workflow.

Workflows must be activate in Vantage during the time an editor plans to use the Send
to Vantage feature to deliver sequences to this workflow. For each sequence sent to it
from Media Composer, the workflow starts a job to process it.
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Prototype Workflow Configuration

You should design and configure your workflows to process the media ingested from
Media Composer to suit your media processing requirements. You must have at least
one workflow to use the feature. Follow these steps to create this prototype:

1. Open Workflow Designer.

2. Create a new category for the File Send program to query, You'll use this category
later when configuring templates for use in Media Composer. In this example, the
category is named MediaComposer:

& MedirComposer

F nest Simpleavid
¥ WithVariables
F WithVanables-Decide

3. Now, create a new workflow in Vantage Workflow Designer—name it STV Test for
this prototype. The basic requirement is a workflow containing these three actions:
Receive > Compose >Conform:

Receive Conform

Conforms the items ina
Composition.

Receive job Creates a composition.

It may contain other actions to perform additional tasks, but these three are required.

1. Configure the Receive action—A workflow being triggered via the API (in this case,
the Vantage File Sender program) must start with a Receive origin action. Open its
inspector:

Receive: Receive job

Media Files: % Expected Nicknames 1)

Labels: B Expected Labels (0)

Attachments: |[|1 Expected Nicknames (0)

2. Specify Media Files > Expected Nicknames (1) and specify Original, to ingest a
single file from Media Composer.

3. Click Save to update the action and close the inspector.
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4. Now, open the Compose action’s inspector:
*Compose: Creates a composition.

S E Composer: Simple AAF
Input file nickname: % Original Y

— > General
Output file nickname: % CML < Edit Filename Pattern...

Closed captions and subtitles
* QOutput Location: Available Vantage Store

~ Composers +

B Simple AAF

5. Configure these controls:

Input File Nickname. Specify Original, the nickname assigned the input file in the
Receive action.

Output File Nickname. Specify CML, which is the type of file being generated by
the Compose action and forwarded to the Conform action for processing.

Output Location. Specify Available Vantage Store, the default working store for
temporary files during job execution.

Composers. Specify Simple AAF, the media descriptor dialect of the sequence being
ingested.

Configure all other controls as required.
6. Click Save to update the action and close the inspector.
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7. Finally, configure the Conform action—display its inspector:

*Conform: Conforms the items in a composition.

- Settings
Input file nickname: (™ CML Conform Settings

=[] Generate Composition Chronicle el @i T
Progressive Compositing
~ Transcoders
Allow imvalid durations

Limit the number of layers: Multi-Layer Mode ¥
4 2000 kbps
Video 1 Processor:  Lightspeed Accelerated 16-bit YCbCr 4:4:4:4 %

Retry on GPU Error:
-~ ) pnC
Advanced settings:
4 64 kbps

Audio 1 B Container: QuickTime

File Extension: mowv ) s
~ Output

V FastStart —
B QuickTime Qutput Location... Edit Filename... = Output W
Insert 608 Closed Caption Track -

i Video v A Track 1 ¥
Video 1 v Audio 1 v

Insert 708 Closed Caption Track
Insert a Timecode Track

V' Enable CLAP atom

8. Configure these controls:

Input File Nickname. Specify CML, the nickname assigned the output file in the
Compose action.

Transcoders. Add and configure a video and audio transcoder as required for your
output specifications.

Output. Select and configure the container format, including its output location,
file name, and nickname, as required for your output specifications.

Configure other controls as required.

9. Click Save to update the action and close the inspector.

Activating the Workflow

Workflows that are to be used to ingest your AAF files from Media Composer via Send
To Vantage must be active. In Workflow Designer, select the workflow to display it, and
at the bottom of the window, click the Activate button.
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Creating and Installing Send To Vantage Templates

Use these topics to create and install templates for each workflow you plan to use.

Identifying Your Vantage Domain

1. On your Media Composer workstation, start the Send To Vantage Template Editor
from the Windows Start menu. and display the Configure Vantage Connection tab:

I Send To Template Editor - o *

“mﬁm Configure Vantage connection

10.0.20.70

L T ———
slegory | MeduComposer

C.\Send ToLog2s'test log

SHNE AND CONNECT

Cannected to Vanage Damain

2. Configure these Vantage connection controls:

Vantage Domain Name. Enter the domain name or IP address of the target Van-
tage domain. In a Vantage array, specify the server hosting the Vantage SDK Ser-
vice.

Vantage Workflows Category. Specify the name of the workflow category you
created in Workflow Designer when creating your first workflow.

Storage User Account. Optional; user ID for the storage being utilized.
Storage Password. Optional; password associated with the user account.

Log Files Path. Optional; specifies the fully-qualified path to the folder where
logs should be written. Default location is the current user’s home directory
(C:\Users\ %USERNAME%\Documents\VantageSendTolLog.txt).

3. Click Save and Connect to test the connection to the domain you just specified.

The Send To Vantage Template Editor program successfully connects to Vantage
and displays the success message at the bottom of the window.

If the connection fails, update the configuration to correct the problem.
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Creating a Template

Send To Vantage templates are comprised of an STT file and an INIfile, stored in a folder
named by you. Each time a job is submitted, these files are utilized.

Note: For each new workflow you create, you must create and configure a template
for it to use.

1. Click the Edit Send To Templates tab:

CREATE SEND TO TEMPLATE ROIT SEND TO TRMPLATE

When you connect to a Vantage domain, the Send To Vantage Template Editor
fetches the list of workflows in the specified workflow category you created earlier
in Workflow Designer, and displays them in the Target Workflows list.

2. Select a workflow from the list and enter a template name in the Send to Template
name field, which identifies both the workflow in Media Composer, and the folder
which contains its template files. Consider using the same name as the workflow.
This is identified as the output location in Media Composer when you select Output
> Send to > Vantage.

3. In Windows Explorer, create (or identify) the parent template folder directory,
naming it as appropriate and making certain that both Media Composer and
Vantage have read/write access to it. This is the folder where the AAF hand-off takes
place: Media Composer writes the AAF to this folder and Vantage reads them for
ingest from here.

4, Back in Send To Vantage Template Editor, click Create Send to Template. The
program displays a File Save dialog so that you can navigate to and save the
template in the parent folder you just created or identified:
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Note: This directory must be accessible with read/write privileges to both Vantage
and Media Composer.

[ Chaocss Sendlc location Es
T Nebwot s vhnei o sbeeng o SendTolartage “ g o
Grgarice = Mot d ity L ]
Tsp
& Ok sceesi
B Dirskiog . :{“:‘{"“r‘ it
& Commlees ¥ Stasepon
i Doty o Srameniypos - Damo
= Prtore . Seatusiepo® faron
vl Meckaliie Fubrmmed LA
[ — b P
SataRipea: hareh
‘Wi ariables. Picks
B Thy PE
= Mecka (D)
i Metmerk

Sebect Foider Carcel

5. Navigate to the parent folder and click Select Folder to automatically create the
template folder and also write the STT and INI files to it.

Home Shate View
v » Network » va-neds » saleseng » SendToVantage
- x
N n
Edit Send To templates lame Date mo

o Quick access

JimVsDwight
Vantage workflows I Desktop » i
test_Simpleavid Send To template name : |StatusReport-Testing ~—ea.___ ‘ Damients " StatusReport
WithVariables %] Documents ’ StatusReport-Demo
WithVariables-Decide o StatusReport-Jaron
[ User inputs metadata
Name that will populate SendTovantage SubmittedRAFS
Media Composer Menu SttBepo-lwon, [ WERStles ke
WiithVariables-Picke
Vantage [ This PC
g ‘ New folder created
workflow

= Media (D) that contains

configurations for
this SendTo tempate

F Network

CREATE SEND TO TEMPLATE EDIT SEND TO TEMPLATE

6. Close the Send To Vantage Template Editor when you are done creating templates.
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Installing Templates
1. Start the Send To Vantage Template Installer program. It displays an Open File

dialog:
L% Choose SendTo templates location X
i > Network > va-nexis > saleseng > SendToVantage » v O Search SendToVantage p]
Organize v New folder ==t (7]
A
" Name Date modified Type Size
# Quick access
File folder
[ Desktop P
File folder
& Downloads # File folder
%] Documents o File folder
& | Pictures o File folder
Avid MediaFiles -Testing File folder
SendToVantage File folder

ithVariables-Picher

File folder

StatusReport-Jar
WithVariables-Pi

Do not select the folder with your template name
B3 This PC

v

Folder: | l ]

| Select Folder | Cancel

2. Click Choose Folder and browse to the parent folder that you used to store the
template when creating it—not the template folder itself—and click Select Folder.

For example, you created a template for the workflow STV Test Workflow, naming it

the same name and saved it in \\va-nexis\MediaComposer\SendToVantage. This is
the folder to select.

Send To Vantage Template Installer displays the list of template folders in the par-
ent folder.

. Send To Template Installer

STV

Choose folder containing SendTo template folders [elzlele}]=Szo]RB]= 33

Install selected templates on this machine INSTALL TEMPLATES

[ 1.07 80 MMIR CAto PAM (NEWS, MAGS, DC)
[ Decision Based On Labels

[J Demo

[ FlipTest

[ FlipVariables

O GetProjectFormat

[ JimVsDwight

[ labels

[ NV_Testd

[ Receive and Conform

Select the templates to install and click Install Templates. When you install a tem-
plate, Vantage Template Installer copies the STT file from the template folder into
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the Media Composer directory C:\Users\Public\Documents\Avid Media Com-
poser\Avid Templates\Send To Templates\Vantage.

The program displays a confirmation when the template is installed:

ﬂ Success o

o 1 template file(s) copied successfully

oK

3. Now, close and re-open Media Composer so that it identifies all of the installed
templates and makes them available for use.

VST
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Sending Sequences to a Vantage Workflow

To send a sequence to Vantage, follow these steps:
1. In Media Composer navigate to one of your bins:

*vid Media Composer Ultimate - JaronGreenscreen

T
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2. Right-click a sequence in the bin and select Output > Send To > Vantage > [your
template name]. Alternatively, select File > Output > Send To > Vantage > [your
template name].

Media Composer displays the Export Options window:

Send To: ReceiveAndConform

NRNRNCEMENTILLI DAY 4-SEMENTILLI_TRIAL_DAY 4_AM2_013025 The name of the AAF being sent to Vantage

These settings should be checked (enabled):

» Filename—the name of the AAF file being sent to Vantage. Media Composer saves
the AAF file to the selected server and path that is being monitored by the Vantage
workflow.

Media Composer may display a warning about overwriting files referencing the
AAF files created in your destination folder:

Avid Media Composer

Click Overwrite to overwrite the existing AAF file in this location.
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» Destination—the shared location that Vantage and Media Composer both have
access to. This is set automatically and should not be changed.

» Auto Launch—the file transfer program (VantageFileSender.exe). Do not change.
Export Settings—must be checked—select the Link to Effects Mixdown option.

If the setting doesn't display, click File > Settings > User tab. Under the Export cate-
gory, check Export—Link to Effects Mixdown and close the window. The new set-
ting should now display in the list.

3. Click Export Settings > Options to display the Export Settings - Link to Audio and
Video window:

Export Settings - Link To Audio and Video

4, Confirm these settings are checked (above and below the video/audio tabs):

» Export As—Select AAF—only Simple AAF files are supported. (See page 66 in the
Post Producer Developer Guide, published on the Telestream web site.)

» AAF Edit Protocol

» ProTools 10/12 compatibility

¢ Include All Video/Data Tracks in Sequence

¢ Include Audio Tracks in Sequence—Select the number of audio tracks to include
» Media Destinations > Video: Use Media Creation Settings

» Media Destinations > Audio: Use Media Creation Settings

Note: The Media Destinations drive where you want to save any newly-created media
should be accessible to Vantage.

5. On the Video/Data tab, confirm these settings are checked:
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o Export Method—Link to (Don't Export) Media
» Mixdown Video / Effects to V1
6. Next, click the Audio Details tab to confirm these settings:

port Settings - Link To Audio and Video

7. Flatten Audio Tracks. Check this setting.

8. Click Save to update the settings and close the dialog.

After clicking OK, Vantage File Sender launches and provides you an opportunity to
enter any metadata your workflow may be expecting (see topic following).

Note: You can repeatedly select sequences and configure all controls as required

before sending the sequences to the workflow. For each sequence you've configured,
Vantage File Sender creates a new tab. When all sequences are ready, you can submit
them to the workflow at one time, and Vantage creates a job for each one submitted.
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Providing Metadata with your Sequences

If your workflow requires metadata labels, they must be created in Vantage before you
can provide the values during job submission. For information about creating
metadata in Vantage, see relevant topics in the Vantage User Guide. If metadata isn’t
utilized, proceed to Submitting your Sequences to submit the job.

Design Metadata
¥ B~ 15 : -
= B | Vantage Label: AvidSend To —
Parameter | ]
W TrucFabe Wise [detati] ] [Misc]
¥ Integer TrueFalse [False |
B Decimal Integer o &)
¥ Date Decimal |0 0000000000 Sl
B Tet Date [June 13, 2024 9:37:32PM M
- Dropliowns Text |dEfaull viue
" DropDown_Exclusive
DropDown |Pam ﬂ -
Name: TrueFalse SUBMIT |
Description:  is this good?
Category: ob status. 0%
Value Type: True/False
. —— Advanced Information ;l

This graphic depicts the Vantage Workflow Designer label selector on the left, and the

same label displayed in the Vantage File Sender program as you are sending the
sequence to the workflow.

In the Vantage File Sender program, If you hover over a metadata field a tool tip
displays showing you the description entered in the label in Vantage (see Is this good?).

W TrueFalse is this good?

Metadata
Vantage Label: AvidSendTo -
[Misc]
TrueFalse |Fal5e : j
Integer C ;l:ieng;:t ‘True' or 'False'. :l i
Decimal -5.0000000000 g
Date [June 13,2024 11:42:38 PM v
Text |default viue |
DropDown ]Pam :J ==

SUBMIT
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Advanced Information Panel

When you are submitting multiple jobs simultaneously, you can optionally submit

them with the same metadata:

[l Vantage File Sender

DemoVideo & ATVsE larry i@
Wetadata
Vantage Label: AvidSendTo =
[Misc]
TrueFalse |Fa\se j
Integer |0 :l
Decimal [0.0000000000 g
Date |June 13,2024 9:37:32 PM V| |
Text |defau\t viue |
DropDown ‘Fam j
DropDown_Exclusive |J\m j
Path [ |
|| SUBMIT |
Job status 0%

[ Submit pending files using this metadata

Advanced Information ;I

log file path: C\SendToLog2s'testlog

Starting Vwa-r
Awaiting metadata entry.

ge'\Decision Based On LabelsVarry.aaf.

To do so, display the Advanced Information panel and check Submit Pending Files
Using This Metadata to submit all of these jobs with this metadata.

After clicking Submit, in the Advanced Information panel, Vantage File Sender displays
information about your job status and which AAF file(s) were sent to the workflow by
Vantage workflow ID (not by name (xref):

Advanced Information ;l

Checking sequence...

Submitting Wa-

\SendT

Validated 6 source files successfully and 0 source files unsuccessfully.
Connected to Vantage Domain

\Decision Based On Labels\ATVFades.aaf

on*10.0.20.70"..

Successfully submitted to host'10.0.20.70"
You can close this window if you dontwant to wait for the job results

to workllow '8b434457-1359-4ac4-b3c2-180eecc72dc3’

Finished processing \i

iToVantage\Decision Based On Labels\ATVFades.aaf

To view this workflow ID directly in Workflow Designer, display the workflow and click
the top disclosure triangle to view the text field containing workflow ID. The workflow
ID displays at the very top of the text window: scroll all the way to the top to locate it.
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Submitting your Sequences

To submit your sequence or sequences to the workflow, click Submit, as depicted here:

m Vantage File Sender

Metadata

| SUBMIT |

Job status: 0%

Advanced Information ;‘

For each sequence you've selected and configured, Vantage File Sender submits them
to the workflow at one time, and creates a job for each one submitted. Now, you can
view jobs being processed (or completed) in Vantage, via Workflow Designer.
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Template Files Information

In the parent folder where templates are stored, each template folder contains two
files—an STT file and an [Nl file:

This PC > saleseng (\\va-nexis) (Z:) > SendToVantage » StatusReport-Testing

~
Name Date modified Type
| StatusReport-Testing.stt 3/29/20245:23PM  STT File
| workflow.ini 3/29/2024 5:23 PM Configuration

The STT file is a copy of the file in the Avid Media Composer directory. Template files
that Media Composer uses are located at C:\Users\Public\Documents\Avid Media
Composer\Avid Templates\Send To Templates\Vantage.

Prototype STT File

STT files reference the template (and by convention, the workflow name) and the
location where the template was created—see highlighted text:

| StatusReport-Testing.stt - Notepad
File Edit Format View Help

k?xml version="1.8"2>

<!l-- Avid Send To Template (.stt) file -->
<templateNickName>StatusReport-Testing</templateNickName>
<supportedPlatforms></supportedPlatforms>
<supportedModels></supportedModels>
<supportedProjectTypes></supportedProjectTypes>
<supportedExportFormats></supportedExportFormats>
<supportedMediaObjects></supportedMedialObjects>
<supportedAudioFileFormats></supportedAudioFileFormats>
<supportedAudioSampleRates></supportedAudioSampleRates>

<supportedAudioBitRates></supportedAudioBitRates>

<destinationDirectoryPC>\\va-nexis\saleseng\SendToVantage\StatusReport-Testing\</destinationDirectoryPC>
<destinationDirectoryMac>//va-nexis/saleseng/SendToVantage/StatusReport-Testing/</destinationDirectoryMac>

<exportSetup>
<exportAutolLaunchInfo>
<visibility»on</visibility>

srmmT S catf mntland e Al i TaCandan asen s FamaTd casfans
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Prototype INI File

The workflow.ini file has data about the Vantage domain, shared storage, credentials,
the target workflow ID, and other variables—see highlighted text:

ﬂ workflow.ini - Notepad

File Edit Format View Help

[[connection]

host=10.0.20.70

user=MediaComposer
workflow=bf726aed-c9cc-454b-b5le-ddce2d8fedbc
templatename=StatusReport-Testing

[Storage]
username=
password=@ByteArray (\x1le\x62\xc5<E\x93\xda\xd3\xa9\x9cNZ\xd6\x

[metadata]
forceentry=true

[metadatagroups]
mediacomposer=Media Composer
vantage=Vantage

[metadataentries]
vantage\testname\displayname=TestName
vantage\testname\default=
vantage\testname\force=false
vantage\testname\type=text

These variables are generated when Media Composer initially sets up the workflow
when you create the template. If new variables are added after the template is created,
you must perform the creation process again.

The workflow ID specifies the workflow, and is displayed here in Vantage Workflow
Designer:

-~ [ variables [t

Name: _va
Description:
Expiration: Expire after

Options: Open mode

Created: 12/13/2(X 2 Owner: VA-G6-01
Updated: 1/9/2025 g Application: Vantage V- .iliuw Deaiguies
Layout Changed: 1/9/2025 8:01:11 PM 1D: 5922a370-ARG7-447-8%4e-BeacaeT4fele

Active Jobs: 0 Complete Jobs: 0 Failed Jobs: 0 Stopped Jobs: 0

Display the workflow and click the disclosure button to the left of the workflow title in
the design panel to view its ID and other pertinent information.
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Troubleshooting

If you can not submit jobs using Send to Vantage, consider these issues:

Confirm that the Nexis client is mounted on Media Composer and Vantage

Confirm that the Vantage Edit Service is running as a user that has access privileges
to the Nexis shares

Confirm that you are using the correct Post Producer ComponentPac—see Product
and Version Requirements.

Confirm that you are using Simple AAF export settings

If the timecode in CML and the timecode on the Media Composer timeline are not
lining up, it may be helpful to adjust your Media Composer Timeline Display to
match your frame rate: File > Settings > Project Tab > General:

General Settings - Current

If the Conform action fails when video mix-downs are included, check your media
creation settings for mix-downs: File > Settings > Project Tab > Media Creation:

o~
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Media Creation - Untitled

mport | Mixdown &Transcode | Mortion Effects
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Using the Send To Tools
Plugin

Use the Send To Tools plugin to create Send To templates. After you create the
templates, a new menu option appears in Avid Media Composer that allows you to
export AAF files and send them to a Vantage workflow.

Topics
m Prerequisites
m Supported Workflows
m Setting Up Send To Tools
m Troubleshooting

T
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Prerequisites

Prerequisites

Avid Media Composer 7 or newer

The Send To Tools application must be installed on the same server as Media Com-
poser

Media Composer and Vantage must have access to a shared storage location
Vantage must be licensed for Post Producer

Vantage must have Component Pac PostProducer.2023.1.0.188.nupkg or later
installed

Supported Workflows

Master clips in a sequence
Sub-clips in a sequence

Simple transition cuts

Workflows are limited to same constraints as Post Producer simple AAF workflows (see
the Post Producer CML Developer’s Guide).

Setting Up Send To Tools

The high-level steps involved in setting up Send To Tools are:

1.

. Create a category.

N OO i o WN

Install Send To Tools.

. Create a workflow.

. Configure the connection between Send To Tools and Vantage.
. Create Send To templates.

. Install the template in Vantage.

. Confirm settings in Vantage.

8.

Send the content.

These steps are explained in detail in the sections that follow.

Install Send To Tools

To install Send To Tools:

VT
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1.
2.
3.
4.
5.

Run the SendToToolsWindowslInstaller.exe installer.

On the Welcome screen, click Next.

Specify the location in which to install the application. Click Next.
Select all components. Click Next.

Specify Start Menu shortcuts as desired. Click Next.
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6. Click Install to begin the installation.

If you see the following error, Media Composer is not installed on the server as
required. (See Prerequisites.)

7. Click Finish.

Create a Vantage Workflow Category

The category can have any name. The Send To Tools plugin will query this category in
your workflow.

Create a Workflow

Create a new workflow in Vantage Workflow Designer. The workflow must include at
minimum Receive, Compose, and Conform actions. You may also want to include a
Delete or Move action to clean up the AAF files after the workflow is complete.

Create Templates

To create templates in Send To Tools:

1. Open the Send To Vantage Template Editor from the Start menu (C:\Program
Files\Telestream\VantageSendToTools\SendToVantageTemplateEditor.exe).

2. Navigate to the Configure Vantage Connection tab.
3. Populate the Vantage connection information as shown:
- Vantage Domain Name. The hostname/IP of your vantage SDK service
- Vantage Workflows Category. A Vantage category.
— Storage User Account. Not used.
- Storage Password. Not used.

— LogFile Path. This should be a path to a file (not a folder). If this field is left blank,
it defaults to the current user’s home directory and
C:\Users\%USERNAME%\Documents\VantageSendToLog.txt.

The template files are created and placed in this directory: C:\Users\Public Docu-
ments\Avid Media Composer\Avid Templates\Send To Templates\Vantage

4. Navigate to the Edit Send To Templates tab. Vantage workflows are populated on
the left. The Send to Template Name field indicates the name that is shown in
Media Composer menus.

5. Select a Vantage workflow.
6. Give the template a name.

7. Click Create Send to Template. An Explorer window opens for you to save the
template. Note that you must save the template in a location that both Vantage
and Media Composer can access. Take note of the name of the parent folder in
which you saved the template; this is needed for the next step.

Ty
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Install the Template in Vantage

Installing a template copies the file from the location you select to the Media Composer
directory.

1. From the Start menu, open the Send To Vantage Template Installer.

2. Click Choose Folder and browse to the parent folder you selected when you
created the template. All eligible template folders appear. Note: Select the parent
folder only, not to the folder with the template name.

3. Select the template(s) to install.

4, Click Install Templates. A confirmation window appears after the templates are
installed.

5. If Media Composer is open, close and re-open it. The templates are now available to
use.

Confirm Settings in Vantage

1. Open Media Composer.

2. Right-click a sequence in Bin, then select Output > Send To > Vantage > (your
template name).

3. A Media Composer window opens. Note that some of the settings in this window
can not be changed:

- Filename
— Destination
— Export Setting Options (only simple AAFs are supported)

VST
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Confirm that the settings are as shown:

ings - Link To Audio and Video

/_'\
Avid Integration Guide telestream



152 | Using the Send To Tools Plugin
Setting Up Send To Tools

ings - Link To Audio and Video

1. Click OK. You may see a message asking you to confirm before overwriting files.
2, Click Overwrite to launch the VantageFileSender.

Send Content to Vantage

After confirming your settings, the VantageFileSender launches.
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B TrueFalse

B Integer

& Decimal
[ Date

B Text

¥ DropDown

¥ DropDown_Exclusive

2.
3.

Value Type: True/False v

Using the Send To Tools Plugin
Troubleshooting

Enter any necessary metadata. Note that the Send to Tools plugin uses Vantage
labels for metadata, not variables. For example:

Metadata

Vantage Label: AvidSendTo —
N | [Misc]
TrueFalse

]Fa\se LI
Integer [0 a
[0.0000000000 8]
[June 13,2024 93732 PM v

Decimal
Date

Text ‘defau\t viue ‘

=i

SUBMIT

DropDown ]Fam

0%

Advanced Information j

Hover over a metadata field to see a tool tip that shows the description from the
Vantage label.

Note that the time stamp in the Date field is 12 hour; AM or PM must be set.
Click Submit.

The Advanced Information dropdown opens. To submit multiple files with the
same metadata, check “Submit pending files using this medata.” Any files you have
open in SendTo are submitted. You can also use this window to view information
about your job status.

You do not need to leave the window open after submitting jobs to Vantage.

Troubleshooting

If you have problems with Send To Tools, check the following:

Avid Integration Guide

Confirm that the Nexis client is mounted on Media Composer and Vantage.

Confirm that the Vantage Edit service is running as a user that can access the Nexis
shares.

Confirm that you are using Post Producer Component Pac 2023.1.0.188 or higher.
Confirm that you are using Simple AAF export settings.

Confirm that the Vantage Edit Service is running as a user that can access the
shared location specified for “SendTo Template Folders” configured during installa-
tion.

If the time codes in CML and the Media Composer timeline do not line up, adjust
your Media Composer Timeline Display to match your frame rate.

If the Conform action fails when video mixdowns are included, check your media
creation settings for mixdowns.
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telestream

153



154 | Using the Send To Tools Plugin
Troubleshooting

/_'\
telestream Avid Integration Guide



155

Capturing Video for Edit
While Ingest Operations

To perform Edit While Ingest operations in Avid Media Composer, you create a Live
Capture workflow with a Media Creation action, and AAF action for environments not
utilizing Interplay (MediaCentral | Production Management). These workflows capture
live video and generate growing AAF-based MXF files that you can import into Avid
Media Composer for editing in near real time.

Topics
m Edit While Ingest Workflow for Avid Media Composer

m Edit While Ingest Workflow for an Interplay Environment

Note: For complete configuration details, see Media Creation Action and AAF Action.
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Edit While Ingest Workflow for Avid Media
Composer

To perform Frame Chase | Edit While Ingest editing in Avid Media Composer that
doesn't utilize Avid Interplay (MediaCentral | Production Management), you first create
a prototype workflow to transcode single resolution media—multi-res encoding is not
supported. Next, you start a capture event in Live Capture, and import the AAF file into
Avid Media Composer.

Here are the tasks to perform (click on the link to view details):

Tasks
1. Creating the Workflow
. Configuring the Workflow to Operate in Open Mode
. Determining Your Source
. Configuring the Capture Action
. Configuring the Media Creation Action
. Configuring the AAF Action
. Activating the Workflow and Starting Capture

W N O L1 A W N

. Start Editing in Avid Media Composer...

Note: If you aren’t familiar with operating workflows, review the Workflow Designer
Guide or the Vantage Management Guide, both available from their programs. For
general and highly-detailed configuration information, open the inspector for any
action in your workflow and click the M button to display its man page.

Creating the Workflow

This workflow—which supports single resolution media transcoding only—is a
prototype; it is the simplest workflow you can make to perform Edit While Ingest
editing. After you create it and get it running properly, you can use it with confidence as
a basis for more complex (and practical) Edit While Ingest workflows to meet your
requirements.

In Vantage Workflow Designer, follow these steps to create this prototype workflow.

/_'\
telestream Avid Integration Guide



Capturing Video for Edit While Ingest Operations | 157
Edit While Ingest Workflow for Avid Media Composer

1. Create a new workflow and name it appropriately. This prototype is named AAF
Workflow.

2. Add a Capture action, Media Creation action and an AAF action and connect them.

Configuring the Workflow to Operate in Open Mode

Edit While Ingest workflows must be set as an Open Workflow—all actions operate
independently and as efficiently as possible, on a frame-by-frame basis—to process
incoming live video and write it to file, making it accessible to Avid Media Composer in
near real time.

To enable Open Workflow execution in Vantage and the workflow specifically, follow
these steps:

1. First, make sure that Vantage is configured for Open Workflow processing. In the
Vantage Management Console, click on Settings and Options:

7l Ventage Management Console [QAE-VL-LIVE-18 : Admiristrator]

Settings & Options

Email Authonzaticn Mapped Drives  DIVA

wws Active Directory for Users

2. In the General tab, check Enable Open Workflows; click Save and close the console.

3. Back in Workflow Designer, click on the disclosure button to the left of the workflow
name (here shown as AAF Workflow) to open its configuration panel:

Click the Disclosure button to open/
close the Workflow Details panel.

e Vantage Workflow Designer [QAE-VL-LIVE-18 : Administrator] - AAF Workflow
Help
Workflows G ~ [ AAF Workflow [Editing - this workflow is

Name:  AAF W,

Description:

Expir ;v Expire after 2 % hours (1.0 days)

Options: v Open mod

4, Check Options: Open Mode to set the workflow to execute in open mode.
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5. Now, right-click on each action in the workflow, and select Workflow Mode > Open:

T -E

Configure...

Perform On » B
Add Variables...

Run On Rules...

Resource Cost v ve stream.

Execution Metrics...

Description...

Annotation...

After setting the Capture, Media Creation, and AAF action to Open mode, you're ready

to continue.

Determining Your Source

In the Live Capture web app, determine which source you are going to capture (we'll
use SDI 01 in this example)—you'll use its name to specify it when you configure the

Capture action.

Configuring the Capture Action

The Capture action is an origin action—it captures live video (SDI | NDI | TS | RMPT | ST
2110), transcodes it and serializes it into a file. The Media Creation action can ingest
MXF-OP1a and TIFO files for Edit While Ingest editing, so this action should be
configured to use either an MXF or TIFO container. Other settings in the Capture action

don't directly affect Edit While Ingest editing.

o~
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1. In Vantage Workflow Designer, open the Capture action inspector, and select your
Live Capture Source (here shown as SDI 07) in the Source control. (If you have more
than one channel group, you may have to specify it as well):

| Capture: Captures a live stream.

Source: W 50101 W Channel Group:

Time-Shift:
Timecode Override Enable
T Ve Tde:
Ign lost frames
Delete files on failure
Enforce required labels to record
Workflow:
ption Data
Stagger Durationc 0

Hide Secondar

2. Set your primary output container to MXF or TIFO, select a codec (here, MXF with
DNxHD) and configure its controls per your requirements:

Capture: Captures a live stream.

Enforce required labels to record

Hide Secondary Outputs

Restrict input

Labels: B Expected Labels (0)
= Trigger

* Manual

Dutput Location... Edit Filename..

4 Audio v

A Secondary Output

3. Check Force One Track per Channel for PCM audio.

4, Specify other settings in the Capture action to meet your requirements and save
and close the inspector.
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Configuring the Media Creation Action

The Media Creation action generates the Avid-compatible AAF file. For Edit While
Ingest editing, you'll configure it to re-wrap the media for importing in Avid Media
Composer, with Frame Chase Editing mode enabled and an output location, stored in a
variable to identify the output location for use in the AAF action:

1. Open the Media Creation action inspector.

2. Click Select and specify MXF OP1a or TIFO, and then click Select and select the
nickname of the Capture action Primary Output: Original:

Media Creation: Create media compatible with Avid Media Composer and

Input Select =

B MXFOP1a Source: i Original ‘Select...
L3

3. Now, in the configuration panel on the right set Interplay Configuration to Media
Composer:

Media Creation: Create media compatible with Avid Media Composer and Interplay.
Interplay Configuration: Med

Edit Filename Pattem...

v AAF Pathe [ AAF Path v Path variable to generate

B Container: MXF OP15

¥ Open file support

Dpen file timeout: 120 -

Process Origin as Precharge

4. Also specify a nickname for the AAF output media file. Here, we've chosen Avid Out.

5. With the Input component selected as shown, in the Container panel at the bottom
of the right panel, check Open File Support, to complete Open mode configuration.

Now, lets configure the remaining Media Creation settings:
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6. In Physical File Settings, set these controls as shown:

ANF File Loc 2 prisproy Shared\AAP,
MXF File Location:  Y\ww d MedaFiles\MXPIWW-WC14.1y

ry and Temporary Files

¥ Create Unigue Folder for AAF

= Physical Drec wtrol | Limit Files per C

Max Number of Files in MXF Directory: 5000 3 files -

Copy AAF File  Disable %

7. AAF File Location: Browse to select the location where you want to save the output
AAF file. In this example, we're saving it in \\wwnexispro\AvidShared\AAF\.
We'll be using this directory later, to import the AAF file into Avid Media Composer.

8. MXF File Location: Browse and select the SAN or other network storage where you
want to save the MXF file set. In this example, we're saving it in
\\wwnexispro\AvidShared\Avid MediaFiles\MXF\WW-WC14.1\.

Note: In this example, we've checked Create Unique Folder for AAF, so that we can
specify a directory that doesn’t yet exist, without action failure.

9. Asset Attributes: Not specifically related to Edit While Ingest editing—set as
required for your requirements or accept default settings.

10. Input Type should be set to default Import.

11. Asset Tag Properties and AAF Updates: Not specifically related to Edit While Ingest
editing—set as required for your requirements or accept default settings.

12. AAF Path: Set this control to a variable (AAF Path is used in this example—just
remember the name of the variable for use when configuring the AAF action) to
track the server and path where you specified that the AAF file should be written,
for use in the AAF action.

13. Save and close the inspector.

Configuring the AAF Action

The AAF action is a utility action that supports PMR operations, Matte Key creation,
frame chasing editing, etc. For this application—Edit While Ingest editing in Media
Composer, without an Interplay (MediaCentral | Production Management) system—
configure the AAF action with the Input Source File Name bound to AAF Path variable
generated in the Media Creation action:
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1. Open the AAF action inspector and set your input to AAF (the only choice):

AAF: Helper Functions for Avid AAF Media.

Input

2. In the AAF Input component panel, click Select to display the Input Source dialog:
select File name and click the green Browse button to select the AAF Path variable,
which holds the fully-qualified path you specified for the AAF file in the Media
Creation action. (The nickname of the output media—MXF file set—is not what we
are using.)

3. In AAF Settings, set these controls as shown:

v Edit Filename Pattern...

PMR Pr

MXF Path Override

Project Name: V.

4, PMR Maintenance: Set to Rebuild.
5. Make sure that Matte/Key effect is set to None.
6. Save and close the inspector.

Activating the Workflow and Starting Capture

Now that you've configured the workflow, activate it (click Activate at the bottom of the
window) and start capturing your video:
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1. In Workflow Designer, activate the workflow:

b Vantage Workflow Designer [QAE-VL-LIVE-18 : Adrwrsstrator] - AAF Workflow

~ E AAF Workflow

5 Domain Monitor

Capture

Activate the current workflow (start accepting new jobs) B

2, Click Activate and then display the Job Status tab to see the workflow actions all
come into a Processing state:

Domain Summary W

Capture ] Media Creation

Job Progress Started ¥ Updated
"Frame Chase INTERPLAY TTTI02A ZATAZPM T/17/2024 21758 PM
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3. Now, in the Live Capture web app, start capturing your live video (in this example,
SDI01) by clicking the red record button at the bottom right of the preview panel; it
starts capturing and displays a blue circle with white square:

o I_:g-:":,i'ltsli)ff_"t';’ﬂi Live i_,apk_._i"i':‘ administrator QAE-VL-LIVE-18
Automation Ch... |M§ Channel Preview AAF Workflow

=, Status

Channels Leader Filler Trailer Time-Shift

No No No None

At this point, your Live Capture workflow is ingesting live media and writing DNxHD
frames to your MXF file set; the Media Creation is performing its task, so that you can
import the AAF file in Avid Media Composer.

With your live source streaming into Live Capture and being encoded and serializing
into an open, growing file set, you can start Edit While Ingest editing.

Start Editing in Avid Media Composer...

1. In Avid Media Composer, go to your project’s bin, right-click and select Input >
Import Media.
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2. Avid Media Composer displays the Select Files to Import—navigate to the Avid
shared storage server and directory that you specified in the Media Creation action
(AAF File Location) for writing the AAF file:

@ Select files to Import W
Lookin: [ AwidShared - «@dEr
Name Date modified Type
pree [AAF TA7/2024 11:18 AM File folder
— “Avid MediaFiles 7/7/2022 10:39 AM File folder
[l STATUS 8/14/2023 347 PM File folder
Deskiop
=
Libraties
This PC
Netwark
< >
Fravann. | 3 [Com
Filus of type [AlFiies (=) -] Cancel |
Opticns Video Resoluton: [DN«HD SO ~l
Video Dive: |lUIl -l
Audso Drive:

3. This directory holds recent Live Capture jobs in separate directories. Open the AAF
directory you specified in the Media Creation action to display the job directories:

@ Select files to Import e
Lookin: [ AF =] e®merEE-
' Name Date modified Type
5 51003 18c-6a49-40cf-8003-9c0eccOc1a53 7117/2024 1178 AM File folder
MK hesess T37cel44-ce30-49c5-bA3a-29a2844a3a5  7/17/2024 10:39 AM File folder
[Vl 286d0178-4CT0-4666-9862-6e676ba3cOed  T/17/2024 103TAM  File folder
Deskiop 0301b7d7-d3af-de31-a2a0-2F1261c3d800  7/16/2024 1212 PM File folder
- 836d020c-1cc9-4478-98ac-c45976a0e2c0 7/16/2024 1210 PM File folder
m 24826d19-6b21-4109-b7dd-Ofadcee3c 119 7/16/2024 11:25 AM File folder
Libraies 1849201a-25c1-45ca-b2Tb-9a4a 1 1decdd2  7/16/2024 B:16 AM File folder
This PC
MNatwork
< >
Fio name [ - |  Open
Filos of type: [Air Fies () Bl Cancel |
Options Video Resaluton: |DhHD SO ~|
Video Drve ]_, foy -l
Aaidso e
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4. Typically, you'll open the most recently modified directory:

(® select files to Import X
Lok in AAF Warkfiow > *®BcrB
' Name Date modified Type
(=) AAF Workflow_local.aaf TT/2024 11:21 AM AAF File
Qunck access
Deskiop
m
Librasies
This PC
Network
< >
File namae |AAF Workflow_local aaf -] [ Opeq
Fios of type All Files (**) - Cancel |
Options Video Resoluon [DH<HD S0 ~]
videoDive:  _, | [D7 _.._

Audso Drmve.

5. Select the AAF file and click Open to load it into Avid Media Composer.
6. Now, you can start Edit While Ingest editing:

¥
-
‘!

TSN N.
flale

Once the AAF workflow has completed in Vantage, re-import the AAF file into your
Media Composer bin to close the asset.
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Edit While Ingest Workflow for an Interplay
Environment

To perform Edit While Ingest editing for use in Avid Media Composer that utilizes Avid
Interplay (MediaCentral | Production Management), you first create a prototype Edit
While Ingest workflow. Next, you start a capture event in Live Capture, and import the
AAF file into Avid Media Composer. Here are the tasks to perform (click on the link to
view details):

Tasks
1. Creating the Workflow
. Configuring the Workflow to Operate in Open Mode
. Determining Your Source
. Configuring the Capture Action
. Configuring the Media Creation Action
. Activating the Workflow and Starting Capture

N O 1 A WN

. Start Edit While Ingest Operations in Media Composer...

Note: If you aren’t familiar with operating workflows, review the Workflow Designer
Guide or the Vantage Management Guide, both available from their programs. For
general and highly-detailed configuration information, open the inspector for any
action in your workflow and click the M button to display its man page.

Creating the Workflow

This workflow is a prototype; it is the simplest workflow you can make to perform Edit
While Ingest editing. After you create it and get it running properly, you can use it with
confidence as a basis for more complex (and practical) Edit While Ingest workflows to
meet your organization’s goals.

Capture . Media Creation ‘¢

Create media compatible with Avid |
Media Composer and Interplay. J

In Vantage Workflow Designer, follow these steps to create this prototype workflow.

1. Create a new workflow and name it appropriately. This prototype is named Frame
Chase INTERPLAY.
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2. Add a Capture action and Media Creation action and connect them.

Configuring the Workflow to Operate in Open Mode

Edit While Ingest workflows must be configured as an Open Workflow—where all
actions operate independently and as efficiently as possible, on a frame-by-frame
basis—to process incoming live video and write it to file, making it accessible to Avid
Media Composer in near real time.

To enable Open Workflow execution in Vantage and the workflow specifically, follow
these steps:

1. First, make sure that Vantage is configured for Open Workflow processing. In the
Vantage Management Console, click on Settings and Options:

7l Ventage Management Console [QAE-VL-LIVE-18 : Admiristrator]

Settings & Options

Email Authorzabon Mapped Drives  DIVA

oad Balancing (legacy)
Task Based Load Balancing
v Enable Open Workflows
v Enabi administration

Use Windows Active Directory for Users

W Metadata Labels

2. In the General tab, check Enable Open Workflows; click Save and close the console.

3. Back in Workflow Designer, click on the disclosure button to the left of the workflow
name to open its configuration panel:

Click the Disclosure button to open/
close the Workflow Details panel.

e Vantage Workflow Designer [QAE-VL-LIVE-18 : Administrator] - AAF Workflow

@ - ¥ Frame Chase INTERPLAY [

Name:  AAF W,

Description:

Expiration; v Expire after 24 % hours (1.0 days)

Options: v Open mode

4, Check Options: Open Mode to set the workflow to execute in open mode.
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5. Now, right-click on each action in the workflow, and select Workflow Mode > Open:

T -E

Configure...

Perform On » B
Add Variables...

Run On Rules...

Resource Cost v ve stream.

Execution Metrics...

Description...

Annotation...

After setting the Capture and Media Creation action to Open mode, you're ready to
continue.

Determining Your Source

In the Live Capture web app, determine which source you are going to capture (we'll
use SDI 01 in this example)—you'll use its name to specify it when you configure the
Capture action.

Configuring the Capture Action

The Capture action is an origin action—it captures live video (SDI | NDI | TS | RTMP | ST
2110), transcodes it and serializes it into a file. The Media Creation action can ingest
MXF-OP1a and TIFO files for Edit While Ingest editing, so the OQutput in the Capture
action should be configured to use either an MXF or TIFO container. Other settings in
the Capture action don’t directly affect Edit While Ingest editing.
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1. In Vantage Workflow Designer, open the Capture action inspector, and select your
Live Capture Source (here shown as SDI 07) in the Source control. (If you have more
than one channel group, you may have to specify it as well):

| Capture: Captures a live stream.

Source: W 50101 W Channel Group:

Time-Shift:
Timecode Override Enable
T Ve Tde:
Ign lost frames
Delete files on failure
Enforce required labels to record
Workflow:
ption Data
Stagger Durationc 0

Hide Secondar

2. Set your primary output to MXF or TIFO—this example uses MXF OP1a—select a
codec (here, DNxHD) and configure its controls per your requirements:

Capture: Captures a live stream.

Enforce required labels to record

Hide Secondary Outputs

Restrict input

Labels: B Expected Labels (0)
= Trigger

* Manual

Dutput Location... Edit Filename..

4 Audio v

A Secondary Output

3. Check Force One Track per Channel for PCM audio.

4, Specify other settings in the Capture action to meet your requirements and save
and close the inspector.
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Configuring the Media Creation Action

The Media Creation action generates the Avid-compatible AAF file. For Edit While
Ingest work, you'll configure it to re-wrap the media for importing in Avid Media
Composer, with Frame Chase Editing mode enabled:

1. Open the Media Creation action inspector.

2. In the Select menu, specify MXF OP1a (either MXF or TIFO may be used) and then in
the input component, click Select and specify the nickname of the Capture action’s
Primary Output: Original:

Media Creation: Create media compatible with Avid Media Composer and

Input Select =

B MXFOP1a Source: i Original ‘Select...
L3

3. Now, in the configuration panel on the right, set Interplay Configuration to
Interplay or to an Interplay system you've previously added to Vantage in the
Vantage Management Console:

Media Creation: Create media compatible with Avid Media Composer and Interplay.
Input Select = Interplay Configuration: WWinterplay0l v

B MxFOPla Sod ginal " Select... Output media file nickname: (™ Avid Out v Edit Filename Pattem...

T |

B Container: MXF OP1a

v Open file support
Open file timeout: 120

Process Origin as Precharge

Note: You can select Interplay to set up its details directly in this action, in the
Interplay Definition panel. You can also pre-configure one or more Interplay systems
in the Vantage Management Console, and they display here in the Interplay
Configuration menu for selection. For details, see the Vantage Management Guide.

4, Specify a nickname for the AAF output media file. Here, we've chosen Avid Out.
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5. With the Input component selected as shown, in the Container panel at the bottom

of the right panel, check Open File Support, to complete Open mode configuration.
Now, lets configure the remaining Media Creation settings:

6. In Interplay Settings, set these controls as shown:

Interplay Frame Ci

Expected Maxamum Duratio

AAF Path: [

7. Interplay Folder: Specify (manually or by browsing) the Interplay (MediaCentral |

Production Management) virtual folder path to be used for the output. (You can
also use a variable that contains this path, set from a previous action.)

Create Interplay Folder Path: Check to create the virtual folder(s) you just specified
if they don't exist. If you don't check this control and they don't exist, the job fails.

Frame Chase Editing: Select Enable. Modify the default controls as desired.
Asset Head Frame | Interplay Asset Metadata: Set controls as desired.

8. In Physical File Settings, set these controls as shown:

d Ternporary Files

ue: Folder for AAF

Max Number of Files in MXF Directory:

Copy AAF File  Disable %

9. AAF File Location: Browse and select the SAN or other network storage where you

want to save the output AAF file. In this example, we're saving it in
\\wwnexispro\Avidshared\AAF\. We'll be using this directory later, to import
the AAF file into Avid Media Composer.
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10. MXF File Location: Browse and select the SAN or other network storage where you
want to save the MXF file set. In this example, we're saving it in
\\wwnexispro\AvidShared\Avid MediaFiles\MXF\WW-WC14.1\.

11. In this example, we've checked Create Unique Folder for AAF, so that we can specify
a directory that doesn’t yet exist without action failure.

12. Asset Attributes: Not specifically related to Edit While Ingest—set as required for
your requirements or accept default settings.

Unless you're importing tape-based material, Input Type should be set to default
Import.

13. Asset Tag Properties and AAF Updates: Not specifically related to Edit While Ingest
editing—set as required for your requirements or accept default settings.

14. Save and close the inspector.

Activating the Workflow and Starting Capture

Now that you've configured the workflow, activate it (click Activate at the bottom of the
window) and start capturing your video:

1. In Workflow Designer, activate the workflow:

| Monitor Status  Job Status  Dom:

| Capture

Captures a live stream,

o
|

Activate the curment workflow (start accepting new jobs)
" Retvaley,
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2, Click Activate and then display the Job Status tab to see the workflow actions all
come into a Processing state:

Workflow Design  Monitor Status [SBESIBINSY Domain Monitor Status  Domain lob Status  Domain Summary  Workfiow Analytics

Capture £l Media Creation :'___

3. Now, in the Live Capture web app, start capturing your live video (in this example,
SDI01) by clicking the red record button at the bottom right of the preview panel; it
starts capturing and displays a blue circle with white square:

o Lightspeed Live Capture administrator QAE-VL-LIVE-18
Automation Ch... L! ;‘.:'I:"::-“::‘.i .!I:E:...L i

=, Status

Channels

esder Filer Trsder Timehit
No No No None

At this point, your Live Capture workflow is ingesting live media and writing DNxHD
frames to your MXF file set; the Media Creation action is performing its task, so that you
can import the AAF file in Avid Media Composer.

With your live source streaming into Live Capture and being encoded and serializing
into an open, growing file set, you can import it into Avid Media Composer and start
Edit While Ingest operations.
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Start Edit While Ingest Operations in Media Composer...

In Avid Media Composer, open the Tools > Production Management Window to locate
the AAF file and drag and drop it into your Avid Media Composer project’s bin:

e Edt View Operatons Tools Preferences Help

| Propemes | Relatives | Associations | | Restiictions. | _Categonies | Resenvabons | File Locations |

Nams [ ||

ts [
[

Duration

Media Status

|

esouton [ ]
1

L ]

]

[
Tracks [

vvvvv

-
il 1080p 23976 AVCI
|
10801 26 AVC1

00:05:00:00

00.0500.00 VA2

Navigate to the server and directory (in this case, /Incoming Media/0). select the file
and import it.

Note: You could also launch Interplay Access and log in; to import the AAF file being
generated by the workflow, locate the AAF file and drag and drop it into your Avid
Media Composer project’s bin.

1. Now, Select the file to play it:

P
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3. Now, you can start Edit While Ingest operations on the file as it grows in near real
time.

4. Once the AAF workflow has completed in Vantage, re-import the AAF file into your
Media Composer bin to close the asset.
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You can use a Flip64 > Media Creation > AAF action workflow to produce two video
clips, composite them, and then import into Avid Media Composer as an effect, and use
to apply a Matte/Key effect on your video.

Matte/Key capabilities in Vantage enable customers to automate their often tedious,
manual graphics ingest processes. The Matte/Key Effect feature exposes a background
clip through foreground clip (derived from the alpha channel as the matte key), using a
monochromatic, grayscale clip as a matte key. This creates a composite, superimposed
clip with transparent through opaque gradation areas based on the alpha channel
image.

You can use a still image with alpha channel or a video with alpha channel as your
matte key effect source.

Note: For a detailed description of all of the Media Creation action’s configuration
controls, see Media Creation Action Configuration.

Requirements

Creating a video composition that you can import into Avid Media Composer for use as
an effect requires that the video meets these requirements:

e The alpha channel (for the matte key) and the RGB channel video are in the same
file. Configure your Receive action (or other origin action as required) to receive
your input file.

» The Alpha Mask Filter in Flip64 extracts the alpha channel from the source video
track and generates video with the transparency levels mapped to the Y channel.
The generated video is DNxHD | DNxHR to be processed by the Media Creation
action. The video track created only contains the grayscale alpha mask image from
the source.

S
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Overview

Overview

To produce Matte/Key Effect files, you can ingest two types of media into your
workflow:

« Image files (PNG | TIFF | WebP, etc.) with an alpha channel

 ProRes file with an alpha channel.
Follow these steps to produce a video composition in Vantage that you can import into
Avid Media Composer as an effect to apply a Matte Key effect on your video clip:

1. Determine the format, frame rate, and duration of the video you plan to generate,
to apply the matte/key effect.

2. Create a ProRes clip with an alpha channel of the proper duration or a PNG file with
an alpha channel.

3. Create and configure your Matte/Key Effects workflow (see Configuring a Matte/Key
Effect Workflow).

4. Process your still frame/video through the Matte/Key Effects workflow to generate
the matte/key effects composition.

5. Import the matte/key effects composition into Avid Media Composer.
6. Apply it to your baseline video clip.

Configuring a Matte/Key Effect Workflow

This is a prototype matte/key effect Media Creation/AAF action workflow:

Create media compatible vith fid
| Media Composer and Interplay. |

Create media compatible with Avid

| Media Composer and Interplay. |

Receive action—Origin action, configured to accept the file (PNG or ProRes) to pass
downstream with same nickname: Original. Other origin actions may be used.

Flip64 action #1 (top branch)—Ingests Original, and extracts the alpha channel,
converts the color range of the video and encodes it into DNxHD/DNxHR format for
Avid compatibility. If a still image is submitted, it encodes video from the image.

* Input for ProRes file: Auto
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 Input for PNG file: Still Image

— Video: Duration set to time of intended length of the matte key effect.
e QOutput: MFX OP1a (nickname AlphaMXF):

- Video:

Enable Color Space Filter. Media Composer expects Full range video—set Gen-
eral > Output Video Range to Full Range.

Enable Alpha Mask Filter. Alpha scaling: Full to Studio.

Note: If you want to invert the alpha channel, do not use the Alpha Mask Filter’s
Assume Use Inverted Alpha Mask control. Instead, enable the AAF action’s Matte/Key
Effect > Swap Sources control.

Enable Allow Video Processor Bypass Filter if incoming media is already DNxHD |
DNxHR.

Codec: DNxHD | DNxHR to match fill video specifications.

Note: For DNxHR, be sure to check the Preserve Alpha Channel in the DNxHR codec
configuration panel.

Media Creation action #1 (following Flip64 action #1)—Wraps the DNxHD | DNxHR
alpha channel source generated from Flip64 #1 into an Avid-compatible AAF/OP-Atom
media file.

 Input: MXF OP1a (nickname AlphaMXF).
» Output Media File Nickname: AlphaAvidOut
* Interplay Configuration: Media Composer, per your requirements.
* Physical File Settings:
- Specify AAF file location; check Create Unique Folder for AAF.
- Physical Directory Control: Do Not Limit Files Per Directory
— Copy AAF File: Disable
» Asset Attributes:
Master/Source MOB ID: blank
Disable Data Track in Output: unchecked.

Material Name: Use Media Name

Timecode: Use Source Timecode

Input Type: Import; Source Package Name: empty
o AAF Path: Checked; AAFPathKey (variable)

Flip64 action #2 (bottom branch)—Transcodes the input media file into DNxHD |
DNxHR and encodes the video from the input image | media file to meet Avid Media
Composer requirements for the fill—RGB Channel utilization.

Ty
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* Input for ProRes file: Auto
 Input for PNG file: Still Image
— Video: Duration set to time of intended length of the matte key effect.
e QOutput MFX OP1a (nickname NonAlphaMXF):
Video:

Enable Allow Video Processor Bypass Filter if incoming media is already DNxHD |
DNxHR.

Codec: DNxHD | DNxHR to match fill video specs.

Media Creation action (following Flip64 action #2)—Wraps the video generated
from Flip64 #2 into an Avid-compatible AAF/OP-Atom media file.

 Input: MXF OP1a (nickname NonAlphaMXF).
» OQOutput Media File Nickname: NonAlphaAvidOut
« Interplay Configuration: Media Composer, per your requirements.
 Physical File Settings:
— Specify AAF file location; check Create Unique Folder for AAF.
- Physical Directory Control: Do Not Limit Files Per Directory
— Copy AAF File: Disable
o Asset Attributes:
Master/Source MOB ID: blank
Disable Data Track in Output: unchecked.
Material Name: Use Media Name

Timecode: Use Source Timecode

Input Type: Import; Source Package Name: empty

AAF action—Generates a composite media file by applying the Matte Operation using
the video tracks of the two video clips made by the Media Creation actions.

* Input: AAF (nickname nonAlphaAvidOut)
» Output Media File NickName: AAFOut
e AAF Settings
* PMR Maintenance: disabled (PMR Processing: None)
» Matte/Key Effect
- Matte/Key Effect Processing: Apply

- Effect AAF Path: File name; bound to AAF Path variable AAFPathKey, set in alpha
channel’s Media Creation #1 action.

— Effect Name: Practical string, per your utilization in Avid Media Composer

» Swap Sources: typically, unchecked. When checked, AAF action swaps foreground
and background layers to compensate for an inverted alpha channel.

» Override Output Path: Typically, Enable and specify the output AAF path.

ST
telestream Avid Integration Guide



Creating an Avid Media Composer Matte/Key Effect | 181
Configuring a Matte/Key Effect Workflow

» Create Unique Folder: Typically, check enabled.
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Performing Avid Media
Production Operations

This chapter describes how to use Vantage's Notify action in Interplay (MediaCentral |
Production Management) workflows. The Notify action has several functions for use in
these workflows: To create MOB IDs and to perform various other Avid Production
operations.

Note: The Media Creation action supports Edit While Ingest operations in single-
resolution workflows, and in multi-resolution workflows when using Generate MOB ID.
Select a Notify action’s MOB ID Generator Notifier to create unique MOB IDs for use.
The MOB ID Generator returns a MASTER MOB ID and a SOURCE MOB ID as Vantage
variables.

Topics
m Creating MOB IDs for Interplay (MediaCentral | Production Management) Workflows
m Using MOB IDs in Workflows
m Metadata XML File Structure
m Configuring the Interplay Notifier's Web Services Host Connection
m Performing MediaCentral | Production Management Operations

m Delivering Media to Transfer Engine

Note: The Notify action can be added to any Vantage workflow. To create, configure,
and manage workflows in Vantage, use the Vantage Workflow Designer. If you are not
familiar with Vantage workflows, refer to the latest version of the Vantage User Guide
located on the Telestream website.

S
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Creating MOB IDs for Interplay (MediaCentral |
Production Management) Workflows

The purpose of the Master MOB ID in Avid is to uniquely identify an Interplay
(MediaCentral | Production Management) asset. In the context of a Vantage workflow,
you can generate a master or source MOB ID using the Notify action, depending on
your workflow requirements. Master and Source MOB IDs are used to dynamically link
files and metadata together to form an Production asset, acting as a unique identifier.

You need to place the Notify action prior to the Media Creation action so that the action
has access to the variables holding the MOB IDs you generated.

To generate a MOB ID, add a Notify action to the workflow Open the Notify action
inspector and follow these steps:

1. Select the Notify action’s MOB ID Generator Notifier:

b P e = LT

. *Notify: Send notification

Select the Notification type:

Name | Description
Automation File Notifier Creates a notification file based upon specific criteria.
BXF File Notifier Creates a BXF file based upon specific critena.
Cloud Netifier Publishes messages to a doud pub/sub message service
Dolby DP600 Notifier Submit workorders to a Dolby DPS00 via web services
Dump Dump an XML file describing the current job
ExternalShell Notifier Invoke an External Command Shell
Http Notifier Invoke a command on a remote server via HTTP
Interplay Motifier Invoke an Avid Interplay web service method
Invoke Invoke an external application

nerator Not...  Generate fariables

MNexGuard Notifier Invokes a NexGuard web service method
SeaChange MVL Notifier Invoke the SeaChange MVL Notifier
Text/CSV Report Notifier Generates text file reports from workflow variables

WebService Notifier Invoke a web service method

2, Check options to produce Master and/or Source MOB IDs and select the variables
to hold the MOB ID values:

*Notify: Get MOB ID
Generate Variables

v Master MOB ID: B MASTER MOBID ¥ Text variable to generate

v Source MOBID: B SOURCEMOBID ¥ Text variable to generate

Cancel < Previous | Next> |

3. Click Next and then click Save to update the action and close the inspector.

The MOB ID variables can be used to populate MOB ID fields within the Media Creation
action, and the Notify action's Interplay Notifier notification type.
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For example, you can pass a MOB ID to a second Media Creation action to create
additional media files that are associated with a Production asset. Or, you can pass it to
a Notify action to interact with Production and perform a variety of operations on a
Production asset by its MOB ID.

Using MOB IDs in Workflows

A MOB ID is a unique identifier in production Interplay (MediaCentral | Production
Management) systems. In the context of Vantage, there are several ways to create a
MOB ID:

« Explicitly, using the MOB ID Generator in a Notify action (see Creating MOB IDs for
Interplay (MediaCentral | Production Management) Workflows).

» Automatically, via the Interplay options in the Media Creation action.

» Automatically, when creating Media Composer assets without checking them into
Production. The MOB IDs can be accessed downstream in these workflows.

The purpose of a MOB ID is to provide a unique identifier to associate components to a
Production asset, which often is comprised of a set of files of the same content in
different formats, plus head frames, XML files, etc., all associated with the primary asset.

In the context of a Vantage workflow, the Vantage Notify action’s MOB ID Generator
function returns a MOB ID that can be assigned a variable, which can then be used in
downstream actions. For example, you can pass it to a subsequent Notify action to
interact perform a variety of operations on an asset by its MOB ID.

Note: Only in unusual circumstances should a MOB ID be entered manually. For
example, when rectifying an error such as a failed transcode. When you manually
enter a MOB ID, that workflow can only be used to modify assets of the MOB ID you
specify.

Metadata XML File Structure

XML files are used in Vantage workflows for ingesting a wide variety of metadata into
Avid environments with:

» The Notify Action’s Interplay Notifier
e The Media Creation Action in Interplay mode

* The Media Creation Action in Media Composer mode

Interplay (MediaCentral | Production Management)
Metadata XML

Interplay (MediaCentral | Production Management) metadata can be ingested using a
simple XML schema structure supporting Avid User Property, Locator and Restriction
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metadata, shown in the example below. This applies to the Notify Action’s Interplay
Notifier, and Media Creation Action in Interplay mode.
<Metadata>

<Entry>
<Tag>Avid Property Name</Tag>
<Value>Data for Property</Value>

</Entry>

<Locator>
<Label>Comment for Locator</Label>
<Color>Color for Locator</Color>
<Timecode>Absolute TC</Timecode>
<Username>username for WS/Interplay Server</Username>
<Track>Valid video or audio track such as V1 or Al</Track>

</Locator>

<Restriction>
<Comment>Avid Property Name</Tag>
<InTimecode>Absolute In Timecode</Value>
<OutTimecode>Absolute Out Timecode</Value>

</Restriction>

</Metadata>

The schema consists of three element types:
» Entry—for adding Avid User Property data.
» Locator—for adding Avid Locator marker data.

» Restriction—for adding Restriction information.

The Entry element has child elements that contain data values:
o Tag—for the name of the Avid User Property.
» Value—for the Avid User Property data.

The Locator element also has child elements that contain data values:
e [abel—for a comment for this locator.

» Color—for the display color for this locator (Red, Green, Blue, Cyan, Magenta, Yel-
low, Black, White).

o Timecode—for the absolute or relative timecode for this locator (hh:mm:ss;ff or
hh:mm:ss;ff).

 Username—for the username used for Web Services or the MediaCentral | Produc-
tion Management Server login.

» Track—for the identity of the video or audio track (for example: V1 or A1). Multiple
Entry and Locator elements can be defined in the XML file.

The Restriction element has child elements that contain data values:
e Comment—for a comment for this restriction.

e InTimecode—for the absolute In Timecode for this restriction (hh:mm:ss;ff or
hh:mm:ss;ff).

e OutTimecode—for the absolute Out Timecode for this restriction (hh:mm:ss;ff or
hh:mm:ss;ff).
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Multiple Entry, Locator, and Restriction elements can be added to the XML file.

Media Composer Metadata XML

Media Composer metadata can be ingested using a simple XML schema supporting
AAF metadata that can be added to a Media Composer BIN when the AAF is imported.
This applies to the Media Creation Action in Media Composer mode.

XML for Media Composer AAF Tagged Value Pairs

Here is an example of a Media Composer metadata XML file, with specified AAF tagged
value pairs.

<Metadata>
<AAFEntry>
<Tag>AAF PropertyA</Tag>
<Value>AAF CommentA</Value>
</AAFEntry>
<AAFEntry>
<Tag>AAF PropertyB</Tag>
<Value>AAF Commentb</Value>
</AAFEntry>
<AAFEntry>
<Tag>AAF PropertyC</Tag>
<Value>AAF CommentC</Value>
</AAFEntry>
</Metadata>

The schema consists of a single type:
» AAFEntry—for adding Tagged Property data and values.

The AAFEntry element has child elements that contain data values:
» Tag—for the name of the AAF Entry Property.
» Value—for the AAF Entry Property data.

Multiple AAFEntry elements can be added to the XML file.

T
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Configuring the Interplay Notifier’'s Web Services
Host Connection

To configure the Notify action’s Interplay Notifier function to connect to your Interplay
Notifier's Web Services host, display the Inspector and follow these steps:

1. Select the Interplay Notifier.

*Notify: Send notification

Select the Notification type:

Name | Description

Automation File Notifier Creates a notification file based upon specific criteria.

BXF File Notifier Creates a BXF file based upon specific critena.

Cloud Netifier Publishes messages to a doud pub/sub message service

Dolby DP600 Notifier Submit workorders to a Dolby DPS00 via web services

Dump Dump an XML file describing the current job

ExternalShell Notifier Invoke an External Command Shell

Http Notifier Invoke a command on a remote server via HTTP
(interplay Notifier  Invoke an Avid Interplay web service method |

Invoke Invoke an external application

MOB ID Generator Not... Generate MOB ID Variables

MNexGuard Notifier Invokes a NexGuard web service method

SeaChange MVL Notifier Invoke the SeaChange MVL Notifier

Text/CSV Report Notifier Generates text file reports from workflow variables

WebService Notifier Invoke a web service method

2. Click Next to configure connection details for Web Services.
*Notify: Send notification

Enter the connection information for Avid Interplay WS:
WS Host:
TCP Port: 80 ¢ 165535 -

Usemame:

Password:

Required

3. Configure these parameters for your system:
WS Host—specifies the URL or IP address of the Web Services host.
TCP Port—specifies the port number of the Web Services host you're connecting to.

Username and Password—specifies the username and password to connect with.
(This is your MediaCentral | Production Management username/password).

/_'\
telestream Avid Integration Guide



Performing Avid Media Production Operations | 189
Configuring the Interplay Notifier's Web Services Host Connection

Note: The Password field cannot be bound to a variable.

Test Connection—tests the WS Host settings. If they are correct and the Web Service
is available, Vantage reports success. Otherwise, determine the problem and test
the connection again. You can’t continue until you have a successful connection.

4, Click Test Connection to verify your configuration and availability of the Avid Web
Service.

5. Click Next to configure the action to perform the Production operation you require.
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Performing MediaCentral | Production
Management Operations

After you've successfully configured the Notify action’s Interplay Notifier to connect to
your MediaCentral | Production Management Web Service, you can configure the
action to perform various Production operations. Except for Create Master Clip, these
operations all use a specific MOB ID (see Using MOB IDs in Workflows).

Here are the Production operations you can perform:

Create Master Clip—creates a new, fully-formed master asset. Note that clips added
to assets created using Create Master Clip cannot be frame-chase edited.

Add Metadata to Clip—adds metadata to the master asset (locators, user properties
set in the Inspector, and from XML attachments). (Locator metadata can only be
added after an asset contains at least one clip resolution.)

Add Metadata to Folder--adds metadata to a folder.
Extract Clip Metadata—extracts metadata from the master asset
Set Headframe—creates a headframe image from the specified source

Copy Clip—copies an existing asset and optionally preserves the Master MOB ID of
the source

Move Clip—moves the master asset

Rename Clip—renames Interplay assets

Delete Clip—deletes the master asset. (The media files are not deleted.)

Check In Graphic File—checks in non-Avid assets, such as a JPG/PNG graphic file
Check In AAF file—checks in AAF files

To perform a specific operation, select it. Next, complete the form for the operation you
selected. Click Next and then click Finish to save and close the inspector.
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Delivering Media to Transfer Engine

Your workflow can deliver media to an Avid Interplay Transfer Engine via the Deploy
action configured with the Avid Interplay Transfer Engine plugin. The Deploy action

exports the specified file or file sets including metadata to a system outside of the
Vantage domain.

You should use Deploy in this manner when media is generated using the Avid Transfer
Manager | Transfer Engine encoder; these files are then re-wrapped in a new container
by Transfer Manager | Transfer Engine, and delivered into Avid storage.

Configuring the Deploy Action

To configure the Deploy action, follow these steps:
1. Add the Deploy action to the workflow and open it's inspector:

*Deploy: Copy and deliver files
Select the deployment type:

Name & | Description |
Avid nerp ay Transter nglne Deliver a media file to an Avid TransterMa...

Export Copies and delivers multiple files

Synamedia COS Delivery Deliver material to a Synamedia Cloud Obj...

YouTube Deploy media to YouTube.
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2. Select Avid Interplay Transfer Engine plugin and click Next. The Deploy action
displays the configuration panel:

*Deploy: Copy and deliver files

Media file nickname to deploy:
i
Unity/LAN Share Workspace:

Transfer Engine Hostname:

Ingest type:

Insert Metadata Name/Value pairs

Required < Previous | Next >

3. Configure these settings:

Media File Nickname to Deploy. Specifies the nickname of this media file, for use
in downstream actions.

Unity/LAN Share Workspace. Specifies the name of the workspace that this media
should be placed in. Leave blank to utilize the default workspace.

Transfer Engine Hostname. The name | IP address of the Transfer Engine | Transfer-
Manager that is the target of this deployment.

Ingest Type. The container format of the media (AAF | OMF) that should be created
during the deployment process.

Metadata Tab

o~
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4. In the Metadata tab, optionally create a collection of metadata name/value pairs,
which may be provided to the Avid Transfer Manager ingest process.

Insert Metadata Name/Value Pairs. Check to add metadata tags; add as many as
required.

Add New Item. Adds a new metadata tag. Manually enter the Metadata tag name
and value or click Browse to assign a variable which contains the value. To re-
arrange the list, use the up/down arrows. To delete a tag, click the X icon (upper
right).
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Locators Tab

5. Use the Locators tab to create a collection of color-coded labels to mark points of
interest on the timeline, which may be provided to the Avid Transfer Manager
ingest process.

Insert Locators. Check to add locators; add as many as required.

Add New Item. Adds a new | Manually enter the comment (which displays the
string at the specified timecode) or click Browse to assign a variable which contains
the value. Specify the color of the mark point and the timecode. To re-arrange the
list, use the up/down arrows. To delete a locator, click the X icon (upper right).

6. Click Next and then click Save to update the action and close the inspector.

Ty
Avid Integration Guide telestream



194 | Performing Avid Media Production Operations
Delivering Media to Transfer Engine

/_'\
telestream Avid Integration Guide



Vantage Actions for Avid Media Processing
Vantage Actions for Avid
Media Processing
Telestream has created and implemented several actions—the Asset Monitor action,
Retrieve action, Media Creation action, and the AAF action—which you can use in
Vantage workflows specifically for importing, exporting, and specialized processing of
media files for Avid utilization.
This chapter is an overview these actions and output formats, with detailed
explanations of their functionality and all of their configuration controls. These same
topics are available directly in Vantage Workflow Designer as man pages.
Topics
m Al Speech Action
m Asset Monitor Action
m Retrieve Action
m Media Creation Action
m Media Creation Action Input Components
m AIFF Input
m Auto Input
m MXF OP1a Input
m TIFO Input
m Wave Input
m Configuring Output for Media Composer
m AAF Action
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Al Speech Action

The Al Speech action provides audio-to-text transcription and audio summarization. It
integrates with Avid Interplay Web Services to deliver transcription and summarization
to an Avid environment through an open workflow. The service can populate an Avid
editing system with insights about what is said in the audio while the file is still
growing.

If the Capture and Al Speech actions are in separate workflows, they can be combined
with the Http Notifier action in open workflow fashion. If Capture and Al Speech are in
the same workflow, the Http Notifier action is not needed.

Telestream recommends that you run the Vantage Al action on a dedicated server with
1-2 NVIDIA CUDA GPUs. If your Vantage license includes at least 1 seat of Array, the Al
Speech action can run on a separate machine in a Vantage domain.

Note: The Vantage Al Service is not supported on Lightspeed Live Capture servers.
For using the Capture and Al Speech actions in separate Vantage domains, use the
Notify “Http Notifier” action to forward the Capture output to an Al Speech workflow
in open fashion.

Follow these recommendations to use the Al Speech action with Open Locators:

» Configure the Al Speech and Notify Open Locators actions to run in open workflow
mode.

» Set the Open File Timeout parameter of the Notify action to a value higher than the
Read Timeout parameter of the Al Speech action.

» Enable Frame Chase Editing in the Media Creation action.

The following example shows Http Notifier settings:
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MNuotify: Send notification
Method Type: Post
Protocol Type:  http
Encoding Type: applicationfjson ¥
Request Body:
Host Name: 10.0.20.201

Port: 8676 % 1-65535

Prowy Server: Enables the use of a proxy server

HTTP Method: Rest/Workflows/21§406b5-59a7-42ae-849¢c-75091e4396a2/Submit
Timeout: 00:00:30 & (HH:MM:55)
Set State: V' Set state to Failure on invalid resuft from HTTP request

Enable basic HTTF authentication

Set HTTP guery string arguments

Set HTTP header values

< Previous ([N

The following example shows the request body for the Http Notifier action:
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Construct: Construct an item

Specify one or more construct operatians to perform:

Add New Item

Select the operation: Construct a multi-line string ¥

Specify the format for the string:
{
"Attachments™: [],
*JobName"; "FROM-CAPTURE- =
“Labels™: [],
"Medias™ [

f
1

“Identifier”: "abb3f7e5-8d7e-49ba-84c5-674a55edb700",

“Data™: "if sending in-band data (eg: CML); place a UTF8 BASE64 encoded version of the data in this field and do not send a file path.”,

"Description”: "The original version of content encountered or created by Vantage.”,

"W\10.0.20.151\CaptureCopyToar\ (A - ) -
L

“Name"; "Original”

1

“Priority™: 0,

"Variables™ [

{

“Identifier”; "7afd46cd-7h20-49c9-9451-b28795d0076b",
“DefaultValue™ ™,
“Description™ ™%,
"Name": "Master MOB D",
“TypeCode™ "String”,

“Value™ * [0 MBS‘ETMD.V..G =

Result: B Al-JSON-TO-SECONDARY-WORKFLOW ¥

Note the following compatibility considerations for Al Speech:

« If using Avid ComponentPac 2024.4 or earlier, you must the option to generate the
AAF Path variable from the Media Creation action for the workflow to execute in
open fashion.

« If using Avid ComponentPac 2025.1 or later, the Media Creation action does not
require the AAF Path variable to be generated. Avid ComponentPac 2025.1 or later
are recommended for Open Locators workflows.

« If using Capture or Flip64 MXF OP1a output as the input to Media Creation and Al
Speech, set the Partition Duration of the MXF OP1a container settings to 2 to 5 sec-
onds.

Avid Integration Guide
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Example Workflow: Flip64 to Avid Media Creation

Receive

Media Creation ‘Y4

71 Apsd Me... 171 Avid Media

Populate

o

Update metadats

Receive

Media Creation ',
" Fliptd Me_.. | Avid Media

)
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Asset Monitor Action

The Asset Monitor action monitors the specified folder and initiates a job each time a
new or modified asset is discovered in Avid MediaCentral | Production Management
since the last scan, and generates the specified format reference output, passing
control to the next action (if any) in the workflow.

Asset Monitor actions are executed by the Vantage Avid Service.

The Asset Monitor action is an origin action, and can only be used as the first actionin a
workflow; however, it may be the only action in a workflow. Asset Monitor actions run
when the workflow is activated and during the active time frame, if specified.

The Asset Monitor action is designed as a same-as-source-converter, assembling media
as quickly as possible for processing (typically transcoding and related tasks) by
downstream actions or other workflows.

It generates an Interplay Metadata and/or Telestream proprietary MP4 media file from
the new/modified input asset.

Note: When some or all media is offline, and only AAF Container and Interplay
Metadata are configured to produce output files for an asset (master clips or
sequences), the job will process and complete. However, if MPEG-4 Reference is
selected, the job will fail because Vantage can not create an MPEG-4 reference file with
missing Avid OP Atom media.

A wide variety of Avid formats are supported for decoding. Consult the Ingesting
Master Clips | Subclips | Sequences chapter in the Avid Integration Guide for a complete
list.

Before this action can be activated and used in a workflow, you must configure your
Vantage domain for the MediaCentral | Production system(s) you are using. See Adding
a MediaCentral | Production Management System to Vantage, below, for details.

Topics
m Avid Media Composer Sequence Requirements
m Processing Asset Types
m MP4 File Generation
m Adding MediaCentral | Production Management Connections to Vantage
m Configuration Overview
m Configuration Details
m Output Components
m Adding and Configuring Outputs

Note: Controls with a green Browse button may be bound to a variable to
dynamically assign their setting or value. The variable must have a value when this
action executes. You can assign the value to the variable in a previous action in the
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workflow or use the variable's default value. Click Browse to select the variable or
Ccreate a new one.

Avid Media Composer Sequence Requirements

In order for the Asset Monitor action to ingest and process Avid media, it must adhere
to the following requirements:

The Asset Monitor action processes two kinds of assets - master clips and sequences.
Sequences may have:

- Gaps in the timeline. During processing, gaps will be filled with black frames/silent
audio.

- Mixed formats (codecs/resolutions). Segments that differ from the format of the first
segment will be transcoded to the first segment's format and the samples will be stored
in the output MP4,

- Transition effects. Transition effects must be rendered before submitting the asset to
the Asset Monitor action.

- Segment effects. Tracks that contain segment effects must be rendered before
submitting the asset.

Note: Segment effect rendering is effective for most commonly used compositions
but may not work as expected for highly complex sequences.

Processing Asset Types

You can process Master Clip and Sequence assets as well as Master Clip assets.

Note: If the Asset Monitor is active and processing output as it is being written (frame
chase editing | edit while ingest), occasionally the proxy file will be written first. As a
result, this will be the file processed by the Asset Monitor. When ingesting growing
media in the Avid folder being monitored, the Asset Monitor processes the asset only
when it is complete. Files must be completed and closed prior to the Asset Monitor
activation so that both the proxy and high-res are present.

MP4 File Generation

The Asset Monitor action creates a Telestream proprietary MP4 media file for further
Vantage processing, which references MXF OP-Atom files located on Avid shared
storage for the asset and may also include additional transcoded media. The file also
includes VANC data extracted from the asset's data track. In addition, a metadata XML
file containing the asset's metadata is generated. The MP4 reference file and XML file
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are passed to downstream actions in the workflow or to other workflows for
transcoding and metadata extraction.

Any system processing these MP4 files must have fully-authenticated access to the
media files located in the Avid shared storage (ISIS/NEXIS).

MP4 files generated by the Asset Monitor action contain Telestream-proprietary
extensions. Therefore, the following requirements apply:

- Vantage transcoding actions processing these files must use the Auto decoder for
Flip64.

- For playback, Switch 4.0 or later is required and processes closed captions including
other metadata in these files.

Adding MediaCentral | Production Management
Connections to Vantage

Before this action can be activated and used in a workflow, you must add and configure
an Avid system in your Vantage domain to communicate with each MediaCentral |
Production Management system you are monitoring.

Note: The systems displayed in the Asset Monitor action's Configuration menu are
those that have been added to the Vantage Management Console.

To add an Avid system to Vantage and configure and test its connection, follow these
steps:

1. Start the Vantage Management Console.
2, In Settings & Options, display the Avid tab.

This panel is where you create, configure, delete, import and export Avid system
connections.

3. Create and configure a connection to the target system, providing the following
information:

- Name

- Web Services Host

- Web Services Port

- Production Workgroup
- Production Username
- Production Password.

For more details on configuring and managing connections, click the ? icon to dis-
play the topic in the Vantage Domain Management Guide.

4. Click Test to confirm that Vantage can access the target MediaCentral | Production
Management server. If you have problems, determine the issue and retry.
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Configuration Overview

To configure an Asset Monitor action for your workflow, first specify the system you
plan to monitor, and configure the monitoring options as required.

Note: The Avid configurations listed are created by you in the Vantage Management
Console.

Next, add your output(s) and configure them for processing.

When you are done configuring this action, click Save.

Configuration Details

Interplay Configuration. Specifies the target Avid system for this workflow. When the
workflow is activated, this list is dynamically generated from the Avid systems
identified in the Vantage domain. See Adding a MediaCentral | Production Management
System to Vantage (above) for details.
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Asset Monitor Settings

Interplay Configuration:  interplay03

Asset Name Pattern:

User Attribute Monitor:

lgnore Modifications Before:

Interplay Folder Scan Interval:

Web Service Request Timeout:
Web Service Wait Per Reques

Generate Variable

Master MOB ID:

Source MOB ID:

Browse...

User Attributes
v’ Reprocess As n Modifications =

v Persist Assets

v Process Incomplete Assets

v Ignore Asset Online Status  ~

v Process Partially Online Multi-Resolution Master Clip

lanuary 1 1
60 v 5-120 secs
60 5-120 secs

0 S 0-120 millisecs

Tape (Source Package) Name:

I Container: AAF Container

File Extension: aaf

Interplay Folder. Specifies the full folder path for the output asset. For example:

Incoming Media/Folder 1/Folder 2.Thefolder can be specifiedin the

following ways: entering the folder path; clicking Browse and selecting an existing
folder path; binding to a folder path variable.

Note: Folder names are not case sensitive.

Master Clips. When checked, specifies that new master clips will be ingested for
processing; otherwise they will be ignored. See Processing Asset Types below for more
details.

Sequence Assets. When checked, specifies that new sequence assets will be ingested
for processing; otherwise they will be ignored. See Processing Asset Types below for
more details.
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Ignore Custom User Attributes. Asset Monitor gathers all the asset metadata into an
Interplay Metadata output file, that includes system metadata, user metadata and
contents of custom metadata fields defined for the MediaCentral | Production
Workgroup, by default. When this option is checked, the custom metadata fields will be
ignored. This option is used to address server issues involving control characters in the
custom metadata.

Reprocess Assets on Modifications. When checked, assets that have been processed
will be processed again when the asset is modified.

Persist Assets. When unchecked, processes all assets in a specified folder (conforming
to other criteria, such as the last modified time of the asset being later than the date
specified in Ignore Modifications Before) after each system/service restart.

When checked, saves the assets and their last-modified time stamps in persistent
storage so they are not reprocessed after a system or service restart.

Track Deleted Assets. When checked, tracks assets that were deleted from a folder
then added again later. Vantage will not reprocess the asset when the asset re-appears
or if the Avid Web service is restarted.

Process Incomplete Assets. When checked, processing an incomplete asset results in
a failure for that asset. When unchecked (default), the asset will continue to be
processed in subsequent scans.

Ignore Asset Online Status. When checked, ignores the online/offline status of an
asset and processes the asset.

Process Partially Online Multi-Resolution Master Clip. When checked, processes the
largest media size online resolution of a multi-resolution master clip track. When
unchecked, the asset is always treated as having an offline track.

Asset Name Pattern. String supplied to Avid for filtering the responses using a regular
expression on the asset display name.

User Attribute Monitor. Monitors for changes to user attribute metadata from Avid
Production Access. When a change is detected, a new job is triggered.

Note: Changing the attribute value to null (blank) or changes made while the service
is not actively monitoring will not trigger a new job. When Track Deleted Asset is
checked, moving the asset, modifying metadata, then moving the asset back to its
original folder will trigger a new job.

Ignore Assets Created Before. Specifies a date in the past, beyond which no newly
created assets should be ingested.

Ignore Modifications Before. Specifies a date in the past, beyond which no modified
assets should be ingested.

Interplay Folder Scan Interval. Specifies the number of seconds (5-120) that should
occur between scans.
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Web Service Request Timeout. Specifies the maximum number of seconds (5-120) to
wait for a response from the specified system before timing out.

Web Service Wait Per Request. Specifies the wait time for Web Service requests in
milliseconds (0-120). Non-zero values disables HTTP persistence.

Generate Variables

Master MOB ID. When checked, specifies the text variable that contains the value of
the master MOB ID for the ingested asset.

Source MOB ID. When checked, specify the text variable that contains the value of the
Source MOB ID of the ingested asset, for use in downstream actions. The source MOB ID
can be used to associate a high-res asset that is already in Production Management to
link it to a Vantage/Flip64 proxy with the same MOB ID. The Source ID and Tape name
are needed for Dynamic Relinking.

Tape (Source Package) Name. When checked, specify the text variable that contains
the value of the tape name of the ingested asset, for use in downstream actions. The
Source ID and Tape name are required for Dynamic Relinking.

Output Components

An Output component generates a file in the format specified, utilizing the ingested
input file from the specified system.

- QOutputs

B AAF Container Output Location... Edit Filename...

Output Toolbar Buttons

Up/Down Arrows. Moves the selected output up and down the set, for organization/
readability purposes. Alternatively, use drag-and-drop: select a component and drag it
to its new location in the set.

Plus Sign. Adds another output to this action. Click to select the type of output you
want to add.
Deleting an Output

Delete. To delete an output, click the X icon immediately right of the nickname menu.

Adding and Configuring Outputs

Configure these controls:

Add Outputs. Add (using the Add button - Plus sign button - in the Output component
toolbar) your outputs by format. Add one output for each file you plan to generate.
Output formats include:
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AAF - Create an AAF file of an Avid asset.

Interplay Metadata - A CML file containing the metadata associated with the asset. This
file is intended to make metadata, along with the media files, available to Avid
workflows. Asset restriction information for master clip assets is preserved in Interplay
Metadata outputs.

Note: If you require the metadata file to have an XML extension instead of the default
CML extension, select the output component to display the Container details panel in
the details panel at the bottom. Click on the Browse button on the File Extension
control and create a text variable, supplying the string 'xml’ as the default value. This
causes the file to use an XML extension instead of the default CML extension.

MPEG-4 Reference - A Telestream variant of an MPEG4 Reference file, intended for use in
defining OP-Atom files for transcoding into the intended media file in a downstream
action or workflow. Telestream MPEG-4 Reference files can be played in Switch.

Select the Output Location. Click Output Location and select from these choices:

- Available Vantage Store: Write the file to any available store, selected dynamically at
run-time. Use this option typically when you only have one store, or when you are
going to access and use the file by nickname in a downstream action - a transport or
staging action, for example.

When you display the Vantage Folder Address Book, click the ? icon for more assistance.
For more information on Vantage folder addresses, see the Vantage User Guide or the
Vantage Domain Management Guide.

- Vantage Store/Folder: Write the file to a specific Vantage store or folder. Select from the
list, or click the Browse button to display the Vantage Folder Address Book where you
can create, edit, and manage your Vantage folder addresses.

When you display the Vantage Folder Address Book, click the ? icon for more assistance.
For more information on Vantage folder addresses, see the Vantage User Guide or the
Vantage Domain Management Guide.

- Path: Write the file to a specific Windows file system server and directory. Manually
enter a Windows share (UNC path) or drive letter (not recommended on Vantage arrays)
or click Browse to navigate and select the location. Or, click the green Browse button
and select a variable which supplies the fully-qualified path.

Edit Filename Pattern. Displays the Filename Pattern Editor so that you can construct
the exact filename pattern you require. Default: Base Name.

Click the insertion point in the text field and use the gear menu to select one or more
tokens or multiple tokens of the same type to insert along with optional, static text
fragments for the filename you are creating. You must specify a file extension. Drag
tokens to re-arrange them; to delete a token, select and press Delete or right-click and
select Delete.

Tokens:
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- Base Name: Adds the Base Name (the portion of the filename excluding the period
and the extension) of the input source file output filename to the output filename.

- Variable: Adds the value of the specified variable to the output filename. The Variable
token is replaced by the value it holds when the action executes. The variable should be
set prior to execution of this action. For example, if a Variable token named /SC/ is given
the value 12H4 JA 678, wherever the ISCl variable token exists in the filename pattern
it is replaced with 12H4JA678.

- Date: Adds the date to the filename. Right-click the down-arrow to select the date
format.

- Time: Select to add the time to the filename. Right-click the down-arrow to select the
time format.

Select the Media Nickname. Click the menu to select the nickname (or enter it
manually) for this new file.

Specify the Container File Extension. Select the output panel and specify the file
extension for the selected wrapper, at the base of the right panel.
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Retrieve Action

The Retrieve action receives an AVID Interplay asset’s master MOB ID. It retrieves the
assets identified by the MOB ID from the target Interplay system, and generates a
Telestream MP4 reference file as the primary output. The Retrieve action can not
process an asset if it is in an Offline or partially Online state, because Vantage can not
create an MP4 Reference with missing Avid OP Atom media.

Retrieve actions are executed by the Vantage Avid Service.

Workflows using a Retrieve action may start with a Receive origin action configured
with a variable to enable it to receive the MOB ID - from an API-based external system, a
Forward action in another workflow, a Workflow origin action, or a manual job
submission in Workflow Designer.

The Retrieve action is designed as a same-as-source-converter, assembling media as
quickly as possible for processing (typically production transcoding and related tasks)
by downstream actions or other workflows. The Retrieve action can not process assets
that are sequences or subclips.

Typical workflow functionality involves transcoding the MP4 file downstream in Flip64
or other transcoding action to produce the desired output format. Metadata and AAF
are optional output files that are delivered as attachments.

Before this action can be used in a workflow, you may configure your Vantage domain
for the MediaCentral | Production system(s) you are using. See Adding a MediaCentral |
Production Management System to Vantage, below, for details. Alternatively, you can
define the target Interplay directly in the action.

Topics
m MP4 File Generation
m Adding MediaCentral | Production Management Connections to Vantage

m Configuration Details

Note: Controls with a green Browse button may be bound to a variable to
dynamically assign their setting or value. The variable must have a value when this
action executes. You can assign the value to the variable in a previous action in the
workflow or use the variable's default value. Click Browse to select the variable or
create a new one.

MP4 File Generation

The Retrieve action creates a Telestream proprietary MP4 file that references MXF OP-
Atom files located on Avid shared storage for the asset and may also include additional
transcoded media. The file also includes VANC data extracted from the Interplay asset's
data track. In addition, a metadata XML file containing the Interplay asset's metadata
may be generated. The MP4 reference file (and XML metadata file and AAF file if
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present) may be passed to downstream actions in the workflow or to other workflows
for transcoding and metadata extraction.

Any system processing these MP4 files must have fully-authenticated access to the
media files located in the Avid shared storage (ISIS/NEXIS).

MP4 files generated by the Retrieve action contain Telestream-proprietary extensions
and are primarily for utilization within the Telestream ecosystem. Therefore, the
following requirements apply:

- Vantage Flip64 actions processing these files must use the Auto decoder.

- For playback, Switch 4.0 or later is required and processes closed captions including
other metadata in these files.

Adding MediaCentral | Production Management
Connections to Vantage

VT
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To identify the target Interplay system, you can define it directly in the Retrieve action
or you may add and configure an Interplay connection in your Vantage domain to
communicate with each MediaCentral | Production Management system you are
interacting with.

Note: The systems displayed in the Retrieve action Interplay Configuration menu are
those that have been added to Vantage via the Vantage Management Console.

To add an Interplay connection to Vantage and configure and test it, follow these steps:
1. Start the Vantage Management Console.
2, In Settings & Options, display the Interplay tab.

Vantage displays the Interplay configuration panel where you create, configure,
delete, import and export MediaCentral | Production Management system connec-
tions.

3. Create and configure a connection to the target system, providing the following
information:

- Connection Name

- Interplay Web Services Host
- Interplay Web Services Port
- Interplay Workgroup

- Interplay Username

- Interplay Password

For more details on configuring and managing connections, click the ? icon to dis-
play the topic in the Vantage Domain Management Guide.
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4. Click Test to confirm that Vantage can access the target MediaCentral | Production
Management server. If you have problems, determine the issue and retry.

Interplay Configuration: Interplay v

Output media file nickname: {7} v Edit Filename Pattern...

-~ General

Mob Id:

Configuration Details

Interplay Configuration

Interplay Configuration. Specifies Interplay | <<Specific user-specified Interplay
systems>>. The specific Interplay systems menu items are dynamically generated from
the MediaCentral | Production systems identified in the Vantage Management Console.
See Adding MediaCentral | Production Management Systems to Vantage (above) for
details.

Note: When you select a pre-defined Interplay system, the Interplay Definition panel
(directly below the General panel) is hidden. If you select Interplay, the Interplay
Definition panel displays and must be configured to identify the target system.

Configuring Output Media File Settings

Output Media File Nickname. Specifies the nickname associated with the MP4 output
file for use in downstream actions.

Edit Filename Pattern. Opens the Filename Pattern Editor. Enter the complete
filename or a portion of the filename, and use the menu on the right side to select one
or more tokens to insert to create the exact filename pattern you require. You can drag
and drop a token to change its order relative to other tokens, thus changing its location
in the filename. Use the following tokens:

- Base Name.The name of the file, without the extension.
- Variable. You select the variable to use.

The Variable token is replaced by the value it holds when the action executes. The
variable should be set prior to execution of this action. For example, if a variable token
ISClis given the value 12H4JA678, wherever the ISCl variable token appears in the
filename pattern it is replaced with that value.

- Date. The current date at the time the filename is constructed. Change the date
format using the menu.

- Time. The current time at the time the filename is constructed. Change the time
format using the menu.
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General Settings

Mob ID. Specifies the Mob ID associated with the Avid asset registered in the specified
Interplay system.

Interplay Definition
¥ General
4 Interplay Definition

Interplay Web Services Host:

-~

Interplay Web Services Port: 80 v 1-65535 -

Interplay Workgroup:

Note: This set of controls is only displayed when you select Interplay from the
Interplay Configuration menu, to provide the target system directly in the action. If
you select an Interplay system that you have defined in the Vantage Management
Console, this panel is not displayed.

Interplay Web Services Host. The DNS/IP address of the Interplay Web Services server.

Interplay Web Services Port. The port being utilized by the Interplay Web Services
server.

Interplay Workgroup. Name of workgroup (case-sensitive) associated with this
Interplay system.

Interplay Username. Authorized user name.

Interplay Password. Authorized password.

Output Interplay Metadata

Configure these controls to generate a separate metadata XML file containing CML, as
an attachment file for use downstream or separately. In Vantage, you can use the
Extract action to access the AVID assets metadata in these files.

The metadata CML file contains the MXF file paths, Avid User properties - Name/Value
string pairs, Avid Interplay Frame Locators, Avid Asset Restrictions (Copyright
information, TV rating, etc.).

= Output Interplay Metadata Enable W

Metadata File: | Specify the output:

File nickname:

® File name:

Overwrite Existing Metadata File -
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Output Interplay Metadata. Specify Enable to generate an optional metadata file in
XML format and supply a nickname or fully-qualified filename.

File Nickname. Select File nickname to identify the file by nickname.

File Name. Manually enter or browse and select the fully-qualified path to the XML
metadata file. The destination must be writable by the Vantage Avid Service.

Overwrite Existing Metadata File. When checked, write the new file out to the
destination, overwriting the existing file (if it is writable) without warning. If unchecked
and the file exists, the job fails at the start of the job when user configuration is
validated.

Output AAF

Configure these controls to generate a separate AAF file, as an attachment file for use
downstream or separately.

-~ Qutput AAF  Enable W

AAF File: | Specify the output:

File nickname:

@ File name:

Overwrite Existing AAF File =

Output AAF. Specify Enable to generate an optional AAF file and supply a nickname or
fully-qualified filename.

File Nickname. Select File nickname to identify the file by nickname.
File Name. Manually enter or browse and select the fully-qualified path to the AAF file.

Overwrite Existing AAF File. Check to silently overwrite the existing output file
without warning. If unchecked and the file exists, the job fails at the start of the job
when user configuration is validated.

Override Output Path

Configure these controls to override the default output path for the MP4 Reference file,
for use downstream or separately.

=« Override Output Path  Enable ¥

Output Asset Path:

Create Unique Folder =

Ovenwrite Existing Output File -

Override Output Path. Specify Enable to override the default MP4 location (Vantage
store) and supply a fully-qualified filename. When disabled, the location is the default
Vantage store.
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Output Asset Path. Manually enter or browse and select the fully-qualified path to the
MP4 reference file. The destination must be writable by the Vantage Avid Service.

Create Unique Folder. Specify Enable to generate a folder in the path, and write the
file to the new folder. The subfolder is named with a randomly generated GUID.

Overwrite Existing Output File. Check to silently overwrite the existing output file
without warning. If unchecked and the file exists, the job fails at the start of the job
when user configuration is validated.
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Media Creation Action

Media Creation actions are executed by the Vantage Avid Service.

Vantage Avid Service log files (avid.trace) are written to the C:\Program Files
(x86)\Telestream\Vantage\Avid directory on the server where the Vantage Avid Service
that executed the action is hosted. Update the config file to write log files per your
requirements.

The Media Creation action enables you to create single and multi-resolution assets for
use in a Media Composer or a MediaCentral | Production Management system. The
Media Creation action operates in two modes: Media Composer mode and Production
mode. Your first configuration task is to choose the mode from the Interplay
Configuration menu at the top of the configuration details panel.

Note: You can select Interplay and configure the target system directly in the action.
Or, you can identify one or more Media Central | Production Management systems in
the Vantage Management Console - Workflow Designer automatically displays these
systems by name in the same menu. This enables you to choose the target
MediaCentral | Production Management system from the menu, avoiding repeated
manual configuration.

- Media Composer Mode: Select Media Composer to create Avid-compatible MXF OP-
Atom files including metadata for ingest into a Media Composer editor. Media
Composer is not required to be part of a MediaCentral | Production Management
infrastructure.

- Interplay Mode: Select Interplay Mode | Pre-defined MediaCentral | Production
Management System (see Adding MediaCentral | Production Management Systems to
Vantage, below) to create Avid MXF OP-Atom files and metadata written to ISIS/NEXIS
storage and automatically checked into a MediaCentral | Production Management
system. Specific systems may be identified in the Vantage Management Console and
selected from the menu.

When delivering media directly to a MediaCentral | Production Management system,
assets include integrated User Property and Headframe creation. Locator metadata can
also be created; use a Notify action for delivery along with the Avid Production Web
Service check-in into an Avid MediaCentral | Production Management workspace.

You can also create files for ingest into Media Composer in Open mode for Frame Chase
editing; metadata insertion is supported while live video is being captured and the file
is being processed in Vantage, enabling real-time editing.

Note: The Media Creation action does not perform transcoding. Files are re-wrapped
into Avid-compatible MXF OP Atom AAF files. Therefore, the video must already be
processed if required, with a supported codec. The Media Creation action supports a
number of popular file formats. Consult the Generating and Ingesting Avid-
Compatible MXF OP-Atom Media chapter in the Avid Integration Guide for the list.

Ty
Avid Integration Guide telestream



216

Vantage Actions for Avid Media Processing
Media Creation Action

If the video in the file you want to add/update is not in a supported format, it should
first be processed through a Flip64 action to produce MXF OP1a media containing
video in the proper format.

This action is Open workflow capable. It requires an Open Workflows license; right-click
the action and select Workflow Mode > Open. Open Workflows must also be enabled
for the workflow and at the domain level, in Vantage Management Console > Settings.

Note: Controls with a green Browse button may be bound to a variable to
dynamically assign their setting or value. The variable must have a value when this
action executes. You can assign the value to the variable in a previous action in the
workflow or use the variable's default value. Click Browse to select the variable or
create a new one.

Accessing a MediaCentral | Production Management System

Prior to designing and implementing Avid workflows in Vantage to access
MediaCentral | Production systems, you (the customer or Avid representative) must
identify each system, including credentials.

Use these specifications to define Avid connections in the Vantage Domain Console for
use in Media Creation, Retrieve, and Asset Monitor workflows, or define them statically
or dynamically via variables, directly in your workflows.

Retrieve, Asset Monitor, and Media Creation actions are configured to interact with a
specific MediaCentral | Production Management system. System configuration may be
manual—statically specifying a system which does not change on a job-by-job basis.

System identification can also be dynamic, where you can use variables to identify the
system dynamically for each job you execute. This is preferable when you may be
accessing one of many Avid systems in a single workflow, based on run-time metrics.
Dynamic, variable-driven workflows often simplify workflow design and utilization.

Note: Always connect to MediaCentral | Production Management and Avid
Production Web Services using a fully-qualified DNS name, which is registered with
Forward and Reverse look up tables in DNS.

Note: Specific Avid systems that display in the Interplay Configuration menu are
connections that have been configured in Vantage via the Management Console. For
full details, see the Avid Integration Guide > Accessing MediaCentral | Production
Management Systems.

To add a MediaCentral | Production connection to Vantage, follow these steps:

1. In the Vantage Management Console, in Settings & Options, display the Avid tab.
The configuration panel enables you to create, configure, delete, import and export
MediaCentral | Production Management system connections.
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2. Create and configure a connection to the target system, providing the following
information:

- Name (displays as a menu item in the action's Interplay Configuration menu)
- Web Services Host (enter the IP address | DNS name)

- Interplay Web Services Port

- Production Workgroup

- Production Username

- Production Password

For more details on configuring and managing connections, click the ? icon to dis-
play the topic in the Vantage Domain Management Guide.

3. Click Test to confirm that Vantage can access the target MediaCentral | Production
Management server. If you have problems, determine the issue and retry.

Action Configuration Details

Input (Left Panel)
Select. Specifies Auto | AIFF | MXF OP1a | TIFO | Wave.
- Auto: Ingest media which is in a video/audio format supported by your Media

Composer/MediaCentral | Production system for re-wrapping into Avid-compatible
MXF OP-Atom files.

- AIFF: Ingest media from an AIFF input file for re-wrapping into Avid-compatible MXF
OP-Atom files.

- MXF OP1a:To process Open MXF OP1a files. For other supported file formats, select
Auto or TIFO.

Note: The MXF OP1a decoder supports open workflows only for files being created
by Lightspeed Live Capture and Flip64.

- TIFO: To capture video in open workflow mode in TIFO format for re-wrapping into
Avid-compatible MXF OP-Atom files. TIFO input is Open Workflow capable.

- Wave: To ingest media from a WAVE input file for re-wrapping into Avid-compatible
MXF OP-Atom files. Each Wave input supports one-channel-per audio track(s). This
input component should only be utilized when you are processing WAVE files.
Submitting non WAVE files to this input will result in job failures. For other supported
file formats select Auto, MXF OP1a or TIFO.

Interplay Configuration Mode

Production Configuration. Specifies Media Composer | Interplay | <<Avid System
connections identified in the Management Console>>. There may be zero or more
connections in the menu, depending on the connections you've created. The
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connections below the Media Composer | Interplay menu items are dynamically
generated from the MediaCentral | Production systems identified in the Vantage
Management Console. See Adding MediaCentral | Production Management Systems to
Vantage (above) for details.

- Media Composer. Select to write AAF files to a specific location, and configure the
Media Creation action to facilitate Media Composer ingest and use of the files.

- Interplay: A workflow-specified MediaCentral | Production Management system.

- <<Avid System connections identified in the Management Console>>. There may be
zero or more connections in the menu, depending on the connections you've created.
The list is dynamically generated from the MediaCentral | Production connections
identified in the Vantage domain. See Adding a MediaCentral | Production Management
System to Vantage (above) for details.

Configuring Output Media File Settings

Output Media File Nickname. Specifies the nickname for the output file for use in
downstream actions.

Edit Filename Pattern. Opens the Filename Pattern Editor. Enter the complete
filename or a portion of the filename, and use the menu on the right side to select one
or more tokens to insert to create the exact filename pattern you require. You can drag
and drop a token to change its order relative to other tokens, thus changing its location
in the filename.

You can use the following tokens:
- Base Name. The name of the file, without the extension.
- Variable. You select the variable to use.

The Variable token is replaced by the value it holds when the action executes. The
variable should be set prior to execution of this action. For example, if a variable token
ISClis given the value 128472678, wherever the ISCl variable token is located in the
filename pattern, it is replaced with that value.

- Date. The current date at the time the filename is constructed. Change the date
format via the menu.

- Time. The current time at the time the filename is constructed. Change the time
format via the menu.
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Media Creation Action Input Components

The Media Creation action can ingest and process these file formats:

AIFF Input

The AIFF Input component re-wraps media into Avid-compatible MXF OP-Atom files.
AIFF Input supports one-channel-per audio track(s). When using a Media Creation
action with AIFF Input, it is not Open workflow capable.

Note: Controls with a green Browse button may be bound to a variable to
dynamically assign their value. The variable must have a value when this action
executes. You can assign the value in a previous action in the workflow or use the
variable's default value. Click Browse to select the variable or create a new one.

Input Toolbar Buttons

Gear > Convert To. Changes the input from one type to another. Alternatively, right-
click and select the format from the list. This saves you the effort of re-configuring an
input when you just want to change the input container/format.

Delete. To delete this input, click the X icon in the upper right corner.

Input Configuration

Source. Click Select to display the input source dialog and specify the file to process, by
nickname or by a unique file name. You can only use an input nickname one timein a
given action.

To attach a file by nickname (which is typical), select the nickname of the file from the
menu. The file must have been ingested or created by an upstream action in the
workflow.

To attach a file by file name, manually enter the fully-qualified path and file name, click
Browse to navigate and select the file (which may not yet exist in the directory, so you
must manually enter the file name), or click Browse to select a variable which has been
created in an upstream action and contains the fully-qualified path to the file.

Container Settings

Start Timecode Option. Specifies the edit rate to use. The edit rate is required for
proper timecode calculations in Media Composer projects.
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Auto Input

The Auto Input, as implemented for the Media Creation action, ingests media which is
in a video/audio format supported by your Avid Media Composer/MediaCentral |
Production Management system for re-wrapping into Avid-compatible MXF OP-Atom
files. This is the default input component for the Media Creation action.

There are no user-configurable options for this decoder.

Note: Auto Input supports one video track. Audio must contain one track per channel
otherwise the job will fail.

Note: Controls with a green Browse button may be bound to a variable to
dynamically assign their value. The variable must have a value when this action
executes. You can assign the value in a previous action in the workflow or use the
variable's default value. Click Browse to select the variable or create a new one.

Input Toolbar Buttons

Gear > Convert To. Changes the input from one type to another. Alternatively, right-
click and select the format from the list. This saves you the effort of re-configuring an
input when you just want to change the input container/format.

Delete. To delete this input, click the Xicon in the upper right corner.

Input Configuration

Source. Click Select to display the input source dialog and specify the file to process, by
nickname or by a unique file name. You can only use an input nickname one timein a
given action.

To attach a file by nickname (which is typical), select the nickname of the file from the
menu. The file must have been ingested or created by an upstream action in the
workflow.

To attach a file by file name, manually enter the fully-qualified path and file name, click
Browse to navigate and select the file (which may not yet exist in the directory, so you
must manually enter the file name), or click Browse to select a variable which has been
created in an upstream action and contains the fully-qualified path to the file.

Configuring Media Trim Settings

This feature allows the user to select just the portion of a media file they need by
setting a start and end time in the Media Creation action and then check it into their
Avid Production environment.
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To access the Media Trim feature, select the input in the upper left hand corner of the
Media Creation action Ul. Then, in the bottom right hand corner of the Ul, select Enable
to reveal the Media Trim controls.

Media start time (inclusive). Set the desired starting point of the media file to keep.
Media prior to the start time is trimmed.

Media end time (exclusive). Set the desired end point of the media file to keep. All
subsequent frames of the file are trimmed.

Use source media video timing. When selected, the start and end times are based on
the container-level start timecode of the media. When unselected, the start and end
timecodes assume that the first frame of the video has a timecode of 00:00:00:00.

MXF OP1a Input

The MXF OP1a Input component re-wraps media into Avid-compatible AAF/MXF OP-
Atom files. Each MXF OP1a Input supports one video stream and one or more PCM
audio tracks, plus an ANC stream.

MXF OP1a Input is Open workflow capable. The MXF OP1a decoder supports open
workflows, but only with MXF OP1A or TIFO files created by Live Capture and Flip64
actions. When Input Type is set to WAVE/AIFF/Auto, open mode is not supported.

Note: Controls with a green Browse button may be bound to a variable to
dynamically assign their value. The variable must have a value when this action
executes. You can assign the value in a previous action in the workflow or use the
variable's default value. Click Browse to select the variable or create a new one.

Input Toolbar Buttons

Gear > Convert To. Changes the input from one type to another. Alternatively, right-
click and select the format from the list. This saves you the effort of re-configuring an
input when you just want to change the input container/format.

Delete. To delete this input, click the X icon in the upper right corner.

Input Configuration

Source. Click Select to display the input source dialog and specify the file to process, by
nickname or by a unique file name. You can only use an input nickname one timein a
given action.

To attach a file by nickname (which is typical), select the nickname of the file from the
menu. The file must have been ingested or created by an upstream action in the
workflow.
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To attach a file by file name, manually enter the fully-qualified path and file name, click
Browse to navigate and select the file (which may not yet exist in the directory, so you
must manually enter the file name), or click Browse to select a variable which has been
created in an upstream action and contains the fully-qualified path to the file.

Container Settings

Open File Support. When checked, the workflow starts transcoding this stream as
soon as the file is opened and media is being written to it in real time. Input supports
one video track. Audio must contain one track per channel otherwise the job will fail.

Open File Timeout. Specifies the maximum amount of time in seconds to wait after
the file has stopped growing before assuming that file is finished being written to and
has been closed.

Process Origin as Precharge. Specifies processing of MXF origin as Precharge Frames.

Max Invalid Key Count. Specifies the maximum number of random, failed read
operations when ingesting a file from NAS. Set the value to the maximum value to
prevent premature termination of Media Creation jobs.

Cache Size. Specifies (in bytes) the stream cache buffer size. Should be set to a
practical, non-zero value in Open workflows, when Flip64 or another Vantage action is
writing to a Network Attached Storage (NAS) and the Media Creation action running on
a separate Vantage node is reading the file, to enable buffered reads when reading
from NAS.

Cache Count. Specifies the number of stream cache buffers to create. Should be set to
a practical, non-zero value in Open workflows, when Flip64 or another Vantage action is
writing to a Network Attached Storage (NAS) and the Media Creation action running on
a separate Vantage node is reading the file, to enable buffered reads when reading
from NAS.

Configuring Media Trim Settings

This feature allows the user to select just the portion of a media file they need by
setting a start and end time in the Media Creation action and then check it into their
Avid Production environment.

To access the Media Trim feature, select the input in the upper left hand corner of the
Media Creation action Ul. Then, in the bottom right hand corner of the Ul, select Enable
to reveal the Media Trim controls.

Media start time (inclusive). Set the desired starting point of the media file to keep.
Media prior to the start time is trimmed.

Media end time (exclusive). Set the desired end point of the media file to keep. All
subsequent frames of the file are trimmed.
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Use source media video timing. When selected, the start and end times are based on
the container-level start timecode of the media. When unselected, the start and end
timecodes assume that the first frame of the video has a timecode of 00:00:00:00.

TIFO Input

The TIFO Input component implemented in the Media Creation action supports
capturing media in TIFO format for re-wrapping into Avid-compatible AAF/MXF OP-
Atom files.

TIFO Input is Open workflow capable. The MXF OP1a decoder supports open
workflows, but only with MXF OP1A or TIFO files created by Live Capture and Flip64
actions. When Input Type is set to WAVE/AIFF/Auto, open mode is not supported.

TIFO format is required for Avid classic proxies. Specification of Avid Picture Essence
Coding Type is also supported. See Specifying Avid Picture Essence Coding Type in Media
Creation. See Specifying Avid the Picture Essence Coding Type in the Avid Integration
Guide.

Note: TIFO Input supports one video track. Audio must contain one track per channel
otherwise the job will fail.

Note: Controls with a green Browse button may be bound to a variable to
dynamically assign their value. The variable must have a value when this action
executes. You can assign the value in a previous action in the workflow or use the
variable's default value. Click Browse to select the variable or create a new one.

Input Toolbar Buttons

Gear > Convert To. Changes the input from one type to another. Alternatively, right-
click and select the format from the list. This saves you the effort of re-configuring an
input when you just want to change the input container/format.

Delete. To delete this input, click the Xicon in the upper right corner.

Input Configuration

Source. Click Select to display the input source dialog and specify the file to process,
by nickname or by a unique file name. You can only use an input nickname one time in
a given action.

To attach a file by nickname (which is typical), select the nickname of the file from the
menu. The file must have been ingested or created by an upstream action in the
workflow.
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To attach a file by file name, manually enter the fully-qualified path and file name, click
Browse to navigate and select the file (which may not yet exist in the directory, so you
must manually enter the file name), or click Browse to select a variable which has been
created in an upstream action and contains the fully-qualified path to the file.

Container Settings

Open File Support. Check to enable Open File support, indicating that you want to
start processing this stream as soon as the file is created and media is being written to it
in real time.

Open File Timeout. Specifies the maximum amount of time to wait after the file has
stopped growing before assuming that file is finished being written to and has been
closed.

Avid Picture Essence Coding Type

Set Avid Picture Essence Coding Type. Specify coding type for creation of Avid proxy
formats. Default is Auto.

Cache Size. Specifies (in bytes) the stream cache buffer size. Should be set to a
practical, non-zero value in Open workflows, when Flip64 or another Vantage action is
writing to a Network Attached Storage (NAS) and the Media Creation action running on
a separate Vantage node is reading the file, to enable buffered reads when reading
from NAS.

Cache Count. Specifies the number of stream cache buffers to create. Should be set to
a practical, non-zero value in Open workflows, when Flip64 or another Vantage action is
writing to a Network Attached Storage (NAS) and the Media Creation action running on
a separate Vantage node is reading the file, to enable buffered reads when reading
from NAS.

Note: For AVCI 50, AVCI 100, XAVCI 50, XAVCI 100 formats, sets the MXF descriptor for
compliance.

Configuring Media Trim Settings

This feature allows the user to select just the portion of a media file they need by
setting a start and end time in the Media Creation action and then check it into their
Avid Production environment.

To access the Media Trim feature, select the input in the upper left hand corner of the
Media Creation action Ul. Then, in the bottom right hand corner of the Ul, select Enable
to reveal the Media Trim controls.

Media start time (inclusive). Set the desired starting point of the media file to keep.
Media prior to the start time is trimmed.

Media end time (exclusive). Set the desired end point of the media file to keep. All
subsequent frames of the file are trimmed.
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Use source media video timing. When selected, the start and end times are based on
the container-level start timecode of the media. When unselected, the start and end
timecodes assume that the first frame of the video has a timecode of 00:00:00:00.

Wave Input

The Wave Input component re-wraps media into Avid-compatible MXF OP-Atom files.
Each Wave Input supports one-channel-per audio track(s). Avid MXF output has one
track per channel. The input WAVE file may have multiple channels per track.

Wave Input is not Open workflow capable.

Note: Controls with a green Browse button may be bound to a variable to
dynamically assign their value. The variable must have a value when this action
executes. You can assign the value in a previous action in the workflow or use the
variable's default value. Click Browse to select the variable or create a new one.

Input Toolbar Buttons

Gear > Convert To. Changes the input from one type to another. Alternatively, right-
click and select the format from the list. This saves you the effort of re-configuring an
input when you just want to change the input container/format.

Delete. To delete this input, click the X icon in the upper right corner.

Input Configuration

Source. Click Select to display the input source dialog and specify the file to process, by
nickname or by a unique file name. You can only use an input nickname one timein a
given action.

To attach a file by nickname (which is typical), select the nickname of the file from the
menu. The file must have been ingested or created by an upstream action in the
workflow.

To attach a file by file name, manually enter the fully-qualified path and file name, click
Browse to navigate and select the file (which may not yet exist in the directory, so you
must manually enter the file name), or click Browse to select a variable which has been
created in an upstream action and contains the fully-qualified path to the file.

Container Settings

Start Timecode Option. Specify start timecode to use.

Start Timecode Option. Specifies the edit rate to use. The edit rate is required for
proper timecode calculations in Media Composer projects.
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Note: Audio-only Wave outputs may have frame rates which are incorrectly
identified in Interplay Access. These include:

- 60 fps NDF/DF identified as 59.94 FPS

- 30 fps NDF/DF identified as 29.97 FPS

- 48 fps NDF/DF identified with no FPS value

- 47.95 fps NDF/DF identified with no FPS value

Configuring Output for Media Composer

Media Creation Settings

Use the following panels to configure the Media Creation for your workflow:

Physical File Settings
A e e
AAF File Location:
MXF File Location:
Delete AAF Subdirectory and Temporary Files

Create Unique Folder for AAF  —

4 Physical Directory Control | Limit Files per Directory ¥

Max Number of Files in MXF Directory: 5000 % files -

~ Copy AAF File | Enable ¥

AAF Copy Directory:

Overwrite Existing AAF File -

AAF File Location. Specifies the UNC path to Avid storage where the AAF file will be
written. The typical pattern is \\<servername>\<workgroup folder>\<filename>. For
example: \\avidnexispro\Interplay2021\AAF\AAF Filel.aaf.

MXF File Location. UNC path to Avid storage where the MXF OP-Atom media files will
be written. The typical pattern is \\servername\workgroup folder\Avid
MediaFiles\MXF\file. For example: \\avidnexispro\Interplay2021\Avid
MediaFiles\MXF\MXF Filel.mxf.

Note: Initial MXF path name must include the \Avid MediaFiles\MXF\ string.
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Delete AAF Sub-directory and Temporary Files. When checked, deletes the AAF files
and temporary files after the media has been checked into Interplay. These files are not
deleted if the job fails.

Create Unique Folder for AAF. When checked, creates a unique directory folder for the
output AAF file.

Physical Directory Control. Specifies Limit Files per Directory | Do Not Limit Files per
Directory.

- Limit Files per Directory: When Limit Files per Directory is selected, update the Max
Number of MXF Files in MXF Directory field to specify the maximum number of files.
When the maximum is reached, the action creates a new directory with a numerical
suffix (<dirname>.1, etc.) to store the next set of files. Range: 100 - 10,000. Default:
5,000.

- Do Not Limit Files per Directory: When Do Not Limit Files per Directory is selected, there
is no maximum.

Copy AAF File. Specifies Enable | Disable:
- Enable: Specifies the AAF Copy Directory and option to Overwrite Existing AAF File.

AAF Copy Directory. Browse to select or manually enter the fully-qualified folder
path.

Overwrite Existing AAF File. Check to overwrite an existing file of the same name
in the target copy directory; uncheck to fail the action.

- Disable: Do not copy the AAF file. Local AAF file is temporary and disposed of per
Vantage settings.

Note: If Overwrite Existing File is unchecked and a file with the same name exists in
the destination directory, the job fails.
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Asset Attributes

~  Asset Attributes

Master MOB ID:
Source MOB ID:
Disable Data Track in the Output -

~ Material Name Override W

Material Name:

-~ Timecode Overnde Timecode ¥

Override Timecode: 00 : 00 : 00 : 00 c 2997 W fps -

4 Input Type Tape W

Tape Name:

Master MOB ID. Specifies the master MOB ID for this asset.
Source MOB ID. Specifies the source MOB ID for this asset.

Disable Data Track in the Output. When checked, disables creation of a data track in
the output.

Material Name. Specify Use Media Name | Override. This name displays as the asset's
display name unless a non-empty tape name is configured.

- Use Media Name. Input media name is used to configure the asset name.

- Override. Overrides default asset name with the user specified value. When selected,
complete this control:

Material Name. Specifies the name to use for the asset.

Note: To change the AAF folder name and filename use the Filename Pattern Editor
to change the naming scheme.

Timecode

If the transcoded source uses drop frame timecode then output is drop frame. If
transcoded source is non-drop frame then output is non-drop frame.

Timecode. Specifies timecode to use: Use Source Timecode | Override Timecode.
- Use Source Timecode. Uses the source timecode detected in the media.

- Override Timecode. Timecode detected in source file is used with no changes to the
timecode in the output. When selected, provide:

Override Timecode. Specify the timecode, frame rate, and drop frame or non-drop
frame notation to use.
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Input Type

Both Tape Name and Source Package Name values change the first 9 characters of the
MXF output filenames and add metadata to Access and Media Composer in the tape
name field (no character limit). If values are entered, this overrides the name set in the
Filename Pattern Editor.

Dynamic Relinking: Avid uses the input descriptor information to check whether one of
the two media are proxies or can be dynamically relinked. In the case of Dynamic
Relinking using 2 Media Creation actions (1 high-res, the other proxy) the input
descriptors (Tape Name/Source Package Name values) must be the same. This is best
achieved by using a variable.

Naming Tapes: Tape names must be alphanumeric characters (A - Z, 0 - 9) and include
uppercase and lowercase characters. Select a case convention and maintain it
throughout a project.

Guidelines for MultiRez Tape Management: When working in a MultiRez workflow, it is
important to name tapes properly. In particular, you should keep the following in mind:

Whenever you create a new tape, Media Composer generates a new source ID, even if
the name you type for the new tape exactly matches that of an existing tape. You
cannot dynamically relink media that does not share a source ID.

Do not use the same name for two different tapes or different names for the same tape.
This might cause incorrect media association. Do not use the default tape name New
Tape.

Input Type. Specifies input type: Tape | Import. Default: Import.

Tape: Select when media is tape-based, and specify the optional tape name of the
asset.

Note: Avid does not support ingesting media define as Tape for 4K media - the asset
displays as offline. Additionally, media with a non-zero timecode greater than 26
seconds also displays as offline.

Tape Name. When Input Type is Tape, optionally specify the asset tape name.

Import: When media is digital (disk-based), specifies the asset source package
name.

Note: While Avid strongly recommends using Import mode for file-based digital
media workflows, this method does not permit the Tape name field to be used for
relinking. Tape mode should be used for traditional dynamic relinking using the Tape
field.

Tape name data replaces the Asset Name set in the Vantage Filename Pattern Editor
when not empty. To configure the Asset Name you must configure a User Property
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with the property name Display Name along with the desired value. Consult the Avid
Integration Guide for more details.

Source Package Name. When Input Type is Import, specifies the optional source
package name of the asset.

Asset Tag Properties

~ Asset Tag Properties

~ Tagged Values Enable w

~ [V Import Tagged Values

Tagged Values: | gpecify the input source:

File nickname:

@ File name:

~ [V Set Tagged Values

Add New ltem

Tagged Values. Specifies Disable | Enable. When enabled, allows specification by
filename or file nickname of an XML file containing tagged values for an asset.

Import Tagged Values. When checked, allows specification by filename or file
nickname of an XML file containing tagged values for an asset.

File Nickname. Select File nickname to identify the file by nickname.

File Name. Manually enter or browse and select the fully-qualified path to the
XML file.

Set Tagged Values. When checked, allows specification of tagged value pairs that
are displayed in the Media Composer bin. Click Add New Item and configure pairs.
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Each tagged value pair item contains metadata fields for the name and associated
value for the tagged pair.

-« Processor Configuration

Hang Detection Interval: ) & milliseconds -

Flush Peniod: 0 : milliseconds ~
-~

Progress Report Interval: 100,000 < milliseconds -

« |0 Performance Tuning Custom W

Video Essence File System 10 Page Size: v 512Bytes ~

Audio Essence File System IO Page Size: v~ S512Bytes -~

Data Essence File System 10 Page Size: 072 512Bytes -
Video Essence File System IO Page Count: ¢
Audio Essence File System IO Page Count: 4

Data Essence File System 10 Page Count: ¢

AAF Updates

-~ AAF Updates

AAF Update Interval: 0 v milliseconds -

Expected Maximum Duration: 21600 % seconds@60fps -

V| AAF Path: [ v Path variable to generate

AAF Update Interval. An AAF file, updated progressively, is made available for
importing into Media Composer for editing, at the beginning of media capture.
Specifies optional local AAF update interval time in milliseconds. Default is 0 (disabled).

Expected Maximum Duration. Expected duration in seconds, rationalized for 60 fps.

AAF Path

AAF Path. When checked, specifies the Path variable for use by downstream actions.
Typically this is used in Open workflows to provide an intermediate AAF path while
media files are still growing. The variable is set from the AAF action from the Input >
Source > File name field.
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Configuring Output for Interplay (MediaCentral |
Production Management)

Media Creation Settings

Interplay Definition
4 Interplay Definition

Interplay Web Services Host:

Interplay Web Services Port 80 $ 165535 -

Interplay Workgroup:
Interplay Usemname:

Interplay Password:

Note: This set of controls is only displayed when you select Interplay and must
provide the target system directly in the action. If you select an Interplay system that
you have defined in the Vantage Management Console, these controls are not used.

Interplay Web Services Host. The DNS/IP address of the Interplay Web Services server.

Interplay Web Services Port. The port being utilized by the Interplay Web Services
server.

Interplay Workgroup. Name of workgroup (case-sensitive) associated with this
Interplay system.

Interplay Username. Authorized user name.

Interplay Password. Authorized password.

Interplay Settings

« Media Creation Settings

4 Interplay Settings

Interplay Folder. Specifies the MediaCentral | Production Management virtual folder
path to be used for the output asset for example \Incoming Media\Media
Creation\New Folder or /Incoming Media/.You may entera known path;
browse to an existing folder path; or bind to a folder path variable.

Create Interplay Folder Path. When enabled, creates the Production virtual folder(s)
that do not exist in the configured Interplay Folder path. When not enabled, the job
fails if the Interplay folder path does not exist.

These top-level system directories in Production can't be modified Catalogs

- Incoming Media
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- Orphan Clips

- Projects

- Send To Playback

- Unchecked-In Avid Assets

Note: These special characters are not allowed in folder names 7 : /\" < > |

Frame Chase Editing. Specified Enable | Disable. When enabled, creates a special type
of Production asset, that can be edited while media ingest is in progress. The growing
asset is available in the Production system, as soon as the initial check-in occurs. When
the media capture ends, a final update is made to the Production system. This update
changes the clip's type from an in-progress clip to a conventional master clip and
updates the metadata. Configure these controls:

4 Frame Chase Editing Enable ¥

Interplay Frame Chase Interval: 20,000 £ milliseconds

Expected Maximum Duration: 21,600 4 seconds@60fps -~

v/ Custom Metadata Management -

Interplay Frame Chase Interval. Specifies the frame chase interval (integer - num-
ber of milliseconds). Growing assets are checked into Production at the end of
every specified frame chase interval.

Expected Maximum Duration. Specifies the expected maximum duration in sec-
onds @60fps that is displayed in Interplay Access and Media Composer while a file
is being processed. Once the file is complete and updated, the duration shows the
actual duration of the file. This applies to both open and closed workflow configu-
rations.

Custom Metadata Management. Enable to allow an Asset Name to be updated in
MediaCentral | Production Management in an Open, Edit-During-Capture (Frame
Chase) Flip64, Lightspeed Live Capture or Tape workflow. Enables Vantage to
update the asset user metadata and the head frame without requiring the use of
the Notify action to generate the MOB ID. For proxy generation in a Flip64 work-
flow, you must use a Notify action to generate MOB IDs. In a Capture/Tape work-
flow, you may use the Capture/Tape action to generate the MOB IDs directly.

Note: For improved Head Frame display performance in Interplay Access, enable
Custom Metadata Management.
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Asset Head Frame. Specifies Enable | Disable. When enabled, allows specification of a
Head Frame source as generated by a Media Creation or Flip64 action. Creation of an
open Head Frame is supported.

4 Asset Head Frame Enable W

4 Asset Head Frame Source Create ¥

= Asset Head Frame Configuration | Specify Frame Number W

Frame Number. 0 ] o

Asset Head Frame Source. Specifies Create | Set. Allows specification of a Head
Frame source using Frame Number or Timecode (Create) or via an Asset Head
Frame file (Set). Configure these controls:
- Create. Specifies Head frame using frame number or timecode (default).
Asset Head Frame Configuration. Specifies Specify Frame Number | Specify
Timecode. Complete these controls as appropriate:
Frame Number. Creates and uses the first I-frame from the specified
frame number in the input video track.
Specify Timecode. Creates and uses the first I-frame from the specified
timecode in the input video track.
- Set. Specifies Head Frame using filename or nickname of the file generated:
File Nickname. Specifies the file by nickname. The file must have been ingested
by an upstream action and assigned a nickname. Use this option when the file
changes for each job.
File Name. Manually enter or browse and select the fully-qualified path to the
file. The Vantage service that executes this action must have access to the file
location. Use this option when you want to assign a static file, which is used for

every job. If you assign a variable, the variable must be assigned the fully-quali-
fied path and file name in an upstream action and the file can change for each

job.
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Interplay Asset Metadata. Specifies Disable | Enable. When enabled, allows metadata
to be added via a file using a (Interplay) Production metadata file or manually using
Add Asset Restrictions, Add Asset Locators, or Add User Properties controls.

“  Interplay Asset Metadata Enable ¥

~ V| Import Metadata

Metadata: Spedify the input source:

File nickname:

@ File name:

~ [V Add Asset Restrictions
Add New ltem

* [V] Add Asset Locators

« [V Add User Properties

Add New ltem

Note: The XML for Avid User Property Metadata and Locators uses a simple structure.
It consists of two Element types: <Entry> for adding Avid User Property data and
<Locator> for adding Avid Locator data. Each Element has several attributes, used to
supply data for the Entry or Locator element you are defining. Multiple Entry and
Locator elements are permitted. See MediaCentral | Production Management Metadata
XML.

Import Metadata File. Allows specification of an Production Asset Metadata file by
file path or nickname. Various parameters such as User Properties and Locators can
be added via an XML file.

Add Asset Restrictions. When checked, allows manual addition of Asset Restric-
tions. A restriction is a span of an asset that indicates a clip, or a portion of a clip,
whose use is limited in some way, such as through intellectual property rights man-
agement or content compliance. There are 2 options for setting the Restriction:

- In Frame Number / Out Frame Number

- InTimecode / Out Timecode
The Frame Number options are enabled by default and values entered in Timecode
fields are ignored. Disable the Frame Number options to use the In Timecode and
Out Timecode values.
If Frame Numbers are used, the In Frame Number and Out Frame Number are off-
sets from the beginning of the clip. A Frame Number is considered invalid if it is
negative or if it extends past the duration of the clip.

Note: Jobs complete successfully, and assets are created, even if a restriction was
unable to be added to the database. This can occur, for example, if an Asset Restriction
uses a non-existent frame number or timecode value. However, such failures with
Production transactions in setting the asset metadata will not result in job failures.
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Note: Unlike other Interplay Access metadata features, the following special
characters are allowed 7:/\" <> |.

Add Asset Locators. When enabled, allows the addition of frame locators and
associated attributes for assets. These include Comment, Color, Timecode, Frame
Number, and Track.

Add User Properties. When enabled, allows the addition of Avid User Properties. If
the name of the User Property does not exist, it is created and populated with the
associated value.

Note: When viewed in Interplay Access, copied clips may intermittently include a
random number sequence appended to the display name (EX.Dup_12345678).
Specifying ‘Display Name’for Name in Add User Properties metadata field prevents
this from occurring.

Physical File Settings
“«  Physical File Settings
AAF File Location:
MXF File Location:
Delete AAF Subdirectory and Temporary Files -

Create Unique Folder for AAF  —

4 Physical Directory Control | Limit Files per Directory ¥

Max Number of Files in MXF Directory: 5000 % files -

~ Copy AAF File | Enable ¥

AAF Copy Directory:

Overwrite Existing AAF File -

AAF File Location. Specifies the UNC path to Avid storage where the AAF file will be
written. The typical pattern is \\<servername>\<workgroup folder>\<filename>. For
example: \\avidnexispro\Interplay2021\AAF\AAF Filel.aaf.

MXF File Location. UNC path to Avid storage where the MXF OP-Atom media files will
be written. The typical pattern is \\servername\workgroup folder\Avid
MediaFiles\MXF\file. For example: \\avidnexispro\Interplay2021\Avid
MediaFiles\MXF\MXF Filel.mxf.

Note: Initial MXF path name must include the \Avid MediaFiles\MXF\ string.

Delete AAF Sub-directory and Temporary Files. When checked, deletes the AAF files
and temporary files after the media has been checked into Interplay. These files are not
deleted if the job fails.
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Create Unique Folder for AAF. When checked, creates a unique directory folder for the
output AAF file.

Physical Directory Control. Specifies Limit Files per Directory | Do Not Limit Files per
Directory.

- Limit Files per Directory: When Limit Files per Directory is selected, specify the Max
Number of MXF Files in MXF Directory. When the maximum is reached, a new
directory is created with a numerical suffix (<dirname>.1, etc.) to store the next set of
files. Range: 100 - 10,000. Default: 5,000.

- Do Not Limit Files per Directory: When Do Not Limit Files per Directory is selected, there
iS N0 maximum.

Copy AAF File. Specifies Enable | Disable.

- Enable: Specifies the AAF Copy Directory and option to Overwrite Existing AAF
File.

- Disable: Do not copy the AAF file. Local AAF file is temporary and disposed of per
Vantage settings.

Note: If Overwrite Existing File is unchecked and a file with the same name exists in
the destination directory, the job fails.

Asset Attributes

~  Asset Attributes
Master MOB ID:
Source MOB ID:
Disable Data Track in the Output -

~ Material Name Override W

Material Name:

-~ Timecode Overnde Timecode ¥

Override Timecode: 00 : 00 : 00 : 00 3 2997 W fps -

4 Input Type Tape W

Tape Name:

AAF Path: |

Master MOB ID. Specifies the master MOB ID for this asset.
Source MOB ID. Specifies the source MOB ID for this asset.

Disable Data Track in the Output. When checked, disables creation of a data track in
the output.
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Configuring Output for Media Composer

Material Name

Specify Use Media Name | Override. This name displays as the asset's display name
unless a non-empty tape name is configured:

- Use Media Name. Input media name is used to configure the asset name.

- Override. Overrides default asset name with the user specified value. When selected,
complete this control:

Material Name. Specifies the name to use for the asset.

Note: To change the AAF folder name and filename use the Filename Pattern Editor
to change the naming scheme.

Timecode

If the transcoded source uses drop frame timecode then output is drop frame. If
transcoded source is non-drop frame then output is non-drop frame.

Specifies timecode to use: Use Source Timecode | Override Timecode:
- Use Source Timecode. Uses the source timecode detected in the media.

- Override Timecode. Timecode detected in source file is used with no changes to the
timecode in the output. When selected, specify...

Override Timecode. Specify the timecode, frame rate, and drop frame or non-
drop frame notation to use.

Input Type

Specifies: Tape | Import. Complete these controls as appropriate:

Note: Avid does not support ingesting media via Tape mode for 4K media - the asset
displays as offline. Additionally, non-zero timecode greater than 26 seconds also
displays as offline.

- Tape Name. When Input Type is Tape, specifies the tape name of the asset.

- Import. When Input Type is Import, specifies the source package name of the asset.

Note: While Avid strongly recommends using Import for file based digital media
workflows, this method does not allow for the Tape name field to be used for relinking.
Tape mode may be used for traditional dynamic relinking using the Tape field.

Tape name data replaces the Asset Name set in the Vantage Filename Pattern Editor
when not empty. To configure the Asset Name you must configure a User Property
with the property name 'Display Name' along with the desired value. Consult the Avid
Integration Guide for more details on this configuration.
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AAF Action

AAF Path. When checked, specifies the Path variable for use by downstream actions.
Typically this is used in Open workflows to provide an intermediate AAF path while
media files are still growing. The variable is set from the AAF action from the Input >
Source > File name field.

AAF Action

The AAF action is an AAF processing action. For PMR maintenance, it ingests an AAF file
and processes the media in the MXF folder referenced in the AAF. To generate Matte/
Key effect files to import and use in Avid Media Composer the AAF action updates the
files for Avid-compatibility. Avid Media Composer utilizes Matte/Key effects to apply
those effects to video clips.

The AAF action is executed by the Vantage Avid Service.

For Edit While Ingest operations, the AAF action processes the MXF folder referenced in
the AAF to create a file you can open in Media Composer for Edit While Ingest
operations in near real time.

Avid Media Composer utilizes Persistent Media Record (PMR) files for information about
the online status of file Media Object information (MOB).

Each PMR file provides an index in a form that an editor can quickly load all the file
MOBs and their associated media files in the media directory in which the PMR file
resides.

The AAF action ingests an AAF file and performs various operations on the media in the
MXEF folder referenced in the AAF, as configured by you. Avid Media Composer utilizes

Persistent Media Record (PMR) files for information about the online status of file Media
Object information (MOB). Each PMR file provides an index in a form that an editor can
quickly load all the file MOBs and their associated media files in the media directory in

which the PMR file resides.

You can also perform a Matte/Key effect on ingested files to use in Avid Media
Composer, where you apply a Matte/Key effect on selected media using the clips.

In order to perform Open Workflow, Frame Chase (Edit While Capture) processing of
Media Creation outputs, you must bind the AAF Path variable (created in an upstream
Media Creation action) to the Input Source File Name field.

For a practical guide to using the AAF in Avid workflows, please see the Avid Integration
Guide on the Telestream web site.

Note: Controls with a green Browse button may be bound to a variable to
dynamically assign their setting or value. The variable must have a value when this
action executes. You can assign the value to the variable in a previous action in the
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Vantage Actions for Avid Media Processing

AAF Action

workflow or use the variable's default value. Click Browse to select the variable or
Ccreate a new one.

Input

Select. Select AAF and specify input source by file name or file nickname.

Output Media File Settings

Output Media File Nickname. Specifies the nickname for the output file for use in
downstream actions.

Edit Filename Pattern. Opens the Filename Pattern Editor. Enter the complete
filename or a portion of the filename, and use the menu on the right side to select one
or more tokens to insert to create the exact filename pattern you require. You can drag
and drop a token to change its order relative to other tokens, thus changing its location
in the filename. You can use the following tokens:

- Base Name. The name of the file, without the extension.

- Variable. You select the variable to use. The Variable token is replaced by the value it
holds when the action executes. The variable should be set prior to execution of this
action. For example, if a variable token ISCl is given the value 12H4JA678, wherever the
ISCl variable token appears in the filename pattern it is replaced with that value.

- Date. The current date that the file is written from the perspective of the server
running the Avid Service. Change the date format via the menu.

- Time. The current time that the file is written from the perspective of the server
running the Avid Service. Change the time format via the menu.

Input Components

The AAF Input component ingests an AAF file for processing.

Note: Controls with a green Browse button may be bound to a variable to
dynamically assign their value. The variable must have a value when this action
executes. You can assign the value in a previous action in the workflow or use the
variable's default value. Click Browse to select the variable or create a new one.

Input Toolbar

Select. Click to specify one AAF input. No other file formats are supported, and only
one file can be ingested per job.
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General Input Details

Source. Click Select to display the Input Source dialog and specify the file to process, by
nickname or by a unique file name.

Note: When used to create a composition for a Matte/Key Effect in Avid Media
Composer, this file is intended for use of the alpha channel file.

Delete. To delete this input, click the Xicon in the upper right corner.

AAF Action Configuration

PMR Maintenance | Frame Chase (Edit While Ingest) Editing

When enabled, you can use the MXF folder referenced in the file to perform PMR
maintenance.

Avid Media Composer utilizes Persistent Media Record (PMR) files for information about
the online status of file Media Object information (MOB). Each PMR file provides an
index in a form that an editor can quickly load all the file MOBs and their associated
media files in the media directory in which the PMR file resides.

The purpose of PMR maintenance is to provide an index for Media Composer specifying
the online status of MXF files in a shared media directory.

For frame chase editing outside of Interplay, you also specify these controls.

Open the AAF Settings panel and the PMR Maintenance sub panel to configure PMR
maintenance controls.
~ PMR Maintenance
PMR Processing: MNone v =

MXF Path Override:

Project Name: Vantage

)

PMR Processing. Provides an MXF status index. Select from these options:

- None. (Default) No PMR processing is performed. Select None when you do not want
to perform PMR operations.

- Append. Incrementally adds entries to the PMR file for those MXF files that have been
added to the directory since the last modification to the PMR file. The PMR file should
have been created by the AAF action; it is not interoperable with PMR files created by
other programs.

- Rebuild. Deletes any existing PMR file in the directory and creates a new PMR file with
entries for all the existing MXF files in the directory.
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MXF Path Override. (Optional) When supplied, overrides the location of MXF files
referenced in the AAF file.

Project Name. Specifies the asset's project name. Default: Vantage.
Copy Input AAF File. Specifies whether or not to copy the input AAF file. When
enabled, configure these controls:

Input AAF Path. Specifies the fully-qualified path to the folder where the copied
AAF file will be written.

Create Unique Folder. When checked, creates a unique folder in the Input AAF
Path folder in which to store the AAF file.

Overwrite Existing File. When checked, enables the action to replace the existing
AAF file with the copied file. If unchecked, the action fails.

Matte/Key Effect Operation

The Matte/Key Effect feature in the AAF action generates a Matte/Key composition that
you can import and use as an effect in Avid Media composer by applying the Effect AAF
file V1 track alpha channel to the Input AAF file V1 track RGB channel.

Note: For a practical discussion of typical Matte/Key Effects use cases, see the
Creating a Matte/Key Effect for Media Composer topic.

Note: The two files originate from a single source that is split into two files using a
parallel set of Flip64 and Media Creation actions preceding this AAF action in the
workflow. The AAF action does not check for the presence of RGB and alpha channels
in the input file. It only checks that the first video track of each AAF file has the same
frame rate and frame count (duration).
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Open the AAF Settings panel and the Matte/Key Effect sub panel to configure the AAF
action for Matte/Key Effect processing.

~ Matte/Key Effect

Matte/Key Effect Processing: MNone v

Effect AAF Path: | Specify the input source:

File nickname:

@ File name:

Effect Name: MatteEffect
Composition Mob Id:
Swap Sources
Invert Key -
Link Master Clips -

-~

Opacity: v 0-100 -

Matte/Key Effect Processing. Enables or disables Matte/Key effect processing
(optionally specify a variable containing one of these keywords):

- None. (Default) Matte/Key effect processing is disabled. Select None when you do not
want to perform Matte/Key effect processing.

- Apply. Matte/Key effect processing is enabled. Select Apply when you want to
perform Matte/Key effect processing and configure these controls:

Effect AAF Path. Specifies the fully-qualified path to the input effect source, by file
nickname or by file name; enter it manually or click Browse to navigate and select the
file. It must be in DNxHD or DNxHR format - specify the nickname or path and file:

File Nickname: Check and select the alpha channel AAF file nickname, bound to
AAF Path variable AAFPathKey, set in alpha channel's Media Creation #1 action.

OR

File name. Manually enter or browse and select the fully-qualified path to the file.
The Vantage Avid service that executes this action must have access to the file loca-
tion. Use this option when you want to assign a static file, which is used for every
job. If you assign a variable, the variable must be assigned the fully-qualified path
and file name in an upstream action and the file can change for each job.

Effect Name. Practical string, per your utilization in Avid Media Composer.
Composition MOB ID. Specifies the MOB ID for the new asset.

Swap Sources. Typically, unchecked. When checked, the AAF action swaps foreground
and background layers to compensate for an inverted alpha channel.
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AAF Action

Invert Key. When checked, inverts the key to reverse the effect of the matte; used when
key is initially inverted when applied - making previously transparent areas opaque and
opaque areas transparent.

Link Master Clips. When checked, links the effect to the fill and key files.

Opacity. Specifies the relative opacity of the key - where 100 is fully opaque and 0 is
fully transparent.

Override Output Path

When enabled, if you are conducting frame chase editing outside of an Interplay
environment (as specified in the Media Creation action in your workflow), you
configure PMR maintenance to suit your requirements specify the Override Output
Path as required.

Note: In order to perform Open Workflow, Frame Chase (Edit While Capture)
processing of Media Creation outputs, you must bind the AAF Path variable (created in
an upstream Media Creation action) to the Input Source File Name field.

 Overnide Output Path  Enable w

Output AAF Path:

Create Unique Folder -

Overwrite Existing Output File -

Override Output Path. Specifies Disable | Enable.
- Disable. When disabled, the output is saved in the current Vantage Store.

- Enabled. When enabled, you can save the output to a shared drive or other location
for use directly in Interplay / Avid Media Composer.

Create Unique Folder. Check enabled when you want a unique folder created for the
output of this job in the location you specify. Use this option when you always want
output to be saved, avoiding duplicate file names.

Overwrite Existing Output File. Check enabled when you want to replace the
previous job file with the current output. When disabled and the output file with same
name exists, the job will fail.
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Throughout this guide and in numerous software tools provided by Avid, various Avid-
specific terms are used as they relate to integration with Vantage. This glossary details
the terminology currently in use by Avid.

Avid User Applications

Avid Media Composer

An Avid non-linear editing program used for editing film and video.
Avid ProTools

Digital audio workstation used for music creation and production, sound for picture
(sound design, audio post production and mixing) and, more generally, sound
recording, editing and mastering processes.

Avid Interplay Access

Client program for MediaCentral | Production (Interplay | Production, Interplay)
providing access to the Interplay workgroup from any location worldwide.

Avid Interplay Assist

Desktop video tool designed for operators to review and log video before it gets into
the edit suite.

Avid Interplay Administrator

Administration control panel used in MediaCentral | Production Management
environments.

Avid Link

Avid licensing, purchasing and update manager application used for a variety of Avid
products. Also allows for creative collaboration, content sharing and promotion.

Avid NEXIS Client Manager

Client software installed on systems that require access to Avid Media, including
Vantage. The client is backward compatible so that new Nexis Client Manager versions
will generally work with older Avid shared storage hardware.
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Avid PathDiag

Diagnostic utility that allows validation of the Avid NEXIS storage group by quantifying
the throughput (performance) of applications accessing Avid NEXIS workspaces
including Vantage.

Avid Media Asset Management Systems
MediaCentral | Cloud UX

Work on MediaCentral news, editorial, production, graphics, and asset management
projects and media from anywhere using a web browser.

MediaCentral | Production

The traditional Avid Production Management suite of tools, including Access and Assist,
that is based on a product called Alien Brain. This is the system that Vantage has
traditionally integrated with using AAF, IAE, Media Creation and Asset Monitor (aka
Interplay Production, aka Interplay, aka PAM).

Avid Storage Systems
Avid ISIS 5000/5500/7000/7500

Older Avid storage systems vary significantly from the 5000 and 7000 series. 7000/7500
systems are rare, expensive and difficult to manage. 5000/5500 are more common.

Avid NEXIS

Current generation of the Avid storage platform with different hardware, however uses
the same/similar network protocol and client software.

Avid Unity
EOL Avid shared storage system; not supported by Avid or Telestream.

Avid MediaCentral Production Components and Services

Avid MediaCentral | Production Management Server

The database host and heart of the MediaCentral | Production Management (aka
Interplay Production, aka PAM) ecosystem. The database server in some cases may be
more than a single server and in some cases may host other MediaCentral | Production
Management services. Telestream products do not communicate directly with the
Production server database.

Interplay Web Services

Interplay Web Services are the back-end web services which Vantage and other non-
Avid Applications utilize for ingesting, monitoring and communicating with an Avid
MediaCentral Production system. The web services may reside on a dedicated server or
be hosted on another of the Production host system. In a purely Avid environment with
no 3rd party applications there often is no Web Service host. There is no limit to the
number of web service hosts—in practice, customers may have separate web service
systems for different 3rd party vendors (Telestream, EVS, Harmonic, etc). Vantage
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requires a properly-configured web service host for MediaCentral | Production
Management integration (aka Interplay Web Services).

Avid MediaCentral | Production—Media Indexer

The Avid MediaCentral | Production Media Indexers are used to catalog and keep track
of Avid Media files. A MediaCentral | Production Management system always has at
least one dedicated Media Indexer but generally it is more common to see two of them
which traditional was known as a HAG (High Availability Group), now known as a NOMI
(Network of Media Indexers). All Avid editor clients that are part of a MediaCentral
Production Management environment also have a Media Indexer installed and
running.

Note: Do not confuse Avid MediaCentral Media Index with Media Indexers. Media
Index is a MediaCentral cataloging and searching tool and not something used with
Telestream products.

MediaCentral Production Avid Service Workgroup

The name of the MediaCentral | Production Management workgroup (aka Interplay
Avid Service Workgroup).

MediaCentral | Production Interplay Folder

The virtual location of assets within a MediaCentral | Production Management system.
This is not a file system location for media files, it is the location of assets in the
MediaCentral | Production Management (Interplay) database.

MediaCentral Transfer

MediaCentral Transfer (aka Transfer Engine | Transfer Manager | Interplay Transfer) is a
tool used to automate the movement of media within a MediaCentral | Production
Management environment. This is a legacy application, however still fairly common.

iNews

Another MediaCentral editing tool used for news production.

Other Avid Products
Avid Airspeed

SDI ingest and playout device similar to Telestream Live Capture.
NuVista, Meridian, Adrenaline, Nitris, Artist 10

Various Avid SDI ingest and output hardware used in editors over the years. In some
cases, like Meridian, is also the codec that was used.

FastServe

Avid's broadcast server, similar to Omneon, Grass and Imagine playout servers.

Maestro | Graphics

On-air graphics production systems.
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